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Environment Management System (EMS)

EMS Overview
Creo is committed to the Environment Management System (EMS) and according to this policy, we 
are obliged to keep customers and service engineers informed about the principles of handling 
company products, while emphasizing on the environmental conservation.
The Triple-R principles are: Reduce, Reuse and Recycle.
Any item that can be recycled should be recycled and any item that can be reused should be reused 
in order to reduce the quantities of landfill that are sent to the local municipalities.

Recycling
Items such as: Paper, Plastic, Electronic Parts, Glass � should be sent for recycling, after usage.

Packaging Materials
Packaging Materials will be kept at the customer�s premises. If these should be disposed, they 
should be sent to a plant for recycling of the Paper, Cartons and Wood.

End of Product Life span
The product should be sent for recycling to a recognized company in each country. 
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About This Manual
Printing Guide Purpose
This Printing Guide will help you operate the CSX2000 Color Server. It can also be used as a 
reference manual for questions or procedures. Study this Printing Guide to take full advantage of the 
many unique and advanced features of the CSX2000 Color Server.

Who is the Printing Guide For?
This Printing Guide is for CSX2000 Color Server operators and system administrators. This guide 
explains how you can quickly and easily print from the CSX2000 Color Server or from a client 
workstation. Step-by-step procedures are included for new and occasional CSX2000 Color Server 
users. Detailed information is provided for users who require in-depth knowledge of the CSX2000 
Color Server. 
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Chapter Content and Description

Chapter Contents Description

About this Manual Printing Guide purpose, contents, 
and document conventions.

Safety Precautions Safety procedures and precautions 
for the CSX2000 Color Server.

Chapter 1 Welcome Introduction to the CSX2000 Color 
Server

Chapter 2 Quick Tour Powering up, powering down, and 
the CSX2000 Color Server interface.

Chapter 3 Basic Printing Workflow Printing from client workstations 
and from the CSX2000 Color 
Server.

Chapter 4 Advanced Printing Color, print quality, imposition, VI, 
and APR and OPI.

Chapter 5 Managing Jobs Alerts and error messages.

Chapter 6 System Messages Queuing and storing jobs.

Chapter 7 Job Accounting Managing job accounting 
information.

Appendix A Color Theory Background information on Color 

Appendix B Imposition Theory Background information on 
Imposition 

Appendix C VI Theory Background information on VI 

Appendix D Glossary Glossary of terms.
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Document Conventions

Item Purpose Example
User interface elements User interface elements, such as menu 

options and icons, are in bold.
Select New from the File menu.
Click the Expand icon.

Procedures you perform Procedures that you perform appear in a 
numbered list.

1. Connect the machine to the main 
power supply.

2. Turn on your PC.
Single-step procedure 
you perform

Single-step procedures appear with an 
arrow.

! Select Remote Station from the 
File menu.

References References to another book or to another 
place in the book

Note Add information

Tip Tip icon precedes a tip.

Emphasized text Template style denotes importance. As a general user, you can search for 
Files and Folders.

" Refer to the Safety Precautions 
chapter.

Use Shift or Ctrl to select several 
files at once.

For faster processing, use the 
Gallop function.



This Page Is Intentionally Blank.
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Safety Precautions
Safety Labels
The following safety labels are found on the CSX2000 Color Server.

Safety Label Meaning Location

Operators should not open 
panels that require the use of 
tools. This label warns of 
dangerous voltages behind 
the CSX2000 Color Server.

Top, side and bottom right rear of 
the CSX2000 Color Server.

This label indicates that the 
outlets to which it is applied 
can accept a maximum 
voltage of between 100-120 
or 200-240 Volts, a 
maximum frequency of 60 
or 50 Hertz, and a maximum 
of 3 Amperes.

Bottom right rear of the 
CSX2000 Color Server.

This label is a reminder to 
review installation 
instructions before 
connecting the CSX2000 
Color Server to the power 
supply. It is also a caution 
against high voltages.

Bottom right rear of the 
CSX2000 Color Server.



This Page Is Intentionally Blank.
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Welcome to the CSX2000 Color Server Printing Guide
Welcome to your CSX2000 Color Server Printing Guide. 

The CSX2000 Color Server is a powerful, comprehensive color server 
providing high throughput and print predictability to digital 
workflows. In combination with the Xerox DocuColor 2060 / 2045 
printer, the CSX2000 Color Server effectively addresses the growth of 
on-demand printing needs and delivers the best output quality 
available. 

Throughout this guide, we look forward to supporting you all the way 
from preprint to print.
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Product Overview
The CSX2000 Color Server is an on-demand pre-press system that 
uses Creo Spire advanced pre-press technologies to drive a Xerox 
DocuColor 2060 / 2045 printer. 

As an optimal digital color solution for printers, the CSX2000 Color 
Server lets you print from PC, Macintosh, and UNIX client 
workstations. The CSX2000 Color Server processes image files in 
PDL formats (for example, PostScript, PDF, and Variable 
Information), using a RIP (Raster Image Processor). The system 
converts image files into a suitable RTP (Ready-To-Print) format for 
direct, high-quality digital printing. 

The CSX2000 Color Server also streamlines the printing process by 
allowing printing with preset workflows.

In combination with the Xerox DocuColor 2060 / 2045 printer, the 
CSX2000 Color Server lets you efficiently print flyers, brochures, 
pamphlets, dummy catalogs, short-run trials, and print-on-demand 
publications.

When installed as a fast, network printer with the CSX2000 Color 
Server, the Xerox DocuColor 2045 printer prints up to 45 full-color A4 
(210mm x 297mm) or Letter (8.5� x 11�) pages per minute and the 
Xerox DocuColor 2060 printer prints up to 60 pages per minute.

The CSX2000 Color Server combines RIP functionalities, automation, 
control tools and special hardware development capabilities with PC 
architecture.



10 Chapter 1  Welcome

CSX2000 Color Server for Xerox DocuColor 2060 / 2045 printer
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Composition

The CSX2000 Color Server is a dedicated Creo platform running in a 
Windows NT environment. 

The CSX2000 Color Server includes:

• Creo hardware, including the interface board

• Software, including:

• Standard Windows NT Server Operating System

• The latest version of Adobe Acrobat 

• Creo application software

Features
The CSX2000 Color Server provides the following:

• Creating jobs in RTP format
Using the CSX2000 Color Server, RTP files can be created and 
stored on the CSX2000 Color Server itself. This lets you print RTP 
data at any time without further processing.

• Powerful document printing capabilities
In combination with the Xerox DocuColor 2060 / 2045 printer, the 
CSX2000 Color Server allows complete printing and processing of 
documents, including production of covers and pages on different 
paper stocks. 

• Enhanced job editing 
The CSX2000 Color Server lets you job edit, both pre- and post-
RIP. Pre-RIP editing includes full Adobe Acrobat functionality 
including: deletion, extraction, rotating, adding, and cropping of 
pages. Post-RIP editing includes deleting job pages and merging 
pages from different jobs to a new job. This minimizes the need to 
re-RIP jobs.
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• RIP - Adobe Postscript Level III and Extreme Certified 
technologies
The CSX2000 Color Server uses the industry-standard Adobe RIP, 
with enhancements for Continuous Tone and Linework. Data are 
processed separately as Continuous Tone and Vector Data layers 
for increased efficiency and merged during printing.

• Ready-to-Print job preview and editing
The CSX2000 Color Server lets you preview RTP jobs up to pixel 
levels to see all job details and to verify job quality and content 
post-RIP. It is also possible to view a thumbnail list of job pages, or 
the actual raster pages.

• Job management
The CSX2000 Color Server lets you monitor job progress during 
all stages of printing. Among other functions, you can promote, 
demote, delete, monitor the import process, and estimate when a 
job will be fully imported. You can also abort jobs during RIPping 
or printing, as well as archive and retrieve jobs.

• Enhanced text and line art quality � FAF (Full Auto Frame)
You can choose superior text quality with the Creo proprietary 
algorithm. This function enhances the quality of diagonal lines, 
borders, blends, and small text. The Creo anti-aliasing causes 
blends to appear smooth with no banding and diagonal lines to 
appear crisp without jagged edges (do not use this option with VI 
jobs).
You can choose superior image quality with the Creo proprietary 
smooth scale algorithm. This function improves the quality of 
images containing various resolutions (such as images taken from 
the Internet).

• Trapping
The CSX2000 Color Server uses the well-known Creo algorithm to 
trap job information easily. The FAF algorithm has been tailored 
for digital printing.
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• Imposition
The CSX2000 Color Server offers a full suite of Imposition 
functions, based on the well-known Ultimate Imposition engine. 
On the CSX2000 Color Server, Imposition is robust with user-
friendly operation. And only the CSX2000 Color Server allows 
imposition of Variable Information jobs.
Imposition is performed on the CSX2000 Color Server at the post-
RIP stage. Re-RIP occurs when you modify the imposition method 
and this new method requires a 180 degree rotation of pages. Pages 
are processed separately and merged to imposed sheets only during 
printing.

• Color Management
The CSX2000 Color Server has a number of color management 
tools and utilities that will help you to improve the quality of your 
jobs. The CSX2000 Color Server lets you modify color on-the-fly, 
even for images that have already been RIPped. This functionality 
includes application of brightness and contrast adjustments, as well 
as changes to image gradation and calibration.

• Variable Information printing
The CSX2000 Color Server allows processing of Creo Variable 
Print Specification and Xerox VIPP file formats and PPML for 
efficient VI (Variable Information) processing and printing. 
Repeated elements are RIPped once and cached, so there is no 
need to continually re-RIP them. 
The CSX2000 Color Server also provides easy management of VI 
elements, including previewing, deleting and updating. The 
CSX2000 Color Server also offers imposition for VI jobs, the only 
digital solution in the industry with this capability.

• Creo workflow extenders
This is a set of Adobe Photoshop and QuarkXPress software plug-
ins and extensions that facilitate printing with the CSX. These 
extensions are located in the shared Utilities folder on the 
CSX2000 Color Server or on CD #3 supplied with the CSX2000 
Color Server software kit.
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The CSX2000 Color Server supports the following file formats:

• Post-script (composite or pre-separated files)

• PDF

• EPS

• Variable Print Specification

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• GAP (Graphic Art Port) files (file formats from various PrePress 
systems, for example Brisque)

• TIF

Workflow
The CSX2000 Color Server receives and processes files from the 
following client workstations: 

• Macintosh: running Mac OS 8.5.x or higher and Mac OS X (10.1)

• PC: running Windows 98 / ME / Windows NT 4.0 / 2000 / and XP

• UNIX Workstations and Servers
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The CSX2000 Color Server basic workflow is as follows:
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Data Flow

The CSX2000 Color Server Data Flow is as follows:

1. The input file arrives at the CSX2000 Color Server from either a 
client workstation, local hard disk, or external media and is 
submitted to the Process queue. 

2. The processing sub-system produces an RTP job from the input 
file.

3. The RTP job is stored on an image disk.

4. When printing starts, the RTP job elements on the disk are 
decompressed and merged to the correct location on the page. This 
is done using Creo hardware.

5. The image delivery sub-system converts the RTP information into 
the print engine format.

6. The image delivery sub-system transmits the page information to 
the print engine.

7. The page data is delivered to the Print Engine and the job is 
printed.

RTP RTP

PDL Processing
(Software)

Decompress
and

Page Assembly
(Hardware)

Image
Delivery

Image Disks
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Network CSX2000 Color Server Virtual Printers

For Macintosh and PC networks, the CSX2000 Color Server provides 
three default network printers, known as virtual printers.

Virtual printers are a function used for automating workflows, which 
then define job streaming. They contain preset workflows that are 
automatically applied to all print jobs processed with that virtual 
printer. There is no need to reset job settings for each job, thus 
increasing printing efficiency.

The three virtual printers are:

• SpoolStore
Files are spooled directly to the Storage Folder and await operator 
processing. You can only import PDL files (such as: PS, PDF, 
VIPP, VPS) to the spool store, not RIPped - RTP files. 

• ProcessPrint
Files sent to this virtual printer are processed and printed directly 
to the Xerox DocuColor 2060 / 2045 printer via the CSX2000 
Color Server.

• ProcessStore
Files sent to this virtual printer are automatically processed in RTP 
format. After processing, the files are stored in the Storage Folder 
of the CSX2000 Color Server until the print operator re-submits 
them for printing.

Additional default network printer for Macintosh networks: 

• FontDownLoader
This special network printer, called Spire_FontDownLoader, used 
with Macintosh clients to download fonts. The FontDownLoader 
functions as a communications port, sending messages between the 
FontDownLoader program and the CSX2000 Color Server. You 
can send only fonts via the FontDownLoader, not files. 

The job (print) parameters set in the job override the parameters set in the virtual 
printer. 

When font substitution is performed, a message appears in the job history of the 
specific file. For more information, refer to Job History on page 349.
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With printing workflows tailored to your job requirements, the CSX2000 
Color Server enables you to: 

• Define new virtual printers

• Choose from which virtual printer to print

! For information on defining and editing virtual printers, see Defining and Editing 
Virtual Printers on page 121.



19

Chapter 2

Quick Tour

Powering Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Introduction to the Workspace  . . . . . . . . . . . . . . . . . . . 22
Shut Down and Power Off. . . . . . . . . . . . . . . . . . . . . . . 25



20 Chapter 2  Quick Tour

Powering Up
To power up the CSX2000 Color Server:

1. Switch on the monitor.

2. Open the front door of the CSX2000 Color Server and click the 
Power button. 
The power LED on the front panel lights-up. The Windows NT 
System starts and the CSX2000 Color Server splash screen 
appears.

If the CSX2000 Color Server is already powered up, open the workspace 
using the Start menu (as described on the following page).
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CSX2000 Color Server in the Start Menu

The CSX2000 Color Server program group appears in the Windows 
Start menu.

To manually open the CSX2000 Color Server workspace:

1. Follow the path Start > CSX2000 > CSX2000 > CSX2000. Click 
on .

2. The Loading Drivers screen appears followed by the CSX2000 
Color Server workspace.

" References: 
1. The CSX2000 Color Server includes a diagnostics utility for checking the 
hardware components of the system. This application should only be started by 
a Service Engineer. For more information, refer to the CSX2000 Color Server 
Technical Manual.
2. For information on CSX2000 Tools from the desktop (Diagnostics, 
Diagnostics ReadMe, and Format Image Disks, refer to the CSX2000 Color 
Server Technical Manual).
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Introduction to the Workspace
After the CSX2000 Color Server is powered up, the following 
workspace automatically appears.
The workspace area items are described on the following page.

1

6

3

1

4
5

2
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Item Name Description

1 Menu Bar The Menu bar includes Job, Selection, Tools, Control and Help headings. 
Click on a heading to open a drop-down menu.

2 Status Panel The Status Panel includes the following panes: Logo, Process Queue, Print 
Queue, Storage Folder and Components. 
In the Components pane (the top-right server-printer animation), you can 
view:

• DFE Monitor (double-click on the server illustration to the left, refer to 
the CSX2000 Color Server Installation Guide)

• Printer Monitor (double-click on the printer illustration to the right, refer 
to the next page for the Printer Monitor dialog box)

3 Pathways Panel Click on an icon on the Pathways Panel to open / close a workspace window.

4 Queue Manager The lower area of the Queue Manager window (Process Queue) lists the files 
to be processed. After a file has been processed successfully, it moves to the 
upper area of the Queue Manger (Print Queue) and waits to be printed, or the 
job moves to the Storage Folder for future printing. Failed jobs and jobs that 
cannot be RIPped also move to the Storage Folder.

5 Job Thumbnail The Job Thumbnail window displays the thumbnail view of a specific page 
in an RTP job that has finished processing.

6 Storage Folder The Storage Folder may contain files that:
• Completed printing 

• Were put on hold, aborted, or failed during processing / printing

• Were sent directly from the client 

• Were imported into the Storage Folder
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Printer Monitor dialog box

The Printer Monitor dialog box can also be accessed from the Tools 
menu.
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Shut Down and Power Off
To shut down and power off the CSX2000 Color Server: 

1. In the CSX2000 Color Server workspace, select Job > Exit. 

Or:

Click the  in the top right hand corner of the CSX2000 Color 
Server workspace.
The Exit window appears.

2. Click Yes. The CSX2000 Color Server workspace closes and you 
return to the Windows desktop.

3. To confirm that the CSX2000 Color Server application has closed, 
make sure that the Creo icon has disappeared.

Jobs that are being processed or printed will abort.
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4. In the Windows desktop, select Start > Shut Down. 

5. In the Shutdown dialog box, select Shut down?

6. When the Windows shutdown is complete, switch off the monitor.

7. On the CSX2000 Color Server, click the Power button behind the 
front door. The power LED on the front panel goes off. 
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Printing from Client Workstations
You can send or import most PDL files (for example, PostScript, PDF, 
EPS, VPS, VIPP) to print on the CSX2000 Color Server. 

You can print from any application (for example, Microsoft Word) on a 
PC or Macintosh client workstation, from UNIX client workstations, or 
by importing PDL files directly into the CSX2000 Color Server. 

Files can be imported from the following:

• Local hard drives

• CD-ROM drives 

• Floppy drives

• Remote client workstations

• File servers

On the CSX2000 Color Server, files are printed by means of virtual 
printers containing predefined job parameter settings. The predefined 
settings are automatically applied to all jobs printed using that virtual 
printer and determine how a sent or imported file is processed. For 
example, a file sent to a virtual printer with a Process & Print job flow 
is RIPped, printed and stored in the Storage Folder. A file sent to a 
ProcessStore job flow virtual printer is RIPped and stored, without 
printing.

Importing from a CD should not be performed when the system is printing or 
processing data. Suspend the Process queue when importing from a CD.
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Printing from a PC
To print from a PC:

1. Open the file to be printed in the application 
(for example, Adobe Acrobat).

2. Select Print from the File menu. The Print window appears.

3. In the Name: box, select the required CSX2000 Color Server 
network printer (for example, Spire_Process&Print).
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4. If desired, click Properties to set the job parameters. 
The printer Document Properties window appears.

.

5. Modify job settings as needed. 

6. Click OK in the Print window.
The file is sent to the CSX2000 Color Server. 

Notes: 
1. The parameters set in the print options overrides the parameters set in the 
virtual printer.
2. Printer's Default indicates that the value is taken from settings of the 
selected virtual printer on the CSX2000 Color Server.
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Printing from a Macintosh
To print from a Macintosh computer:

1. Open the file to be printed in the application 
(for example, Microsoft Word). 

2. Select Print from the File menu. The Print window appears.

3. In the Printer: box, select the required printer 
(for example, CSX_Color_ProcessPrint).
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4. To set job parameters, click General. From the drop-down menu, 
select one of the Printer Specific Options.

A window similar to the one shown below appears. 

5. Adjust the printer options as required.

6. After modifying the job settings in the Printer Specific Options 
windows, click Print.
The file is sent to the CSX2000 Color Server. 

Notes: 
1. Printer's Default indicates that the value is taken from the currently-selected 
virtual printer.
2. The PPD parameters are divided up into five Printer Specific Options in the 
drop-down menu.
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Printing from a UNIX Client Workstation
To print from a UNIX client through LPR:

1. Type the following:

<lpr><space><-P><space><local UNIX printer 
name><space><PS file name>
For example, to print frog.ps on a printer named ProcessPrint, 
type:

lpr -P ProcessPrint frog.ps
2. Press Enter.

The PostScript file is downloaded to the printer. All settings are 
taken from the remote printer on the CSX2000 Color Server.

Notes: 
1. Use alphanumeric and underscores for names. Names are case sensitive, for 
example ProcessPrint not processprint. 
2. UNIX does require PPDs to print jobs. Therefore, you can not set printer 
options.
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Fonts

The following standard fonts are available on the CSX2000 Color 
Server:

AdobeSansMM Bookman-DemiItalic   GillSans-Condensed

AdobeSerifMM Bookman-Light   GillSans-ExtraBold

AlbertusMT-Italic Bookman-LightItalic   GillSans-Italic   

AlbertusMT-Light Carta GillSans-Light  

AlbertusMT Chicago   GillSans-LightItalic   

AntiqueOlive-Bold Clarendon-Bold   GillSans   

AntiqueOlive-Compact     Clarendon-Light   Goudy-Bold   

AntiqueOlive-Italic   Clarendon   Goudy-BoldItalic   

AntiqueOlive-Roman   CooperBlack-Italic   Goudy-ExtraBold   

Apple-Chancery   CooperBlack   Goudy-Italic   

Arial-BoldItalicMT   Copperplate-ThirtyThreeBC   Goudy   

Arial-BoldMT   Copperplate-ThirtyTwoBC   Helvetica-Bold  

Arial-ItalicMT   Coronet-Regular   Helvetica-BoldOblique   

ArialMT   Courier-Bold   Helvetica-Condensed-Bold  

AvantGarde-Book   Courier-BoldOblique   Helvetica-Condensed-BoldObl   

AvantGarde-BookOblique   Courier-Oblique   Helvetica-Condensed-Oblique   

AvantGarde-Demi   Courier   Helvetica-Condensed   

AvantGarde-DemiOblique   Eurostile-Bold   Helvetica-Narrow-Bold   

Bodoni-Bold   Eurostile-BoldExtendedTwo   Helvetica-Narrow-BoldOblique   

Bodoni-BoldItalic   Eurostile-ExtendedTwo   Helvetica-Narrow-Oblique   

Bodoni-Italic   Eurostile   Helvetica-Narrow   

Bodoni-Poster (001.002) Standard 
Disk Geneva Helvetica-Oblique   

Bodoni-PosterCompressed   GillSans-Bold Helvetica   

Bodoni   GillSans-BoldCondensed HoeflerText-Black  

Bookman-Demi   GillSans-BoldItalic HoeflerText-BlackItalic   
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The following standard Kanji fonts are available on the CSX2000 
Color Server Japanese version:

HoeflerText-Italic   NewCenturySchlbk-Roman TimesNewRomanPS-
BoldItalicMT   

HoeflerText-Ornaments NewYork TimesNewRomanPS-BoldMT   

HoeflerText-Regular   Optima-Bold   TimesNewRomanPS-ItalicMT  

JoannaMT-Bold   Optima-BoldItalic  TimesNewRomanPSMT   

JoannaMT-BoldItalic   Optima-Italic   Univers-Bold   

JoannaMT-Italic   Optima   Univers-BoldExt   

JoannaMT   Oxford   Univers-BoldExtObl   

LetterGothic-Bold   Palatino-Bold   Univers-BoldOblique   

LetterGothic-BoldSlanted   Palatino-BoldItalic   Univers-Condensed   

LetterGothic-Slanted   Palatino-Italic   Univers-CondensedBold   

LetterGothic   Palatino-Roman   Univers-CondensedBoldOblique   

LubalinGraph-Book   StempelGaramond-Bold  Univers-CondensedOblique   

LubalinGraph-BookOblique   StempelGaramond-BoldItalic   Univers-Extended  

LubalinGraph-Demi   StempelGaramond-Italic  Univers-ExtendedObl   

LubalinGraph-DemiOblique   StempelGaramond-Roman   Univers-Light   

Marigold   Symbol Univers-LightOblique  

MonaLisa-Recut   Tekton   Univers-Oblique  

Monaco Times-Bold   Univers   

NewCenturySchlbk-Bold Times-BoldItalic  Wingdings-Regular

NewCenturySchlbk-BoldItalic Times-Italic   ZapfChancery-MediumItalic   

NewCenturySchlbk-Italic Times-Roman   ZapfDingbats

FotoMinA101-Bold MidashiMin-MA31 ShinGo - Light

FutoGoB101-Bold MidashiGo-MB31 ShinGo - Medium

GothicBBB - Medium Ryumin-Light ShinGo - Ultra

Jun101-Ligh ShinGo - Bold ShinseiKai - CBSK1
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Managing Fonts

To manage fonts on the CSX2000 Color Server:

1. Access the Fonts Handler screen via Admin >Resource Manager 
> Fonts. Double-click on this option.

The Fonts Hander screen appears.

2. To set the default font, select a font from the font list. Click the Set 
As Default button.

3. To delete a font, select the font you want to delete and click Delete.

4. Click OK to confirm the changes and to return to the 
Administration window.
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PPD Parameters

The following table lists the PPD (PostScript Printer Description) 
parameters and the printing options that can be selected from the Print 
window of an application.

Notes:
1. In the PPD file, the Printer Default option is presented for all PPD 
parameters. Printer's Default corresponds to the settings of the currently-
selected virtual printer.
2. Parameter settings are modified or applied through either through the PPD, a 
virtual printer, or the Job Parameter window.
3. When setting or adjusting job parameters, the last-modified or applied 
parameter settings are the settings that are applied to the job. However, the print 
settings defined in the job file override the settings of the virtual printer.
4. Grayscale images created in RGB applications (such as PowerPoint) should 
be specified as Monochrome or submitted to the system with BW Printing 
selected in the PPD. This selection ensures that grayscale images are counted 
as black and white instead of color in both the CSX2000 Color Server and in the 
DocuColor 2045 / 2060 billing meters.

PPD Parameter Printing Options

Print Method Simplex prints single-sided pages.
In Duplex Head to Toe, the image on the reverse side of sheet is rotated 180 
degrees. It used for calendar-style hard copies and presentation-style copies 
(usually used with Landscape jobs).
In Duplex Head to Head, the head of the image appears at the top of the page 
on both sides of the sheet. It is used for normal book-style hard copies (usually 
used with Portrait jobs).

Face-Up Face Up delivers the pages facing up on the printer.
Face Down delivers the pages face-down on the printer (when printing 
confidential documents).

Reverse Print Order Yes starts printing from the last page.
No starts printing from the first page.

Collation Yes prints a complete copy of the job before the first page of the next copy is 
printed.
No prints all the copies of each page before all the copies of the next page are 
printed. 
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BW Printing Yes prints all pages using black (K) toner only.
No prints all pages using all CMYK toners.
With No, Print gray using only black toner all office elements with equal RGB 
values are printed using only black toner (using a new CRD).

Type Select Paper or Transparency as the media. 

Weight Select the required paper weight from the drop-down list. The following ranges 
are listed: 64-80, 81-105, 106-135, 136-150, 151-220, and 221-280 (all values 
are in gsm). For example, 81-105 gsm prints on 81-105 gsm paper.

Coating Coated prints on coated paper.
UnCoated prints on uncoated paper.

Text and Line Quality High provides superior text quality. This setting applies the Creo proprietary 
algorithm that enhances the quality of diagonal lines, borders, blends, and small 
text. The Creo anti-aliasing causes blends to appear smooth with no banding and 
diagonal lines to appear crisp without jagged edges (do not use this option with 
VI jobs).
Normal provides standard text quality.

Image Quality High provides superior image quality. This setting applies the Creo proprietary 
smooth scale algorithm, which improves the quality of images containing 
several resolutions (such as images taken from the Internet).
Normal provides standard image quality and increased RIPping speed.

Trapping Yes applies the Creo FAF (Full Auto Frame) algorithm to the job.
Trapping solves misregistration between color separations in offset and digital 
printing. This occurs regardless of the printer device accuracy. This problem 
results in white lines around objects on top of a background (in a knock-out 
procedure) and also between adjacent colors. The FAF solution is to extract the 
element or background to create an overlap between them. Do not use this 
option with VI jobs.
No does not begin image trapping while RIPping (this does not affect trapping 
incorporated by the authoring application). If trapping was applied in the 
authoring application, select No.

PPD Parameter Printing Options
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Black Overprint Yes provides better printing quality (as in FAF) and a richer, deeper black with 
the underlying CMY values equal to the those of the printed background. As a 
result, misregistrations are not visible.
Black Overprint ensures that 100% black text prints cleanly within a tint or 
picture area. Occasionally white lines may appear around black text and the text 
may appear less dense than required as a result of misregistration between color 
separations. With Black Overprint, the Pure Black Text / Graphics option is 
automatically activated and there are no knock-outs under the black text. 
However, a knock-out occurs when you print only the topmost color. This results 
in less color density and can cause misregistration if separations are not 
perfectly aligned.
No leaves the job as is.

PS Overprint PS (PostScript) Overprint offers the option to use the overprint, which exists in 
the PS file. It also determines whether DTP application PS Overprint settings are 
honored in the RIP.
CSX2000 Color Server settings override PS Overprint commands from DTP 
applications. For example, if PS Overprint was set to Yes in a DTP application, 
selecting PS Overprint No in the CSX2000 Color Server results in no 
overprinting. The CSX2000 Color Server can not create PS Overprint that is not 
pre-defined in the file. Selecting PS Overprint Yes for a file that has not had 
overprinting defined in a DTP application does not result in overprinting.
Yes instructs the RIP to use the overprint information that exists in the input 
PostScript file. Also, if PS Overprint is applied in a DTP applications, it is 
implemented by the CSX2000 Color Server. Background colors are not knocked 
out. 
For example, in the case of a yellow triangle overlapping a cyan circle, selecting 
Yes results in the overlapping area turning green. This is not seen on the screen, 
only in print.
No ignores the overprint information that exists in the input PostScript file. 
Background colors are knocked out and only the top most color parts are seen on 
the screen in your DTP application.
For example, in the case of a yellow triangle overlapping a cyan circle, selecting 
No results in the cyan background being knocked out, so only the yellow is 
printed. 

Brightness Brightness settings can be applied to RTP jobs without reprocessing (re-RIPping 
the file).
Normal keeps the current job setting and does not apply extra brightness.
To apply brightness, select one of the range options: Light (5%), Lighter 
(10%), Lightest (15%), Dark (5%), Darker (10%), Darkest (15%).

PPD Parameter Printing Options
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Contrast Contrast settings can be applied to RTP jobs without re-processing (re-RIPping 
the file).
Normal keeps the current job setting and does not apply extra contrast.
To apply contrast, select Less Contrast or More Contrast. 

Rendering Intent for 
RGB

Rendering Intent defines how colors are compressed from Lab values to printer 
color space.
Saturated (presentation) produces saturated colors that are suitable for office 
environment applications (for example text documents and presentations).
Perceptual (photographic) yields the most effective results on continuous tone 
and images.
Saturated (presentation) and Perceptual (photographic) are the most 
effective RI methods for RGB images.
Relative Colorimetric provides an accurate general-purpose gamut mapping 
for all applications. The lowest density is mapped to white. 
Absolute Colorimetric preserves the substrate tint.

Rendering Intent for 
CMYK

Rendering Intent defines how colors are compressed from Lab values to printer 
color space.
Relative Colorimetric provides an accurate general-purpose gamut mapping 
for all applications. The lowest density is mapped to white. 
Absolute Colorimetric preserves the substrate tint.
Relative Colorimetric and Absolute Colorimetric are the most effective RI 
methods for CMYK images.
Saturated (presentation) produces saturated colors that are suitable for office 
environment applications (for example text documents and presentations).
Perceptual (photographic) yields the most effective results on continuous tone 
and images.

Ink Saving(GCR) No does not use GCR and uses default maximum toner settings.
Use Low, Medium, or High to set the amount of CMY toners to be replaced by 
the black toner. High provides low ink coverage while saving on toner (this 
prevents the occasional peeling of ink and the curling effect that may occur 
when printing transparencies).

CMYK Emulation Select a CMYK emulation: None, DocuColor40, Euroscale, Gravure, 
Japan_Color, Offset, or SWOP.
None applies Ink Saving (GCR) without emulation.
In all cases, emulation applied in the original DTP application overrides the 
CSX Color Server settings.

PPD Parameter Printing Options
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Screening Method Automatic applies two types of screens: 
For CT, the system uses Dot type screen of 200 lpi. 
For text / line-art elements, the system uses Dot type screen of 200 lpi for all 
colors below a system-preset threshold. It uses Line type screen of 600 lpi for 
colors that are equal to or higher than the system-preset threshold. 
Dot 150 applies Dot type screen of 150 lpi.
Dot 200 applies Dot type screen of 200 lpi.
Line 200 applies Dot type screen of 200 lpi.
Line 300 applies Dot type screen of 300 lpi.
Line 600 applies Dot type screen of 600 lpi.

Use RGB CSA This option increases gamma values, thus producing more color depth for RGB 
images. To use CSA in the image, select Use Source CSA. To replace CSA with 
RGB, select: Use CSXRGB 1.8, Use CSXRGB2.1, or Use CSXRGB 2.4. 

CMYK Source CSA Select whether to Use Source CSA or Ignore Source CSA for your CMYK 
image.

Calibration Normal prints using the normal LUT (Look-Up table, which is the calibration 
table name).
Saturated prints using the saturated LUT.
None prints without calibration, thus there is no balance between colors and 
gives no color calibration data.

Automatic Deletion Always, Never, Successful Only, Failed Only
On large VI jobs, which take up a large amount of the CSX2000 Color Server�s 
disk space, it is recommended (if you do not need to reprint the job) to use the 
this option. Completed and failed jobs are automatically saved in the Storage 
Folder unless you check one of the Job Deletion option check boxes. Follow the 
below process:
Suspend the Process queue.
Import your job.
Successful Only removes jobs so they will not be printed. This option 
continuously deletes pages once they have been successfully printed and thus 
sustains enough free disk space for the duration of the print run.
Failed only removes failed jobs (while processing or printing) from the 
CSX2000 Color Server.
Each successfully printed page of the job is immediately deleted while the rest 
of the job remains in the queue to print.

PPD Parameter Printing Options
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APR 
(Automatic Picture 
Replacement�) 

Print with High Res prints using high-resolution files.
Print with Low Res prints using low-resolution files.

Job Flow ProcessPrint RIPs the PDL files and prints them, then moves the files to the 
Storage Folder or deletes them in accordance with the deletion policy.
ProcessStore RIPs the PDL files and moves them to the Storage Folder as RTP 
jobs.
SpoolStore copies the PDL files directly to the Storage Folder.

Admin Page Admin Page includes general information about the job, including paper stock 
parameters (Admin page can also apply to non-successfully completed jobs).
Admin page is printed in the same order as the job, before each set for face-
down printing and after each set for face-up printing.
Yes prints an Admin page.
No for no Admin page with the job.

Slip Sheet Yes inserts a sheet offset from the job stock between jobs or copies of a job or at 
the end of uncollated stacks of pages.
No does not insert any slip-sheets.

Finisher Module Select a Finisher module from the drop-down list to select the printed output�s 
destination: 
OCT (Output Cache Tray) prints to the output cache tray. 
If your printer is equipped with an HCS (High Capacity Stacker), select: 
HCS Stack Tray, which prints to the top tray.
HCS Top Tray, which prints to the stack tray, which is the internal tray.
If your printer is equipped with an HCSS (High Capacity Stacker Stapler), 
select:
HCSS Top Tray, which prints to the top tray.
HCSS Stack Tray, which prints to the Stack Tray (usually for many pages / 
copies). 
HCSS Staple Stack, which prints an already stapled document. 

Finisher Offset Yes shifts the sheets when a new page number is delivered. For example, you 
requested 3 copies of each page. Thus the printing output sequence is as follows: 
Page1, Page1, Page1, Offset, Page2, Page2, Page2, Offset, and so on.
No does not use this printing method.

PPD Parameter Printing Options
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Staple Options Landscape - Single TL a single staple in the top left corner.
Landscape - Single TR a single staple in the top right corner.
Landscape - Dual Right two staples along the left side.
Landscape - Dual Left two staples along the right side.
Landscape - Dual Top two staples along the top.
Portrait - Single TL a single staple in the top left corner.
Portrait - Single TR a single staple in the top right corner.
Portrait- Dual Right two staples along the left side.
Portrait - Dual Left two staples along the right side.
Portrait - Dual Top two staples along the top.

Rotate 180 Yes (only relevant for the Finisher Module > HCSS Staple Tray option), 
modifies the stapling position by 180 degrees. For example, instead of stapling 
on the upper left-hand corner, you can staple on the lower right-hand corner.
No ignores this method.

PPD Parameter Printing Options
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Printing from the CSX2000 Color Server
Importing Files

When PDL files are created on client workstations that are not 
connected to the CSX2000 Color Server or if files are available only on 
external media (such as a CD-ROM), you can import files into the 
CSX2000 Color Server. It is also possible to import job files that reside 
locally on the CSX2000 Color Server.

To import files into the CSX2000 Color Server:

1. In the CSX2000 Color Server workspace, from the Job menu, 
select Import Job. 

The Import Job window appears.

2. To access the required files, click the up one level button or 
double-click on file folders to go down the file tree.

3. Select the required files and click Add to List. Or drag the files to 
the right hand side of the Import Job window.

4. Select a Virtual Printer from the drop-down list.

Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 
To add only one file, double-click on its name. If required, add the same file 
more than once.

Notes: 
1. To remove files, select the required files in the right hand side of the Import 
Job window and click Remove.
2. Use Shift or Ctrl to select several files at once.
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5. Click Submit. 
All files currently listed on the right hand side of the Import Job 
window are sent to the CSX2000 Color Server to be processed and 
printed as defined in the selected virtual printer.

To check the status of imported jobs:

1. Click on the arrow in the Components pane.
The Importing window appears.

The Importing window indicates the name of the file being 
imported, its location and the job size. It also indicates the 
percentage of the job already transferred, both numerically and 
graphically.

2. Click Skip This Job to stop importing the current file and import 
the next job in the import queue.

3. Click Abort All Jobs to stop importing all the files.

4. Click Close to exit the Importing window.
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The Storage Folder

RTP jobs are stored in and reprinted from the Storage Folder. 

The Storage Folder also contains files that:

• Have completed printing

• Were aborted during processing or printing

• Failed to complete processing or printing

• Were imported or downloaded directly from a client workstation to 
the Storage Folder. 

The Storage Folder also holds PDL files (for example, PostScript files 
that were spooled directly to the Storage Folder).

" For further details, refer to Handling Jobs in the Storage Folder on page 304.
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Reprinting Files

RTP jobs that are stored in the Storage Folder can be easily reprinted. 
Select the job you want to reprint and submit it. It is automatically 
placed in the Print queue. 

The CSX2000 Color Server allows you to change job parameters and 
edit jobs prior to reprinting.

You can change job parameters in the Job Parameters window. Certain 
changes to the job parameters require re-RIPping of the job. The 
CSX2000 Color Server automatically determines if your file requires 
re-RIPping and places it in the appropriate queue when you submit it 
for reprinting.

Jobs edited using Job Editor can not be re-RIPped. Once a job has been 
saved in the Job Editor, it is a new RTP file without an associated PDL 
file. For such jobs, parameters requiring re-RIPping can not be applied.

RTP jobs can be reprinted by:

• Submitting an RTP job that requires no changes.

• Submitting a job that needs to be re-RIPped.

" References:
1. For further details on editing RTP jobs, refer to Editing RTP Jobs on page 317.
2. For further details on changing job parameters, refer toSetting Job 
Parameters on page 49.
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Submitting an RTP Job Requiring no Changes

To submit an RTP job requiring no changes:

1. Select the jobs in the Storage Folder. and select Submit 

2. Alternatively, right-click the jobs and select Submit from the 
Shortcut menu. This places the jobs in the appropriate queue (the 
Process or Print queue).

Submitting a Job that Requires Re-RIPping

To submit a job that requires re-RIPping:

! Double-click a job to open the Job Parameters window. Change 
the required parameter and click Submit.

When you click Submit, the CSX2000 Color Server automatically 
determines if your job needs to be re-RIPped and places it in the 
appropriate queue.Refer to From a Client Workstation on page 49.

Use Shift or Ctrl to select several jobs.



Printing from the CSX2000 Color Server 49

Setting Job Parameters

The CSX2000 Color Server lets you view and edit of all job 
parameters. Job parameters can be adjusted from client workstations or 
from the CSX2000 Color Server itself.

From a Client Workstation

To use the CSX2000 Color Server PPDs:

! Through the Print window of your application, select print settings 
specific to printing to the CSX2000 Color Server. 
Job Parameters can also be adjusted for jobs that have already 
been processed and which are being held in the Storage Folder. 
Changes to the following job parameters require re-RIPping of the 
job. 

Re-RIP indication appears in the job ticket when you modify 
specific parameters that require the re-processing of the job.

Print Settings Tab

The following require re-RIPping:

• Changing between Simplex / Duplex HTH / Duplex HTT

• Changing to B&W / Color

• Modifying page ranges

Paper Stock Tab

The following require re-RIPping:

• In the Paper Size parameter, changing orientation from / to LEF 
from / to SEF

• Paper size modifications that require changing the orientations due 
to print engine limitations

Jobs edited using Job Editor can not be re-RIPped. Once a job has been saved 
in the Job Editor, it is a new RTP file without an associated PDL file. For such 
jobs, parameters requiring re-RIPping can not be applied

This re-RIPping indication covers most occurrences of re-processing. But there 
are still some cases for which re-processing is required and no indication 
appears in the job ticket. 
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Print Quality Tab

All Print Quality options require re-RIPping.

Color Tab

Modifications to the following functions require re-RIPping:

• Rendering Indent parameter

• Ink Saving parameter (GCR)

• Workflow parameter

• Source CSA

• RGB flow

• CMYK flow

Imposition Tab

Modifications to the following functions require re-RIPping:

• Method parameter (for example, changing from Saddle Stitch to 
Perfect Bound)

• Template parameter (for example, changing from 2x1 Simplex to 
1x2 Simplex)

Services Tab

The following functions require re-RIPping:

• In APR, when High Res is changed to Low Res (and vise-versa) 
and when settings are changed in the use APR Path box.

• Compression

• Preflight

Finishing Tab

For cover and staple issues, the need to re-RIP, is not per option, but 
depends on the need to rotate some pages. Thus, the job is executed 
according to the required stapling options or the cover to be printed. 

Exceptions

Any exception that changes the order of the original pages requires re-
RIPping the file.
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Job Parameters Window

To enter the Job Parameters window:

! Double-click on the job in the Storage Folder.

Or:

Right-click on the job in the Storage Folder. Select Job 
Parameters. . . form the Shortcut Menu.
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Or:

Select a job in the Storage Folder. From the Job menu, select Job 
Parameters. . . 
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The Job Parameters window contains the following tabs:

• Print Settings
• Paper Stock

• Print Quality
• Color
• Imposition
• Services
• Finishing

• Exception
The Job Parameters window title bar shows the following:

• Sender�s (originating workstation�s) user ID

• Job submission date and time

• Job size
To set Job Parameters in the Job Parameters window:

1. Click on the various tabs and set the required job parameters.

2. Click OK to confirm the setting or Cancel to abort. Alternatively, 
click Submit to move the selected job to the appropriate queue 
using the current parameters.
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Print Settings Tab

You can set various print-related job parameters.

Num of Copies

To use Number of Copies:

! Type the number of copies to be printed.
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Print Range

To use the Print Range option:

! Select All to print the entire job.

Or:

Select Pages and specify the pages to be printed as follows:
Type one or several numbers separated by commas and no spaces 
(for example, 1,3,5). Or, type a range of pages with a hyphen 
between the starting and ending numbers in the range (for 
example, 1-5).

Notes:
1. Upon setting a �print range�, the system only processes the defined range, not 
the whole job. 
2. For Print Range, re-RIPping of a job is required only if you are adding new 
pages to the range which were not previously defined for printing. It does not 
depend on issues of ranges within ranges, already defined for printing.
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Print Method

To use the Print Method option:

! Select Simplex to print single-sided pages. 

Or:

Select Duplex Head to Head to print the top of the image on side 
1 on the same edge of the page as the top of the image on side 2. 

Or:

Select Duplex Head to Toe to print the top of the image on side 1 
on the page�s opposite edge from the top of the image on side 2.
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Print Order 

To use the Print Order option:

1. Select the Reverse Print Order check box to print the pages of 
your job from last to first.

Or:

Clear the Reverse Print Order check box to print the pages of 
your job from first to last.

2. Select Face Up to deliver the pages facing up.

Or:

Select Face Down to deliver the pages facing down (for example, 
when printing confidential documents).

When collating a document, selecting Reverse Print Order and Face Down or 
Face Up causes the set to be delivered in the correct order.
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Collation

To specify sorting options:

! Select Yes for copies of a complete job to be collated and output 
into the top tray.

Or:

Select No for copies of a complete job to be output, uncollated into 
the top tray.
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Image Position

You can adjust the image positioning on the sheet�s printed page 
(simplex or duplex). 

This function uses the following terminology: 

• Lead (or Leading Edge, the edge of a sheet at which printing 
begins) 

• Rear (or Rear Edge sheet's edge near the printer rear, where 
printing stops) edges. 
The page�s Lead and Rear edges are determined just after the page 
is printed out before making any change in the page orientation. 

• One refers to the first side of the sheet (facing-up) that was printed. 

• Two refers to the second side of the sheet (facing-down) that was 
printed.

To use duplex printing, perform one of the following: 

• Click the Same on both sides button to shift the image on the 
sheet�s second side (face down image) according to the previous 
shift on the sheet�s first side (face up image). 
Set page offsets by clicking the directional arrows or by manually 
entering Rear and Lead measurements. 

• Click the Auto Center button to delete all values input in the 
numerator, setting each value back to �0�.

• Clicking the arrows to shift the image of both sides. Or enter 
values in the Rear: and Lead: boxes.
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Clicking on the arrows changes the numerator values as following: 

• Positive (negative) values for shift toward (away from) the 
Leading Edge 

• Top (bottom) arrows for positive (negative) values toward (away 
from) the Rear Edge 

Image Scale 

To proportionally enlarge or reduce the size of the job pages:

• Select 100% for no change from the original file (default value).

• Select Fit to Paper for the image to fit the selected paper in the 
paper stock.

• Select Custom to decide by which percent to proportionally 
decrease / increase the image size.

Use this option to move duplex page data away from the spine. 
This option is not available if the Print Method is Simplex.
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B&W Printing 

Use the B&W Printing option to discard all color data of the job and 
print in B&W only. This option is useful in saving printing costs (for 
example printing time and toner).

When a color job is printed using the B&W Printing option, the C 
(Cyan), M (Magenta), and Y (Yellow) separations are also printed 
using K (Black) toner, giving a dense appearance similar to a grayscale 
image.

To use the B&W Printing option:

! Select Yes to print the job as black and white using K toner only.

Or: 

Select No prints the job in color using CMYK toners.
Select Print grays using only black toner (available only for the 
No option) for color print with RGB grays to be printed only as 
black. Use this option if you have a mixed document (one page / s 
B&W or page / s color) or mixed page (with both color and B&W 
images / texts).

Grayscale images created in RGB applications (such as PowerPoint) should be 
specified as Monochrome or submitted to the system with B&W Printing 
selected in the PPD. This selection ensures that grayscale images are counted 
as B&W instead of Color in both the CSX2000 Color Server and in the 
DocuColor 2045 / 2060 billing meters.



62 Chapter 3  Basic Printing Workflow

Gallop

Gallop allows concurrent RIPping and printing of the same VI job.

Large jobs do not have to be RIPped entirely to disk before printing. 
Gallop lets you pre-define the number of pages to be processed before 
the printing stage begins. As soon as these pages are processed, 
printing starts while the rest of the job is being RIPped.

To use the Gallop option:

! Select Yes to start printing the job while it is still being RIPped.

In the Print after: box, type the number of pages to be RIPped 
before printing begins.

Or:

Select No to RIP a job completely before starting to print it.
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Paper Stock Tab

The Paper Stock tab lets you determine the paper stock. If the selected 
paper stock is not available, printing of the current job is frozen until 
the stock is replaced and an alert message appears.

Paper Size

To use the Paper Size option:

! Select the paper size on which to print from the list:

For all paper stock exceptions, except Admin Page, Imposition is unavailable 
(refer to Exceptions on page 50).
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For a custom paper size setting, select Custom from the list. 

To use Custom paper size:

1. Type the units of measure (selected in the Administration window). 

2. Select a feed direction: 

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)
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Type

To use the Type option:

1. Select Paper to print on paper.

Or: 

Select Transparency to print on transparencies.

2. When the stock type is Transparency, select Add Interleave to 
insert a blank page between transparencies. 

3. For Add Interleave, select the following properties:

• Paperweight

• Coating

• Tray
Notes:
1. Slip-sheets and / or blank pages in a transparency job (interleave) are counted 
in the Number of Sheets, not in the Number of Pages, (rastered pages) reported 
on the Admin page.
2. If the job is imposed, then the interleave is the size of the imposition sheet and 
is inserted between each sheet (not each slide).
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Weight

To select the required stock weight:

! Select the paper weight from a range of supported paper weights 
from the drop-down list.

Coating
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To use the Coating option:

! Select Coated to print on coated paper.

Or: 

Select Uncoated to print on uncoated paper.

Tray

To use the Tray option:

! Select Auto to select the required paper stock from all paper trays.

Or: 

Select a specific tray from the drop-down list to print only from 
that paper tray.

Printing uses the paper in the selected tray only if it complies with all the other 
paper stock parameters. If the paper stock in the assigned tray mismatches with 
any Job Stock parameter, the job becomes 'Frozen' (refer to Chapter 7, Queue 
Manager).
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Print Quality Tab

The Print Quality tab provides you with features that enhance image 
and text quality during the RIPping process, including text quality, 
image quality, trapping, black overprint and PostScript overprint.

Text / Line Quality

Text / Line Quality refers to the Creo anti-aliasing algorithm for 
superior text quality. Text / Line Quality and text and line-art elements 
are processed separately to produce optimal rendering of all the 
elements on a page. This option performs the following:
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• Improves the text quality of diagonal lines, borders and blends 

• Causes blends to appear smooth with no banding 

• Displays crisp diagonal lines without (or with minimal) jaggies - 
rough edges that are the result of the limited resolution of the print 
engine. The following illustrations display the effects of this 
feature: 

To use the Text/Line Quality option:

! Select High to improve the text quality of diagonal lines, borders 
and blends by providing superior text quality (in other words using 
the Creo Anti-Aliasing algorithm).

Or:

Select Normal for a standard quality text without anti-aliasing.

Normal (with jaggies) High

Notes:
1. Anti-aliasing is used to avoid or minimize jagged edges - rough edges around 
an images� edges. Jagged edges result from limited resolution of the original file. 
2. Do not use Text / Line quality option High for VI jobs.
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Image Quality

Image Quality refers to the ability to maintain the same detail and 
smoothness with different degrees of enlargement.
To use the Image Quality option:

! Select Normal for jobs that do not contain various resolutions.

Or:

Select High to improve the picture quality of the images in a job 
which contain various resolutions, such as images downloaded 
from the internet and low-resolution images of digital cameras. 

This feature is especially useful when your PostScript file includes several 
images at different qualities (for example, that were rotated, scanned at different 
resolutions, or were downloaded from the Internet).
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Trapping

Trapping is a solution that solves mis-registration between color 
separations in both offset and digital printing. This occurs no matter the 
accuracy of the printing device. This problem results in white lines 
around objects on top of a background (in a knock-out procedure) and 
also between adjacent colors. The solution is to extract the element 
and/or the background in order to create an overlap between them. 
Refer to the below illustration for Trapping�s effect:

Printed without Trapping Printed with Trapping

Do not use this option with VI jobs.
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To use the Trapping option:

! Yes applies the Creo FAF (Full Auto Frame) algorithm to the job.

Or:

No does not begin the image trapping process of the job during 
RIPping (this does not affect trapping incorporated by the 
authoring application). If trapping was applied in the authoring 
application, select No.

Frame Thickness

Frame Thickness refers to the thickness of Trapping. The thicker the 
frame, the less chance that white lines / areas appear between images. 

! Select the default (0.08mm) or manually type a value for the 
thickness of the Trapping effect. 

Protect Small Text

Select Protect Small Text (default) for small or complex images as 
thicker frames can decrease quality by hiding part / s of an image.
! Select Protect Small Text so that any text smaller or equal to 12 

pt. is not framed during FAF.

Or:

Clear this option to frame all text elements during FAF, according 
to the Frame Thickness above.

When Yes is selected, the Frame Thickness and Protect Small Text options 
are activated.

No does not affect trapping incorporated by DTP applications (for example 
PhotoShop). 
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Black Overprint

Occasionally, white lines may appear around black text. The text may 
appear less dense than required as a result of misregistration between 
color separations. Black Overprint is used to ensure that black text 
prints cleanly within a tint or picture area. The text appears in a richer, 
deeper black, with the underlying CMY values equal to those of the 
printed background. 

When Black Overprint is active, there are no knock-outs under the 
black text. Black Overprint prints text over coated backgrounds rather 
than knocking out the background first. As a result, misregistrations 
are not visible.

To use the Black Overprint option:

! Select Yes to provide better printing quality (for example, as in 
FAF). This results in a lighter black.

Or:

Select No to leave the job as is. The black image is not printed 
directly on top of the page. The effect resembles an image without 
trapping. 

Notes: 
1. Black Overprint should always be set to Yes. This gives better results when 
printing black text and graphics. Black Overprint applies only to 100% black.
2. A knock-out occurs when you print only the topmost color. This results in 
lesser color density and can cause misregistration if separations are not 
perfectly aligned.
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PS Overprint

In the authoring tool, you can select overprint options. PS (PostScript) 
Overprint offers the option to use the overprint, which exists in the PS 
file. It also determines whether DTP application PS Overprint settings 
are honored in the RIP.
CSX2000 Color Server settings override PS Overprint commands from 
DTP applications. For example, if PS Overprint has been set to Yes in a 
DTP application, selecting PS Overprint No in the CSX2000 Color 
Server results in no overprinting. The CSX2000 Color Server can not 
create PS Overprint that is not pre-defined in the file. Selecting PS 
Overprint Yes for a file that has not had overprinting defined in a DTP 
application results in overprinting
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To use the PS Overprint option:

! Select Yes (default) to instruct the RIP to use the overprint 
information that exists in the input PostScript file. Also, if PS 
Overprint is applied in a DTP applications, it is implemented by 
the CSX2000 Color Server. Background colors are not knocked 
out. 
For example, in the case of a yellow triangle overlapping a cyan 
circle, selecting Yes results in the overlapping area turning green. 
This is not seen on the screen, only in print.

Or:

Select No to ignore the overprint information that exists in the 
input PostScript file. Background colors are knocked out and only 
the top most color parts are seen on the screen in your DTP 
application.
For example, in the case of a yellow triangle overlapping a cyan 
circle, selecting No results in the cyan background being knocked 
out, so only the yellow is printed. 

The above is true for files with PS Overprint Yes already selected in the DTP 
application.

When using FAF, set PS Overprint to No. 
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Color Tab

The Color tab includes all the color settings that effect the printed 
result (for text and image). From this tab, you can make post-RIP color 
corrections that do not require re-RIP, such as:

• Brightness

• Calibration

• Gradation

• Screening method

• Contrast

" For more information, refer to Color Workflow on page 174.
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Brightness

To use the Brightness option:

! Select Normal for no Brightness correction.

Or:

Move the slider to select the job�s brightness level (the range starts 
from Light to Dark), which decreases or increases the brightness 
respectively. 

When Brightness has been adjusted for an RTP job, no re-RIP is required.
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Contrast

To use the Contrast option:

! Select Normal for no contrast correction.

Or:

Move the slider to select the contrast level for the print job (the 
range starts from Less to More, which decreases or increases the 
contrast respectively. 

When Contrast has been adjusted for an RTP job, no re-RIP is required.
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Rendering Intent

RGB & CMYK Rendering Intent Workflow

You can set any Rendering Intent value for CMYK or RGB elements 
under Rendering indent options. The default value for CMYK is 
Relative. The default value for RGB is Perceptual.

Rendering Indent Options

There are several methods that can be used when translating colors 
form one color space to another. These methods are called Rendering 
Indents because they are optimized for various intended uses.

When working with ICC profiles, it is important that you select the 
Rendering Indent that best preserves the important aspects of the 
image. 

The CSX2000 Color Server supports all four rendering style options:

• Perceptual (Photographic)

• Relative Colorimetric

• Absolute Colorimetric

• Saturated (Presentation)
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Each rendering style option specifies a CRD for color conversions. 
You can modify the rendering style option to control the appearance of 
images, such as prints from office applications or RGB photographs 
from Photoshop.

Perceptual (Photographic) (default) method preserves the visual 
relationship among the colors as they are perceived by the human eye. 
In other words, all colors are proportionally scaled to fit the output 
gamut. All or most colors in the original are changed but the 
relationship between them does not change.
This method is recommended when working with realistic images such 
as photographs, including scans and images from stock photography 
CDs. 
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In Relative Colorimetric method, colors that fall within the output 
color space remain the same. Only colors that fall outside are changed 
to the closest possible color within the output color space. 
When using this method, some closely related colors in the input color 
space can be mapped to a single color in the output color space. This 
reduces the number of colors in the image.

Absolute Colorimetric is similar to Relative Colorimetric except that 
it does not make adjustments according to the white point. In this 
method, colors that do not fit within the output color space are 
rendered at the extremes of the output color space. Colors that fall 
inside the output color space are matched very accurately. 
This method is valuable for representing �signature colors�. Colors 
that are highly identified with a commercial product such as the cyan in 
the Creo logo.
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Saturated (presentation) scales all colors to the strongest saturation 
possible. The relative saturation is maintained from one color space to 
another.
This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for mixed 
pages that contain both presentation graphics and photographs.

Ink Saving (GCR)

Ink Saving GCR (Gray Component Replacement) replaces the gray 
component (CMY) of each pixel with Black toner. 
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To use the Ink Saving (GCR) option:

! Select No to not use GCR. 

Or:

Select Low, Medium (default) or High to set the amount of CMY 
toners to be replaced by the Black toner. 

Screening Method

Screening converts CT and LW images into information (halftone dots) 
that can be printed. The human eye �smooths out� this information, 
which seems visually consistent with the original picture. Thus, the 
more lines per inch, the more natural the image appears. 

For optimal printing performance, use Medium (default) GCR. 

Use High to provide low ink coverage while saving on toner (this prevents the 
occasional peeling of ink and the curling effect that may occur when 
printing transparencies).
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To use the Screening Method option:

! Select Automatic, which applies two types of screens: 

• For CT, the system uses Dot type screen of 200 lpi. 

• For text / line-art elements, the system uses Dot type screen of 
200 lpi for all colors below a system-preset threshold. It uses 
Line type screen of 600 lpi for colors that are equal to or higher 
than the system-preset threshold:

Dot 150 applies Dot type screen of 150 lpi.

Dot 200 applies Dot type screen of 200 lpi.

Line 200 applies Dot type screen of 200 lpi.

Line 300 applies Dot type screen of 300 lpi.

Line 600 applies Dot type screen of 600 lpi.

Or:

Select a specific screening method from the drop-down list. For 
CT images, use Dot. For LW images, use Line. 
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Gradations

To use the Gradations option:

! Select None for no gradation.

Or:

Select one of the gradation curves from the drop-down list.

Add, remove, and edit gradation tables by selecting Gradation from the Tools 
Bar. 

" For further information, refer to Gradation Tool on page 182.
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Calibration 

To use the Calibration option:

! Use the default calibration table.

Or:

Select a calibration table from the drop-down list.

For optimal printing performance, use the �Normal� (default) Calibration setting 
(with Medium GCR).

" For further information, refer to Calibration on page 196.
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RGB Workflow

This workflow lets you select a profile for printing images when 
opened in another application that supports ICC color management.

CSA (Color Space Array) is the spectrum of specific variants of a color 
model with a specific gamut or color range. For example, within the 
color model RGB, are a number of color spaces (such as: Apple RGB, 
sRGB, and Adobe RGB). While each of these define color by the same 
three axes (R, G, and B), they differ in gamut and other specifications.

CSA is comprised of a three-dimensional geometric representation of 
colors that can be seen / generated using a certain color model and are 
quantitatively measured.

Source CSA is to be used only under the assumption that the upstream 
color workflow was managed and monitored. Otherwise use the 
Replace With option. By default, Source CSA is replaced with the 
Creo CSA.

There are three CSAs with gamma of 1.8, 2.1 and 2.4. The higher the 
gamma, the darker the RGB appears.
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Use this workflow when you have images from different sources (such 
as: digital cameras, Internet, and scanners) and you want the images to 
have the common RGB color spaces. 

To use the RGB Workflow option:

! Select Use Source CSA profile to use the embedded CSA. 

Or:

Select Replace with to select a required CSA from the drop-down 
list. 

CMYK Workflow

CMYK Workflow is used to emulate printing of files that were 
originally targeted at other output devices or print medias. 
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To use the CMYK Workflow option:

! Select one of the following options:

• Use Original CMYK Values does not modify the CMYK 
values. The CMYK element is sent as is to the printer.

• Use Source CSA uses the current CSA if the PS file has an 
embedded CSA.

• CMYK Emulation LAB forces the DFE to modify all CMYK 
elements. 
When None (default) is selected, the system processes CMYK 
jobs without modifying the CMYK values (in other words no 
color management modification occurs during the RIP). 
When another option is selected, the system emulates the 
selected option during the RIP process. GCR and CMYK 
Emulation do not affect the processed job.

The CSX2000 Color Server supports LAB color profiles. The ICC (International 
Color Consortium) profiles imported to the system for CMYK Workflow should be 
based on CIE LAB values.
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Imposition Tab

Use the Imposition tab to set job options related to positioning, 
folding, trimming and binding of pages. 

After selecting the Template parameter, a dynamic thumbnail view 
appears on the lower right hand corner of the Imposition tab. It shows 
the effect of your parameter choices on the printed sheet. Parameter 
setting conflicts are highlighted in red, or with a dotted line.

Method 

Method specifies how printed sheets are finished. 

" For more information, refer to Imposition Theory on page 395.
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After selecting a finishing method, a display icon of the method 
appears in the lower right corner of the Imposition tab. 

Step & Repeat

Step & Repeat is a method used for printing multiple copies of the 
same image so it fills up a larger sheet (for example, many business 
cards on one sheet).

When None is selected, all Imposition parameters become unavailable and the 
thumbnail viewer does not display an image.

It is possible to use specific Step & Repeat templates to print several different 
images on one sheet.
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Within the Step & Repeat method, is the sub-option Cut & Stack. A 
job�s pages, booklets (personalized set of any number of pages), or 
books are sorted in a Z-shape. In other words, each stack of pages is 
sorted in consecutive order. Thus, when stacks are piled one on top of 
another, the entire job is already sorted up or down. 

Saddle Stitch

Saddle Stitch is a book-finishing technique where the pages of a book 
are attached through stitching or stapling in the spine fold 
(for example, for brochures).

When using the Step & Repeat template for VI jobs, the system prints it in Z-
Sorting mode. This mode allows imposed VI jobs to be sorted for Cut & Stack 
finishing.



Job Parameters Window 93

Perfect Bound

Perfect Bound is a book-finishing technique where the pages of a book 
are attached through trimming of the spine fold, roughening the edges 
of the gathered pages and gluing them together (for example, for 
hardcover books).

Size

To use the Size option:

Select the size parameter by defining the following:

• Sheet size

• Trim size

• Bleed size
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Sheet Size

Sheet size is the actual physical paper size. Define the paper stock size 
that the job will be printed on. It overrides the Paper Size job 
parameter in the Paper Stock tab. 

! Select the default sheet size taken from the PS file.

Or:

Select from the drop-down list of available sheet sizes.

 

Or:

Select Custom to define the height and width of the sheet (based 
on the document size you defined in the DTP application) and the 
feed direction. 

• In the H: and W: boxes, manually type the height and width (in 
inches).

• Under Feed Direction, select LEF or SEF (for more information, 
refer to Template Orientation on page 401). 
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Trim Size 

Trim size is the actual page size (which contains the whole image) on 
which you work in your authoring tool. 

! Select from the drop-down list of available trim sizes.

Or:

Select Custom to define a custom trim size. 

• Set the height and width of the finished page. 

Bleed Size

Bleed extends part of the printed page image beyond the trimming 
boundary. This avoids white edges after cutting and folding pages with 
elements adjacent to the edge of the page.

! Select To Fold in order to extend bleed to the sheet fold lines.

Or:

• Select Custom and specify the Bleed Size. Type a value in 
millimeters.

If a file incorporates bleed previously applied in a DTP application, applying 
bleed results in the bleed effect. If bleed has not been incorporated in the file, 
application of bleed on the CSX2000 Color Server does not create bleed.

You cannot extend the bleed size beyond the sheet fold lines. Bleed does not 
affect the position of crop marks.
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Template

A template is a set of parameters that determines how your finished 
sheet is printed. The template parameter includes:
• Available template list

• Thumbnail viewer

Each Imposition method has its own specific template choices. For 
example, if you change your Imposition method from Perfect bound to 
Step & Repeat, your initially selected template no longer fits the new 
method.

Upon selecting the Template job parameter, a dynamic thumbnail 
viewer appears at the lower right hand corner of the Imposition tab. It 
lets you perform a dynamic visual check of your job at any stage of 
defining Imposition parameters. 
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The thumbnail viewer provides important information about your 
imposition settings by indicating:

• Conflicting parameter settings (dotted lines indicate sheet size, red 
corners indicate pages that extend the sheet boundaries and are 
printed outside of the printable area) 

• Page orientation by arrows� directions. Arrows point to the head of 
the page. Upward pointing arrows always indicate column 
direction.

• Pages� sequence by page numbers

To use the Template option:

1. Select a template from the drop-down list of available templates.

2. Select a layout from the drop-down list of available layouts (if you 
selected User Defined for Category, then Layout is not an 
option). 

3. Select the option Fit to Sheet to proportionally increase or 
decrease the entire layout in order to fill the entire sheet size.

If any red corners or dotted lines appear in the thumbnail view, adjust your 
imposition settings to resolve any imposition parameter conflicts. This situation 
can occur after each imposition parameter modification. 

" For further details, refer to Imposition Theory on page 395. 
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Marks

To use the Marks option:

! Check Add Crop Marks for lines to indicate where the sheet is to 
be cropped.

Or:

Check Add Fold Marks for lines to indicate where the sheet is to 
be folded.

Crop marks are placed according to Trim Size parameters. A minimum of 6mm 
are required for crop marks and 10mm for fold marks.
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Margins

The Margins job parameter lets you adjust the spaces between the 
outside edges of pages and the edges of the sheet on which they are 
printed. Margin settings should suit finishing equipment and 
requirements. Confirm binding parameters with your binder when 
planning your sheet.

Spine Trim Size 

Spine trim size is the space between adjacent pages on a printed sheet, 
which, when folded into a signature / booklet, allows for grinding and 
perfect binding. Spine trim size is used with the Perfect Bound method 
only. If the Saddle Stitch method is used, this value is set to zero and 
the pages are printed side by side without any space between them.
This option is only available for Perfect Bound.
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Minimum Gutter Size

The gutter is the inside space between pairs of pages on a sheet. When 
folded into a signature / booklet, the gutter allows space for trimming.

Minimum Margin Size

Margin size is the distance between the outside edges of the sheet and 
the edges of the pages printed on the sheet. You can set the minimum 
margin size, but not the exact size, which is calculated by the CSX2000 
Color Server in accordance with other imposition parameters.

To use the Margins option:

1. Set Spine Trim Size.

2. Set Minimum Gutter Size.

3. Set Minimum Margin Size.

Creep

Creep compensates for the minute movement inside signatures away 
from the spine in a folder of a saddle stitch bound signature / booklet. 
Creep options include Total Creep In and Initial Creep Out.

For specific sheet templates there may be only one gutter or no gutter at all (in 
other words, in two up, there is no gutter). In these cases, the Minimum Gutter 
Size setting is ignored.
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Total Creep In 

Specifies the amount of movement towards the spine applied to the 
center two pages and their backs-the pages that require the most 
compensation. From the center quartet of pages back towards the 
outside four pages of a job, the CSX2000 Color Server automatically 
applies an ever-decreasing amount of movement. Every quartet of 
pages is moved by an amount less than the previous quartet. The 
outside two pages and their backs are not moved. 

Initial Creep Out

You might find that page images sometimes get too close to the spine. 
This problem can be resolved by giving a value for Initial Creep Out. 
This shifts all the pages of the job further out towards the outside 
margin (away from the spine) by the specified amount. This movement 
takes place before the Total Creep In value is applied. 

To use the Creep option:

1. Set amount for Total Creep In in millimeters.

Or:

Select Auto for an automatically generated value based on all of 
the following: 

• Total number of pages for one copy

• Selected template 

• Paper stock weight 

• Paper stock coating

2. Type the amount for Initial Creep Out.

If paper stock weight or the template is modified for a job, Auto creep values are 
automatically recalculated.

Units of measurement (mm or in.) reflect system configuration. They are chosen 
in the Administration window.
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Services Tab

Select the Services tab to set deletion policies for completed and failed 
jobs and to set font substitution, APR and Job Flow parameters.

Job Deletion

On large VI jobs, which take up a large amount of the CSX2000 Color 
Server�s disk space, it is recommended (if you do not need to reprint 
the job) to use the Job Deletion option. 
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Job Deletion is initially set to Save. Completed and failed jobs are 
automatically saved in the Storage Folder unless you check one of the 
Job Deletion options check boxes. 

To use Job Deletion:

1. Suspend the Process queue.

2. Import your job.

3. Select Delete Completed Jobs to remove jobs so they will not be 
printed. This option continuously deletes pages once they have 
been successfully printed and thus sustains enough free disk space 
for the duration of the print run

Or:

Select Delete Failed Jobs to remove failed jobs (while processing 
or printing) from the CSX2000 Color Server.

4. Press OK to close this window.

5. Release the Process queue to initiate job processing and printing.

6. Each successfully printed page of the job is immediately deleted 
while the rest of the job is still in the queue to print.

Notes: 
1. When the SpoolStore virtual printer has been selected, jobs remain in the 
Storage Folder.
2. When printing VI jobs, or when using Gallop, it is recommended to activate the 
Job Deletion options. 



104 Chapter 3  Basic Printing Workflow

Substitute Fonts

To use the Substitute Fonts option:

! Select No to halt processing if the required font is missing.

Or:

Select Yes to substitute any missing font with the corresponding 
font set in the Administration window as the Substitution Font.

When font substitution is performed, a message appears in the job history of the 
specific file. For more information, refer to Job History on page 349.

" For information on fonts and managing them, refer to Fonts on page 34.
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APR

APR is the mechanism that lets you work with low-resolution images 
(for layout purposes). It automatically replaces these images with their 
associated high-resolution images during the RIP. The CSX2000 Color 
Server is predefined with an APR path for placing your high-resolution 
files. This path is located in D:\Shared\High Res.

To use the APR options: 

APR options

! Select Print with High Res to use the high-resolution images in 
your printed job.

Or:

Select Print with Low Res to print the job with the low-resolution 
images.

The path to the high-resolution file folder is specified in APR Path. It is also 
possible to search sub-folders for high-resolution images.
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Use APR Mask from

! Select High Res to use the masking data contained in the high- 
resolution file (if such data exists).

Or:

Select PS Image (low-resolution) to use the masking data 
contained in the low-resolution image file.

Or:

Select Both to use only the masking data common to both the high- 
resolution and the low-resolution image files (in other words, if the 
images defined by the two sets of masking data overlap, then this 
overlapping area is RIPped). 

APR Path

! Copy your high-resolution files to the CSX2000 Color Server 
default folder D:\Shared\High Res. This is where the CSX2000 
Color Server looks for them when it RIPs the job.

Or:

Click Add for the APR Editor. Here, you can add additional paths 
in which to look for the high-resolution images (or to change the 
order in which the paths are searched).

If, for example, the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the high-
resolution file, no masking data is used. 

You can also define a custom path to any connected server or disk. 
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APR Editor

The APR Editor window displays the default path and other pre-
defined paths. Add paths for high-resolution images or modify the 
order in which the paths are searched. 

1. Check Include Subfolder to include all the sub-folders of the 
selected paths on the search. 

2. Click the arrow buttons to set the system search order.

3. Click New Path to add a path. Locate a required path, for example 
CD-ROM containing your high-resolution files. This option can 
save copying your files over the network.

4. Select one or several paths and click Delete to remove the path(s) 
form the search. 

5. Click OK to confirm an action.

6. Click Cancel to an action.

Notes: 
1. The order in which the paths are listed specifies the order of searching for the 
high-resolution images.
2. You can have more than one APR path, for example you want to create 
different paths for different customers. 
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Job Flow

The Job Flow parameter shows the sequence of operations that the 
CSX2000 Color Server performs on a job.

To use the Job Flow option:

! Select ProcessPrint for the CSX2000 Color Server to RIP the 
PDL files, print them, and store them in the Storage Folder (unless 
the Job Deletion policy parameter is set to Delete Completed 
Jobs).

Or:

ProcessStore to RIP the PDL files and move them to the Storage 
Folder as RTP jobs.

Or:

SpoolStore for the CSX2000 Color Server to place the PDL files 
directly into the Storage Folder without processing them.

" For further details, refer to Job Deletion on page 102.
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Compression

Compression is a feature that attempts to solves problems when 
printing fails. In such cases, the following message may appear in the 
Alerts window:

"Job failed in print. Please try to change paper 
feed direction or set compression to high level 
from services tab."
To use the Compression option:

! Select Normal to deactivate the Compression process.

Or:

Select High to use Compression. Also, select High if the above 
message appears.

Notes:
1. When printing with compression, some job quality may be lost.
2. This feature should only be used if recommended by the application. 
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Preflight 

You can run a preflight check on a job when it starts running in the 
process queue. You can print a report (and save it as a text file) 
indicating the presence or absence of any of the job resources.

To use the Preflight option:

! Select Skip Preflight Check to not use this process.

Or:

Select Run preflight check to activate this process. You can select 
any of the following job resources, on which to run a Preflight 
check:

• High Res 

• Fonts

If one of the checked resources on the list is missing, then the job status 
at the end of the Preflight check is �Failed� and the job is transferred to 
the Storage Folder. 

The Preflight check runs through the entire file and does not fail on the first 
missing resource. 
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Job Info 

Job Info helps in tracking and assigning jobs.

To use the Job Info option:

! Type the following free-text information (these entries can also 
apply to non-successfully completed jobs):

• Job Title

• Sender 

• Account

• Recipient

• Job Comments
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Finishing Tab

The Finishing tab refers to the final details regarding printing the job, 
such as: 

• Additional pages to the job

• Destination / printing path of the pages

• Stapler options

Admin Page

Admin Page includes general information about the job, including 
paper stock parameters (Admin page can also apply to non-
successfully completed jobs).
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Admin page is printed in the same order as the job, before each set for 
face-down printing and after each set for face-up printing.

To use the Admin Page option:

! Select Do Not Print Admin Page (default value).

Or:

Select Use paper stock. Select the following paper properties:

• Paper Weight

• Coating

• Tray

Slip-Sheet

Slip sheet is the ability to print slip-sheets between copies from a paper 
stock other than the job's paper stock. You can insert slip sheets 
between printed copies for collated jobs or between sets of pages for 
uncollated jobs.

For details on Printing Job Ticket Parameters, refer to Printing the Accounting 
Report on page 374.
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To use the Slip Sheet option:

! Select Do not print slip-sheet (default value) for no slip sheet.

Or:

Select Use Paper Stock to use a slip sheet / s. Select the following 
paper properties:

• Paperweight

• Coating

• Tray

Front Cover

You can print the front cover (first page of the job or first two pages of 
the job in the case of duplex) on different paper stock than that of the 
job. 

Notes:
1. Slip-sheet size must be the same size as that of the job. If the job is imposed, 
then the slip-sheet is the size of the imposition sheet.
2. Slip-sheets / blank pages in a transparency job (interleave) are not be counted 
in the Number of Pages reported on the Admin page.
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To use the Front Cover option:

! Select Do Not Print Front Cover (default value) for no front 
cover.

Or:

Select Use paper stock to print a front cover. Select the following 
paper properties:

• Type

• Paperweight

• Coating

• Tray

In Cover Printing options:

• None (default value) does not add an extra page as the front cover. 

• Print on Front Side adds an extra page for the front cover sheet, 
printing only on the front side.

• Print on Both Sides adds an extra page for the front cover sheet, 
printing on both sides.

Cover size must be the same as that of the job. If the job is imposed, then the 
Admin page is the size of the imposition sheet.
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Back Cover

You can print the back cover (last page of the job or last two pages of 
the job in the case of duplex) on different paper stock than that of the 
job. 

To use the Back Cover option:

! Select Do Not Print Back Cover (default value) for no back 
cover.

Or:

Select Use paper stock to print a back cover. Select the following 
paper properties:

• Type

• Paperweight

• Coating

• Tray
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In Cover Printing options:

• None (default value) does not add an extra page as the back cover. 

• Print on Back Side adds an extra page for the back cover sheet, 
printing only on the back side.

• Print on Both Sides adds an extra page for the back cover sheet, 
printing on both sides.

Finisher

To use the Finisher option:

Select a Finisher module from the drop-down list to select the printed 
output�s destination: 

• HCS (High Capacity Stacker)

• HCSS (High Capacity Stacker Stapler)

• OCT (Output Cache Tray)

Cover size must be the same as that of the job. If the job is imposed, then the 
Admin page is the size of the imposition sheet.

Notes:
1. The finisher module must be connected to the CSX2000 Color Server.
2. For PostScript files, available stapling methods depend on page orientation 
and size. For PDF files, stapling methods depend on page size.
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If your printer is equipped with an HCS, you can select HCS. 

! Select Top Tray to print to the top tray.

Or:

Select Stack Tray to print to the stack tray (the internal tray).
Use Offset for both collated and uncollated jobs. 

• For collated jobs, each copy is offset from the next copy.

• For uncollated jobs (only if you requested more than one copy 
of each page), Offset shifts the sheets when a new page number 
is delivered. For example, you requested 3 copies of each page. 
Thus the printing output sequence is as follows: Page1, Page1, 
Page1, Offset, Page2, Page2, Page2, Offset, and so on. 

Or:

Select Bypass Tray so that sheets are not stacked directly on top of 
each other, which makes it more efficient to take printed material. 
Bypass Tray prints to a connected DFE (digital front end finisher 
connected to the bypass tray) device using the Bypass tray.
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If your printer is equipped with a HCSS, you can select HCSS. 

! Select Top Tray to print to the top tray.

Or:

! Select Stack Tray for printing to the Stack Tray (usually for many 
pages / copies). 
Select the following parameters for Stack Tray:

• Use Offset for both collated and uncollated jobs.
For uncollated jobs, if you requested more than one copy of a 
page, Offset shifts the sheets when a new page number is 
delivered. For example, you requested 3 copies of each page. 
Thus the printing output sequence is as follows: Page1, Page1, 
Page1, Offset, Page2, Page2, Page2, Offset, and so on. 

• Check Staple to select the required stapling method. Stapling 
icons automatically appear below. Select from these available 
stapling methods.

• Rotate 180 (only relevant for the Stack Tray > Staple option), 
lets you modify the stapling position by 180 degrees. For 
example, instead of stapling on the upper left-hand corner, you 
can staple on the lower right-hand corner.

Select OCT print to the output cache tray. 

To select stapling from the PPD, first select a stapling position and then select 
HCSS.
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Exception Tab

In the Exception tab, you can assign special pages within the job (such 
as: Admin page, Interleave, Slip-sheet, and Covers) to any media stock 
in the IOT. This option includes assigning new paper stock to the new 
print range and inserting new paper stock between pages in a job.

Define paper stock attributes and parameters for special exceptions 
within a job (refer to Paper Stock Tab on page 49).

To use the Exception option:

1. Under Exception Properties, manually type values for from page 
and to page.

2. Under Paper Stock Properties, choose values for the following 
properties:

• Type

• Paperweight

• Coating 

• Tray
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Defining and Editing Virtual Printers
To define and edit a virtual printer:

1. Access the Virtual Printers dialog box via Administration > 
Resource Manager > Virtual Printer.

2. The Virtual Printers dialog box appears. From the three buttons on 
the left, you can perform one of the following:

• Add a new virtual printer

• Rename a virtual printer

• Delete a virtual printer
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3. In the Add new Virtual Printer dialog box, enter the following 
information:

• Printer name

• Based on

• Comments
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Advanced Printing Workflows
This chapter describes the CSX2000 Color Server Advanced Printing 
Workflows, including Print Quality, Imposition, APR and OPI, the use 
of Variable Information on the CSX2000 Color Server and Color.

In addition to the job parameters, sample jobs are detailed to show how 
various job parameters are adjusted for specific types of jobs.



High-Resolution (APR) Workflow 125

High-Resolution (APR) Workflow
Working with high-resolution files during the design and page layout 
process can be a long and inefficient process. Processing and 
manipulation of large files and graphics can be very time consuming. 
To speed up production, it is common to work with low-resolution files 
until the RIPping stage.

The CSX2000 Color Server provides APR (Automatic Picture 
Replacement) and OPI (Open Prepress Interface) image replacement 
workflows for replacing low-resolution files with high-resolution files 
during the RIP. 

APR and OPI workflows are accessed through the Job Parameters 
window > Services tab.  

" For further details, refer to Services Tab on page 102 and APR on page 105.

High-Resolution Image File, 5.23 MB Low-Resolution Image File, 306 KB
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Use APR and OPI to:

• Minimize production time with faster image processing and 
working in DTP applications.

• Reduce the time to create PostScript files and to print.

• Decrease network traffic.

APR (Automatic Picture Replacement)

APR is a Creo-developed image replacement method for PostScript 
files. APR is a standardized set of file instructions that specify how an 
external high-resolution image is placed in a PostScript file as it goes 
to RIP. The instructions specify the type, size, position, rotation, 
cropping and location of the high-resolution images themselves. 

When you send your PostScript file to be processed, the CSX2000 
Color Server checks it for APR instructions. It then searches for the 
external high-resolution file, performs the specified image replacement 
and RIPs the PostScript file.

OPI (Open Prepress Interface)

Like APR, OPI is a standardized set of file instructions that specify 
how an external high-resolution image is placed in a PostScript file as 
it goes to RIP. The instructions specify the type, size, position, rotation, 
cropping and location of the high-resolution images themselves. 

When you send your PostScript file to be processed, the CSX2000 
Color Server checks it for OPI instructions. It then searches for the 
external high-resolution file, performs the specified image replacement 
and RIPs the PostScript file.

Many OPI systems use remote storage of high-resolution files. The 
CSX2000 Color Server supports the storage and replacement of high- 
resolution OPI files internally. 
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APR and OPI File Formats

APR and OPI are functionally identical on the CSX2000 Color Server. 
APR low-resolution files have a *.e extension, while OPI low- 
resolution files have a *.lay extension. The APR and OPI workflows 
support Creo Continuous Tone, EPSF and TIFF high-resolution file 
formats. 

You can use either the APR or OPI workflow, depending on your high- 
resolution file type.

High Resolution

The High Res utility in the Resource Manager lets you organize
your high-resolution files. High-resolution files are required for the
APR and OPI workflows. You can add or delete high-resolution files. 
You can also copy high-resolution files from a local hard disk, from the 
network, or from external media (for example, CD-ROM, Jazz drive or 
floppy). There is a default shared folder set on the system dedicated to 
high-resolution files. The folder resides in D:\Shared\HighRes.

To organize your high-resolution files: 

1. Access the High Res folder via Admin > Preferences > High Res.

Windows Explorer displays the contents of your High-Res folder.
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2. You can add files to the High-Res folder, delete files from it, and 
copy files from an external media.
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Setting the High-Resolution File Path

If your high-resolution files are not located in the CSX2000 Color 
Server default folder, you must specify the APR path(s) in the Job 
Parameter window Services tab before printing: 

1. Print or download your job from the client workstation to the 
Storage Folder in the CSX2000 Color Server workspace. Or import 
the job to the Storage Folder.

2. Double-click on the job in the CSX2000 Color Server workspace.

3. Adjust the job parameters.

4. In the Services tab, click APR. 

5. In APR Path, Click Add.

The APR Editor window appears, indicating the default path. 
Select the default path or add additional paths to define the location 
of your high-resolution images.

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44. 

" For further details, refer to APR Path on page 106.
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You can perform the following functions in the APR Editor:

• Check Include Subfolder to include all the sub-folders of all 
the specified paths.

• Click New Path and locate a required path.

• Change the order of paths to change the order in which they are 
searched. Click the arrow buttons to move a path up, down, to 
the beginning of the search, or to the end of the list.

• Select one or several paths and click Delete to remove the 
path(s) from the search.
If a path is not specified, the CSX2000 Color Server looks for 
high- resolution files in the default path and predefined paths, 
according to the order that they are listed.
Paths other than the default path are defined on a per-job basis, 
or set in the virtual printer. The order in which the paths are 
listed determines the order in which the CSX2000 Color Server 
searches for the high-resolution files. Specify paths on local 
hard drives, CD-ROM drives, and the floppy drive connected to 
the CSX2000 Color Server. Or you can specify paths on remote 
clients / file servers.

6. Set other high-resolution job parameters as required.

Preparing to Print Using APR or OPI
Before printing using APR or OPI: 

1. Create low-resolution files from high-resolution files.
PS Image (APR low-resolution) files can be created in Adobe Photoshop® 
using the PS Image Exporter Plug-In. The PS Image Exporter Plug-In can be 
installed from the Spire Documentation and Utilities CD-ROM. Or 
download it from the Creo website at www.creo.com.
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2. Export each image file as a low-resolution *.e file 
(in other words a file called duck is exported as duck.e). 
OPI images can be created in other applications or can be provided 
by a print service bureau. Ensure that you have created or obtained 
the required image files.

3. Design the document in a DTP application using low-resolution 
files.

4. Perform detailed graphic work on the original high-resolution file. 
The low-resolution file is used for positioning, rotating, scaling 
and cropping only. 

5. Place the high-resolution files in a defined path on the CSX2000 
Color Server. This is where the CSX2000 Color Server looks for 
them when it RIPs your jobs. Define the high-resolution path 
through the Job Parameters window for each job.

Printing with APR or OPI 

If your high-resolution files are located in the CSX2000 Color Server 
default folder (D:\Shared\HighRes), you can print APR or OPI jobs 
without adjusting APR settings. Perform the following steps:

Notes: 
1. A PS Image (*.e) file is a low-resolution preview of the original high 
resolution file. It contains preview information saved at 72dpi in black 
and white or color. Also, it contains pointers to the location of the high-resolution 
Image.
2. APR low-resolution files have a *.e extension. OPI low-resolution files have a 
*.lay extension. 

Once you have created the low-resolution file, do not change the name of 
the high-resolution file. This is the file name that the CSX2000 Color Server 
looks for.

Notes:
1. The CSX2000 Color Server default HiRes folder used for APR and 
OPI is E:\Shared\HiRes.
2. Paths other than the default path are defined on a per-job basis. You can 
define the APR path to any connected server or disc
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1. Print, download or import the job from the client workstation to the 
CSX2000 Color Server. Select the CSX2000 Color Server virtual 
printer you wish to print to.

2. The job is processed and printed according to the settings of the 
selected virtual printer using APR or OPI high-resolution files.
If your high-resolution files are not located in the CSX2000 Color 
Server default folder:

3. Specify the APR path(s), as described above.

4. Print or download your job from the client workstation to the 
Storage Folder in the CSX2000 Color Server workspace. Or import 
the job to the Storage Folder. 

5. Double-click on the job in the CSX2000 Color Server workspace.

6. Select the Print Quality tab in the Job Parameters window.

7. Adjust the job parameters.

8. Set other high-resolution job parameters as required (refer to APR 
on page 105). 

9. Click Submit. The job is processed on the CSX2000 Color Server 
and sent to the Xerox DocuColor 2060 / 2045 for printing. 

Organizing High-Resolution Files

You can organize (move, delete) your high-resolution files through the 
Resource Manager found under Tools > Administration. 

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44. 

" For further details, refer to Setting Job Parameters on page 49.

If the masking data in the PS Image file defines a completely different part of
an image than the masking data in the high-resolution file, no masking data 
is used. 

" For further details, refer to the CSX2000 Color Server Installation Guide.
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Sample Job: Printing a Brochure Using the APR Workflow

In this example, you can use APR to print a brochure that contains a 
high-resolution file.

Brochure
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The picture used in the brochure is a high-resolution file called 
milkmaid. In this example, it is assumed that you already created the 
low-resolution file milkmaid.e and that your brochure has already been 
designed in a DTP application using milkmaid.e. 

To print a brochure using the APR workflow:

1. Place your high-resolution file milkmaid in the path: 
D:\Shared\High Res.

2. Print or download the brochure job from your client workstation to 
the CSX2000 Color Server.
The job is processed on the CSX2000 Color Server and sent to the 
Xerox DocuColor 2060 / 2045 for printing.

High-Resolution Image File, 5.23 MB Low-Resolution Image File, 306 KB

On the CSX2000 Color Server, the APR workflow is functionally identical to the 
OPI workflow, so while the high-resolution image used in this example has a *.e 
extension, if it was an OPI image, it would have a alternative extension, such as 
*.lay.
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VI (Variable Information) Workflow
VI jobs are jobs in which the printed materials are individualized for 
specific recipients or purposes. These materials can include bills, 
targeted advertising and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific individual or address.

All VI jobs are constructed as a collection of individually RIPped 
elements that may differ from booklet to booklet, including text, 
graphics, pictures and page backgrounds. Pages are assembled from 
the RIPped elements just before printing. Each element - text, graphic, 
picture, or page background - is RIPped only once, regardless if the 
element is used once, several times, or even in every page of the VI 
job. If it is used more than once, then it is cached for further re-use.

You send VI jobs to the CSX2000 Color Server in Creo Variable Print 
Specification or Xerox Variable data Intelligent Postscript Printware 
(VIPP) formats to be RIPped and printed. The CSX2000 Color Server 
can also process conventional Postscript files as VI jobs, although they 
are not truly VI documents.

The CSX2000 Color Server allows concurrent RIPping and printing of 
VI jobs. Large jobs do not have to be RIPped entirely to disk before 
printing. You can pre-define the number of pages to be processed 
before the engine starts to print. As soon as these pages are processed, 
printing starts while the rest of the job is streamlined through the 
CSX2000 Color Server. The Xerox DocuColor 2060 / 2045 continues 
printing at its rated speed without interruption or slowing down until 
the job is finished.

" For further information, refer to Gallop on page 62.
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Using Creo Variable Print Specification to Print a VI Job 

1. Copy VI graphic elements to one of the defined APR folders on the 
CSX2000 Color Server.

2. Submit your job on the CSX2000 Color Server.

3. Re-usable elements are identified, processed, and placed in the 
cache folder. They are ready for rapid assembly into pages and for 
multiple usage.

4. Your VI job is processed and printed on the CSX2000 Color 
Server.
The Xerox DocuColor 2060 / 2045 prints RTP booklets at full 
engine speed working uninterrupted from the printer disk. 
Booklets are compiled concurrently while the printer prints. As 
pages are sent to the print engine, they are assembled from the 
various Inline and re-usable elements on-the-fly.
Once the job is completed, an RTP job is placed in the Storage 
Folder. This job is identified by the Variable Print Specification 
sub-job name. Booklet and Page descriptions, as well as inline 
elements, are embedded in the RTP job. All sub-job handling is 
done via this RTP job (for example adjusting Job Parameters).

" For further details, refer to APR and OPI File Formats on page 127.

Notes:
1. If an element is to be used more than once but with different clipping or 
scaling parameters, it is treated as a new page element and processed again.
2. The cache is kept intact until the completion of the job, allowing for reuse of 
RIPped elements anywhere in the job. Elements may remain in the cache for 
subsequent jobs. You can also archive job elements.
3. Deleting a job does not delete the cached job sub-folder. This must be done 
manually via the Resource Manager.
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The VI Workflow

VI jobs are created using VI authoring programs that support Variable 
Print Specification and Xerox VIPP formats. Most VI authoring 
programs can convert VI files to conventional PS files, which can also 
be processed by the CSX2000 Color Server, although less efficiently 
than Variable Print Specification and VIPP files.

In VI Jobs, pre-RIPped re-usable elements are combined with inline 
elements during the RIP. Pages are assembled from the various 
elements at high speed on the CSX2000 Color Server as they are fed 
into the print engine.

The re-usable elements are stored in a cache folder. The CSX2000 
Color Server only RIPs inline elements in subsequent jobs using the 
same re-usable elements. The cached re-usable elements are integrated 
into the job during the RIP.

In your VI authoring program (for example Creo Darwin), you can 
define several sub-jobs related to the same VI job, (for example 
different weekly runs, late additions or updates to a database.). This is 
known as batch processing. The CSX2000 Color Server processes the 
first batch that arrives at the system, as described above. When 
processing following batches of the same job, the CSX2000 Color 
Server uses the already cached re-usable elements and adds new re-
usable elements to the cache sub-folder. This saves the initial ramp-up 
time for processing and allow immediate processing at the rated printer 
speed.

" For further information, refer to Organizing VI Elements on page 141.
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VI Document Authoring Programs 

The desktop environment requires an authoring program to design, 
organize and generate VI documents. This program can be stand alone 
covering all aspects of document design, data management, text 
capture, and so on. Or it can be an extension of an existing program 
that allows the creation of VI documents and VI jobs.

VIPP (Variable data Intelligent Postscript Printware)

The Variable data Intelligent Postscript Printware format was 
developed in 1993 by RX (Rank Xerox) Switzerland. The VIPP is 
PostScript based format that composes the VI pages during the 
processing stage. The VIPP is being used for various types of 
applications, but mostly for financial applications (which typically use 
the dynamic graph charting capability of VIPP) and for billing 
statements of banks, telephones, electricity, and so on.

In order to be able to utilize VIPP files on your CSX2000 Color Server, 
the VIPP software should be first installed on your system. This 
installation should be done by a service engineer. Contact your service 
provider for further information.

PostScript Files

The CSX2000 Color Server can also process conventional Postscript 
files as VI jobs, although they are not truly VI documents. All page 
elements are re-RIPped for each page. This workflow is suitable for 
simple, very short run jobs. These jobs do not use a VI authoring tool at 
all. Instead, they use a mailmerge function in a MS Word® document 
or a MS Excel® spreadsheet.
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VIPP (2001) & PPML

The CSX2000 Color Server supports VIPP (2001) and PPML formats 
and the features related to them, for example:

• Processing VIPP (2001) & PPML jobs efficiently

• Providing a management mechanism for VIPP (2001) and PPML 
reusable elements

• Importing jobs in various VI formats to the DFE 

• Importing VI elements to the DFE and submit them for pre-cache

• Viewing VI elements in their structural hierarchy

Both PPML & VIPP2001 have a hierarchical structure. Document 
components are separated from their submission file and can be 
organized and stored in different levels of the hierarchical structure.

Variable Print Specification, VIPP and PPML are displayed under 
matching tabs the Elements Viewer window (refer to Viewing, Deleting 
& Archiving on page 142).

In PPML there is an ability to have different jobs in one PPML file. 
Thus, the display in the navigation pane varies from the Variable Print 
Specification & VIPP appears.

Creo Variable Print Specification

Creo Variable Print Specification is the Creo developed formal 
language designed for effective production of VI documents.

Creo Variable Print Specification is comprehensive and can specify a 
complete range of VI documents. It also provides the means for 
efficient implementation - fast, efficient data processing and storage 
prior to printing.

The following are Variable Print Specification job components:

Booklet

A personalized copy of a document within a single print run where 
pages and / or elements within a page may vary from booklet to 
booklet.
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Sub-job

All copies of a particular document (for example, book, brochure, or 
flyer), within a single print run. On the CSX2000 Color Server, sub-
jobs can be deleted, archived, or reprinted at any time. However, you 
can still maintain re-usable elements for future runs. Re-usable 
elements are cached elsewhere, so only the unique data, which is 
embedded in the job, is deleted.

Re-usable Elements

Self-contained graphical entities that can be line art, text, raster images 
or a combination of these types. Re-usable elements are represented in 
PostScript and can be stored as EPS files when appropriate. Re-usable 
elements include clipping and scaling instructions as well as the image 
data.

Re-usable elements can be used repeatedly in different pages, booklets 
and jobs. On the CSX2000 Color Server, all re-usable elements are 
processed once and cached as RTP elements for further re-use. They 
can then be re-used either within the sub-job itself, or in additional runs 
of sub-jobs.

Inline Elements 

Unique information is drawn from a database and is embedded in the 
sub-job. This data prints only once for individual booklets.

Grayscale TIFF and EPS images created in CMYK applications (such as 
PhotoShop) are counted correctly as B&W instead as Color in both the 
CSX2000 Color Server and the DocuColor 2045 / 2060 billing meters.
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CSX2000 Color Server VI workflow

Organizing VI Elements

The VI Elements utility lets you organize VI elements on your system. 
Jobs that include variable information require that VI elements 
(reusable elements) are stored in a specified location. This allows the 
CSX2000 Color Server to reuse these files when the job is printed for 
the first time and also for future jobs.

VIPP

Variable Information
Job Processing

Very fast data 
processing

Rated Speed RIP

VI workflow
Individual element 
cache and archive,
concurrent RIP and
print error recovery 

PostScript

CreoScitex
V

P
S

ariable
rint

pecification
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Viewing, Deleting & Archiving

1. Access the Elements Viewer window via Admin > Resource 
Manager > VI Elements.

The Elements Viewer window appears.

In the above screen (in Preview mode), your VI job folders are 
displayed in the left pane. In the right pane, there is a thumbnail 
view in the Icon column and other information associated with 
your job.
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2. The Elements Viewer window has two modes: Preview (default) 
and Details. Click on the View button and select a mode.

.

3. Select Details mode to view the element name and system name as 
a list in the cached element window. The remaining information 
(file name, source file, submitted date, size and feed direction) is 
under the thumbnail.

To delete VI elements:

! Select the elements you want to delete and click Delete (from 
either mode). You can also delete the entire folder.

You can resize the VI elements window. The system saves the last setting if 
the window is resized the next time it is opened.
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To archive your VI elements for future use:

1. Click Archive (from either mode). The Save As window appears.

2. Select the folder where you want to archive the VI elements and 
click Save.

VI Element Formats

There are three VI Element formats, each with it own tab on the top-
left side of the Elements Viewer window:

• VPS

• VIPP

• PPML

Each tab displays its own file type with its matching hierarchy (for 
example, the VIPP tab displays only VIPP files with the VIPP 
hierarchy structure). For all formats in the window under the tabs, only 
the folder levels are displayed. While the content of these folders 
appears on the right side. 
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Retrieving VI Elements

To retrieve VI elements from archive:

1. From the Job menu, select Retrieve from Archive.

The Retrieve window appears.

2. Double-click on the folder where your VI elements were archived.

3. Alternatively, select the folder and click Open.
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4. The archived VI elements are retrieved.
To view your retrieve VI elements:

1. Access the Elements Viewer window from Admin > Resource 
Manager > VI Elements. 

The Elements Viewer window appears.
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2. Your retrieved VI file is returned to file tree and listed last.

You can resize the VI elements window. The system saves the last setting if 
the window is resized the next time it is opened.
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CSX2000 Color Server Job Parameters and VI Jobs

You can adjust the job parameters of VI jobs via the Job Parameters 
window, just as with any other type of job.

Special considerations apply to VI jobs when adjusting some job 
parameters.

Using Imposition with VI Jobs

When using Imposition with VI jobs:

• Every booklet must have the same number of pages. 

• In the Step & Repeat method, when printing a single page booklet, 
the VI job does not print the same image repeatedly. Several 
booklets are printed on the same sheet and each record is printed 
on the sheet once.

Single Page VI Job, 3x2
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For a booklet with several pages, the pages are printed in order along 
the length of the sheet. The next booklet is printed beside the first. 
After the sheets are cut, the booklets are aligned with their pages in the 
proper order.

3 Page VI Job, 3x1, duplex, 3 pages per record

Gallop

The CSX2000 Color Server Gallop job parameter, located in the Print 
Settings tab, performs concurrent RIPping and printing of VI jobs. 
This reduces processing time.

! Select Gallop in the Print Settings tab in the Job Parameters 
window. This causes the printer to start printing your job after an 
initial number of pages were processed.

The above example uses the Step and Repeat method. There are no special 
considerations for VI jobs using Saddle Stitch and Perfect Bound methods.

" For further details, refer to Imposition Tab on page 90.
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Deleting Completed Jobs

On high-volume VI jobs, where disk space may be an issue, you can 
set the CSX2000 Color Server to continuously delete pages once they 
have been successfully printed.

! Select the Delete after Complete check box in the Services tab in 
the Job Parameters window to cause the continuous deletion of 
pages once they have been successfully printed.
Notes:
1. This sustains enough free disk space for the duration of the print run and 
affects the sub-job only. Moreover, it disposes of inline elements only and not re-
usable elements.
2. The Variable Print Specification file is also be deleted.
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Imposition Workflow
Imposition is the process of positioning page images on sheets of paper 
in the printer (or in a digital printing press) as part of the process of 
producing finished documents.

In addition to page images, various marks can be added to the sheets in 
order to aid the production process (marks that show where the paper 
should be folded or trimmed).

Imposition does not affect the content of the individual page but rather 
the placement of the pages on a press sheet. Imposition is a 
combination of content and layout. The content is the pages that should 
be printed and the layout is the location of the page on the sheet and the 
printing marks (crop marks and fold marks).

On the CSX2000 Color Server, the imposition parameters are set on 
the Imposition tab of the Job Parameters window.

Whenever possible, imposition settings should be defined before 
RIPping a job. Changing key imposition settings (for example 
template) post RIP may require inefficient re-RIPping of your job.

You can use a CSX2000 Color Server virtual printer to predefine your 
imposition settings. When you create a new virtual printer or edit an 
existing one, define the imposition settings for that particular printer. 
These settings become the printer's default options and are applied to 
all jobs that use the printer. 

The Imposition Workflow
To submit jobs for Imposition on the CSX2000 Color Server:

1. Download or spool the job from the client workstation to the 
CSX2000 Color Server. Or import the job from within the 
CSX2000 Color Server workspace. 

" For further details, refer to Imposition Tab Job Parameters on page 153.

" For more on Virtual Printers, refer t Network CSX2000 Color Server Virtual 
Printers on page 17.
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2. Access the Job Parameters window:

Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

Or:

Select a job in the Storage Folder, right-click and select Job 
Parameters. . . 

3. Select the Imposition tab in the Job Parameters window.

4. Adjust the required imposition parameters.

5. Click Submit to send your job to print.
The job is processed on the CSX2000 Color Server and sent to the 
Xerox DocuColor 2060 / 2045 for printing. 
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Imposition Tab Job Parameters

Select the Imposition tab to set job options related to positioning, 
folding, trimming and binding of pages:

apr

Whenever possible, imposition settings should be defined before 
RIPping a job. Changing key imposition settings (for example, 
template settings) post RIP may require inefficient re-RIPping of jobs. 
The CSX2000 Color Server only re-RIPs an imposition job when 
required.

You can use a CSX2000 Color Server virtual printer to predefine your 
imposition settings. When you create a new virtual printer or edit an 
existing one, define the imposition settings for that particular printer. 
These settings become the printer's default options and are applied to 
all jobs that use the printer. 

If you change key job parameters and click OK in the Job Parameters 
window, the job automatically reverts to its pre-RIPped format (for 
example, PDF, PostScript) and remains in the Storage Folder. 
To print or reprint the file, submit it to the Process queue.

Job page size settings are overridden by the virtual printer settings for sheet size 
and trim size.

" For further details, refer to Imposition Tab on page 90.
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Imposition Tab Thumbnail Viewer 

At the lower right hand corner of the Imposition tab, a dynamic 
thumbnail view shows the effect of your parameter choices on the 
printed sheet. The thumbnail viewer appears when you select the 
Template job parameter.

When setting the Template parameter, the thumbnail view continuously 
updates your selections for trim size, margins and sheet size.

The template option and the thumbnail view are not active if you select None as 
your imposition method.
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Example templates, as shown in the thumbnail viewer:

In the thumbnail view, the page orientation is indicated by the direction 
of the arrows (which point to the head of the page) and not by the 
orientation of the numbers.

In the thumbnail view, conflicting parameter settings are indicated by 
red corners on the pages on the template.

2x2 HTT Template (Perfect Bound) 2x1 Template (Perfect Bound)
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If the trim size settings (for example, A3 trim for Step & Repeat 2x2 
Duplex template) conflicts with the template settings, the paper size is 
indicated by a dotted line.

Method

This parameter specifies the finishing of printed sheets. It offers two 
types of binding (in other words Saddle Stitch and Perfect Bound) and 
one method that collects pages together on one sheet without binding 
(in other words Step & Repeat).

Step & Repeat

Step & Repeat is a method used for printing multiple copies of the 
same image so it fills up a larger sheet (for example, for business 
cards).

Step & Repeat Thumbnail View

Cut & Stack

A job�s pages or booklets are sorted in a Z shape. In other words, each 
stack of pages is sorted in consecutive order and when stacks are piled 
one on top of another, the entire job is already sorted up or down. 

Cut & Stack Thumbnail View

If you see red corners and a dotted line, adjust your imposition settings to 
resolve the parameter conflicts.
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Saddle Stitch

Saddle Stitch is a book-finishing technique where the pages of books 
are attached through stitching or stapling in the spine fold (for 
example, for brochures).

Saddle Stitch Thumbnail View

Perfect Bound

Perfect Bound is a book-finishing technique where the pages of books 
are attached through trimming of the spine fold, roughening the edges 
of the gathered pages and gluing them together (for example, for 
hardcover books).

Perfect Bound Thumbnail View

Changing Imposition Method

If you select to change imposition methods when setting imposition job 
parameters, the following warning window appears:

! Click Yes to continue. Or click No to return to your initial settings.
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Sizes

When using Imposition jobs, Size overrides the Paper Size job 
parameter in the Paper Stock tab. This override lets you define the 
sheet size for the job and avoid inappropriate settings that may be 
embedded in the job.
Sizes lets you define a virtual printer for imposition. For example, you 
can set a virtual printer with 2X1 Duplex Rotated, Step & Repeat 
template so that any letter size job submitted through that virtual 
printer automatically prints 2UP on tabloid size paper.

! Select the default sheet size.

Or:

! Select from the drop-down list of available sheet sizes.

Or:

! Select Custom to define a custom sheet size. Set the height and 
width of the sheet.

Changing Paper Size

If you select to change paper size when setting imposition job 
parameters, the following warning window may appear:

! Click Yes to continue. 

Or:

Click No to return to your initial settings.



Imposition Workflow 159

Trim Size

Trim size is the size of the finished, trimmed document. 

You can adjust your page size by adjusting the trim size. If your trim 
size setting is smaller than the size of the printed data, then your data is 
cropped.

! Select the required size for the finished document from the drop-
down list.

Or:

! Define a custom trim size by entering the required height and 
width of the finished page.

The default trim size is the initial paper size of the job, set in the Paper Stock 
tab. If you set trim size to be smaller than the page size set in the DTP 
application, some of the data is cropped. Setting a larger trim size results 
in a larger border on the printed page.
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Bleed Size

Bleed extends part of the printed page image beyond the trimming 
boundary. This avoids white edges after cutting and folding pages with 
elements adjacent to the edge of the page.

! Select To Fold to extend the bleed to the sheet fold lines.

Or:

Select Custom and specify the bleed size.

Applying Bleed Size results in the bleed effect only when a file contains bleed 
applied in the originating DTP application. 
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Template

A template is a set of parameters that determines how your finished 
sheet is printed. The template includes:

• The number of columns and rows of pages on a sheet.

• Each pair�s first number refers to columns and the second number 
refers to rows. 

• Whether the sheet is printed on one side (Simplex) or on both sides 
(Duplex).

• The orientation (portrait or landscape) of the page. 

CSX2000 Color Server Predefined Imposition Templates

The CSX2000 Color Server is predefined with the following 
imposition templates:

DUP refers to Duplex and SIM refers to Simplex.

Step & Repeat Saddle Stitch Perfect Bound Cut & Stack

1x1 DUP 1x2 HTT 1x2 HTT 1x1 DUP

1x1 DUP Rotated 1x2 HTT Rotated 1x2 HTT Rotated 1x1 DUP Rotated

1x1 SIM 2x1 2x1 1x1 SIM

1x1 SIM Rotated 2x1 Rotated 2x1 Rotated 1x1 SIM Rotated

1x2 DUP 2x2 2x2 1x2 DUP

1x2 DUP Rotated 2x2 HTT 2x2 HTT 1x2 DUP Rotated

1x2 SIM 2x2 Rotated 2x2 Rotated 1x2 SIM

1x2 SIM Rotated 2x2 HTT Rotated 2x2 HTT Rotated 1x2 SIM Rotated

2x1 DUP 4x2 4x2 2x1 DUP

2x1 DUP Rotated 4x2 Rotated 4x2 Rotated 2x1 DUP Rotated

2x1 SIM 2x1 SIM
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2x1 SIM Rotated 2x1 SIM Rotated

3x1 DUP 3x1 DUP

3x1 DUP Rotated 3x1 DUP Rotated

3x1 SIM 3x1 SIM

3x1 SIM Rotated 3x1 SIM Rotated

3x2 DUP 3x2 DUP

3x2 DUP Rotated 3x2 DUP Rotated

3x2 SIM 3x2 SIM

3x2 SIM Rotated 3x2 SIM Rotated

3x4 DUP 3x4 DUP

3x4 DUP Rotated 3x4 DUP Rotated

3x4 SIM 3x4 SIM

3x4 SIM Rotated 3x4 SIM Rotated

3x8 DUP 3x8 DUP

3x8 DUP Rotated 3x8 DUP Rotated

3x8 SIM 3x8 SIM

3x8 SIM Rotated 3x8 SIM Rotated

4x2 DUP 4x2 DUP

4x2 DUP Rotated 4x2 DUP Rotated

4x2 SIM 4x2 SIM

4x2 SIM Rotated 4x2 SIM Rotated

4x3 DUP 4x3 DUP

4x3 DUP Rotated 4x3 DUP Rotated

Step & Repeat Saddle Stitch Perfect Bound Cut & Stack
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4x3 SIM 4x3 SIM

4x3 SIM Rotated 4x3 SIM Rotated

4x4 DUP 4x4 DUP

4x4 DUP Rotated 4x4 DUP Rotated

4x4 SIM 4x4 SIM

4x4 SIM Rotated 4x4 SIM Rotated

5x5 DUP 5x5 DUP

5x5 DUP Rotated 5x5 DUP Rotated

5x5 SIM 5x5 SIM

5x5 SIM Rotated 5x5 SIM Rotated

8x3 DUP 8x3 DUP

8x3 DUP Rotated 8x3 DUP Rotated

8x3 SIM 8x3 SIM

8x3 SIM Rotated 8x3 SIM Rotated

P1-P2 SIM

P1-P3 DUP

P1-P2 SIM Rotated

P1-P3 DUP Rotated

P1-P2-P3 SIM

P1-P2-P3 SIM Rotated

P1-P3-P5 DUP

P1-P3-P5 DUP Rotated

Step & Repeat Saddle Stitch Perfect Bound Cut & Stack
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Collating Templates

The Step & Repeat method contains a subset of templates called 
Collating Templates. Collating Templates are used when jobs with 
different page images are used to fill up a larger sheet. Unlike regular 
Step&Repeat, where the same images are printed several times on a 
sheet, with Collating Templates, several images are printed on the 
same sheet. Collated Templates are used for one-time job print runs 
and are of the form P1-P2-P3, indicating the job pages to be printed on 
a sheet.
When choosing a template, you should account for other job 
parameters (for example paper trim size, bleed, margins and gutters 
and paper size). Since some of these parameter settings may contradict, 
the Template thumbnail lets you visually check your job as it highlights 
such conflicts (in red).

Templates are also linked to the chosen imposition method. If you 
change your imposition method (for example from Perfect Bound to 
Step & Repeat), your initially selected template may no longer fit the 
new method. When required, the CSX2000 Color Server automatically 
substitutes a suitable template for your new method and notifies you 
that the change has been made.

The default orientation is Head to Head, Portrait. If a template contains a 
different page orientation such as Head to Toe (HTT), it is included clearly in the 
name of the template (for example 2x1 DUP HTT).
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Commonly used templates, as shown in the thumbnail viewer:

2x1 SIM Rotated (Step & Repeat) 2x1 DUP Rotated (Perfect Bound)

It is advisable to review your Template thumbnail after setting your imposition 
parameters to check for conflicts and to resolve them by adjusting parameter 
settings.
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Marks

Marks are additional images printed on the sheet that help in the 
finishing process by noting where trimming and folding should occur. 
They also help with color control.

Select one, several, or none of the following options:

! Check Add Crop Marks so that lines indicating where the sheet is 
to be cropped are printed on the sheet.

Or:

! Check Add Fold Marks so that lines indicating where the sheet is 
to be folded are printed on the sheet.

Notes: 
1. If your job already includes crop marks incorporated in the DTP application, 
you do not need to add crop marks here. If you do add crop marks, both sets 
of crop marks can be printed.
2. If you want to use crop marks incorporated in the DTP application, ensure 
that enough space is left around your page in the PS file so that the page 
prints with crop marks. 
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Margins

This job parameter lets you adjust the space between pages (and pairs 
of pages) so they fit your finishing requirements.

Spine Trim Size

Spine trim size is the space between adjacent pages on a printed sheet, 
which, when folded into a booklet, allows for grinding and perfect 
binding. 

! Set the Spine Trim Size.

Margin settings should suit finishing equipment and requirements. When 
planning your sheet, it is advised that you confirm binding parameters with your 
binder.

Spine trim size is used with the Perfect Bound method only. If the Saddle 
Stitch method is used, this value is set to zero and the pages are printed 
side by side without any space between them.
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Minimum Gutter Size

The gutter is the inside space between pairs of pages on a sheet. When 
folded into a booklet, the gutter allows space for trimming.

Minimum Margin Size

Margin size is the distance between the outside edges of the sheet and 
the edges of the pages printed on the sheet. 

! You can set the minimum margin size, but not the exact size, which 
is calculated by the CSX2000 Color Server in accordance with 
other imposition parameters. 

Creep

When inserting signatures inside one another when binding saddle-
stitched jobs, the signatures inserted last (in other words towards the 
center of the job) are the furthest away from the center of the 
publication. When the publication is trimmed down to its final size, the 
inward page sections drift outward (or are even clipped).

Creep compensates for this problem by moving the pages on inside 
signatures progressively closer to the fold (in other words the position 
of the final PostScript trimmed pages remains at a constant distance 
from the outside edge of the book, when in fact the margins closest to 
the spine are continually changing).

Two parameters are used to compensate for creep. Select one, both, or 
none of the creep options:

Total Creep In

Specifies the amount of movement towards the spine applied to the 
center two pages and their backs (in other words the pages that require 
the most amount of compensation). 

For specific sheet templates, there can be only one gutter, or no gutter at all 
(for example, in the 2x1 template, there is no gutter). In these cases, the 
Minimum Gutter Size setting is ignored.
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An ever-decreasing amount of movement is automatically applied 
from the center quartet of pages back towards the outside four pages of 
the job (in other words every quartet of pages is moved by an amount 
less than the previous quartet). If required, the CSX2000 Color Server 
can also set Total Creep In automatically based on paper stock weight.

Initial Creep Out

You might find that page images get too close to the spine. This can be 
resolved by specifying a value for Initial Creep Out that moves all the 
pages of the job further out toward the outside margin (in other words 
away from the spine) by the specified amount. 

Editing with Imposition Jobs

The RTP Job Editor window lets you move pages within a job, delete 
pages of a job, insert pages of another job, or merge two entire jobs. 
You can use the RTP Job Editor with imposition jobs just as you would 
with any other RTP job.

When inserting or replacing pages, the new page should have the same 
size and orientation attributes as the old page.

To replace a page that is rotated 180°, rotate the page in the DTP 
application and re-submit it to the CSX2000 Color Server. PDL files 
can be rotated using Adobe Acrobat. 

The outside two pages and their backs are not moved (the value 0.0 is used).

Notes: 
1. This movement takes place before the Total Creep In value is applied.
2. Normally, the movement applied by the creep parameters is horizontal 
(to or from the spine).

Pre-Rip, jobs are edited using Adobe Acrobat. Post-Rip, only RTP jobs can be 
edited. Any changes to a job in the RTP job editor that require re-RIPping 
causes the job to fail, as there is no original PDL file to be re-RIPped.
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Or submit a two-page job with the corrected page as the second page in 
the job. In the Print Settings tab, set Print Method to be Duplex 
Head to Toe. After processing, the second page is rotated 180° and can 
be used as the replacing page in the Job Editor.

Once the job is completed, an RTP job is placed in the Storage Folder. 
This job is identified by the Variable Print Specification sub-job name. 
Booklet and page descriptions, as well as inline elements, are 
embedded in the RTP job. All sub-job handling is done via this RTP 
job (for example adjusting Job Parameters).

" For further details, refer to Editing RTP Jobs on page 317.

Notes:
1. If an element is to be used more than once but with different clipping or 
scaling parameters, it is treated as a new page element and processed again.
2. The cache is kept intact until the completion of a job, allowing for reuse of 
RIPped elements anywhere in the job. Elements may remain the in cache for 
subsequent jobs. you can also archive job elements.
3. Deleting a job does not delete the cached job sub-folder. This must be done 
manually via the Resource Manager. 
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User Defined Imposition Templates

The User Defined Imposition Template utility lets you import and
manage user defined imposition templates (created in a stand-alone
application) in the CSX2000 Color Server.

To import a user defined imposition template:

1. Access the Template Manager dialog box via Admin > Resource 
Manager > User Defined Imposition Templates.

The Template Manager dialog box appears.

2. Click the Created Template button (the first button on the far 
left).
The Import Template dialog box appears.
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3. Browse to the location of the desired user defined imposition 
template.

4. Select the desired user defined imposition template.

5. Select the lock job ticket check box for no modifications to the 
selected template in the Job Parameters window. 

6. Click the Import button. The selected template is listed in the 
Template Manager dialog box and can be selected as a template in 
the Job Parameters window.

7. Repeat the above procedure to add additional user defined 
imposition templates.

To rename a user defined imposition template:

1. In the Template Manager dialog box, select a user defined 
imposition template from the list and click the Rename button 
(middle button on the left).

Or:

Right-click the user defined imposition template to rename and 
from the menu select Rename.
The user defined imposition template name becomes active.

2. Type a new name for the user defined imposition template.

3. Click anywhere outside the name box of the user defined template. 
The user defined imposition template with the new name is listed
in the user defined imposition template list.
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To delete an existing user defined imposition template:

! In the Template Manager dialog box, select a user defined 
imposition template from the list and click the Delete button.

Or:

! Right-click the user defined imposition template to delete and from 
the menu select Delete.
The selected user defined imposition template is deleted.



174 Chapter 4  Advanced Printing

Color Workflow
Color job parameters can be accessed through the Color tab of the Job 
Parameters window. The Color tab provides you with tone 
compression tools such as brightness, contrast and gradation, as well as 
color tools, including rendering intent, ink saving, and CMYK 
Workflow. In addition, you can select various screening methods for 
your job.

CSX2000 Color Server Color Tab

The tone compression tools and screening methods can be applied to 
your RTP jobs without requiring the CSX2000 Color Server to re-RIP 
the jobs. The color tools, however, should be applied prior to initial 
RIPping or your job will need to be re-RIPped.

CSX2000 Color Server Color Formats

The CSX2000 Color Server can accept the following color formats:

• RGB

• CMYK

• L a* b*

• Spot Color

• Greyscale

• Duotone
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The Color Workflow

To submit jobs for color adjustment on the CSX2000 Color Server:

1. Download or spool your job from your client workstation to the 
CSX2000 Color Server. Or import the job from the CSX2000 
Color Server workspace.

2. Double-click on the job in the CSX2000 Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. Adjust your required color parameters.

5. Click Submit to send your job to print. The job is processed on the 
CSX2000 Color Server and sent to the Xerox DocuColor 2060 / 
2045 for printing.

Color Job Parameters

Brightness

With Brightness you control how light or dark your image will appear. 

Brightness is generally used to make last-minute adjustments to the 
print job after proofing. 

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.

Lighter Normal Darker
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! Select Normal to apply no brightness.

Or:

! Move the slider to select your required brightness level for the 
print job. 

Contrast

Contrast is the ratio between the light tones and the dark tones in an 
image. If you increase the contrast, highlights become lighter while 
shadows become darker. 

Contrast is generally used to make last-minute adjustments to the print 
job after proofing.

! Select Normal to apply no contrast. 

Or:

! Move the slider to select the contrast level for the print job. 

Rendering Intent

All printers, monitors and scanners have a gamut or range of colors 
that they can output (or view in the case of a scanner). If a color needs 
to be output and is outside the gamut of the output device, it must be 
mapped or approximated to some other color, which exists within the 
gamut.

The range starts from Light, which applies -15%, to Dark, which applies +15%. 

Less Normal More

The range starts from Less - which applies -10%, to More - which 
applies +10%.
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Rendering Intent allows compressing out-of-gamut colors into the 
color capability of the press you are using. 

Ink Saving (GCR)

Ink Saving GCR (Gray Component Replacement) replaces grays (of a 
certain percentage of C, M and Y) with Black, which affects the gray 
component of all colors.

This replacement conserves ink or toner and prevents the consequences 
of excessive toner buildup, such as flaking and cracking, or the curling 
effect that may occur when printing transparencies.

While the gray component of each color is replaced by black, there is 
no change in the color quality of the printed image.

! Select No (360%) in order not to use Gray Component 
Replacement and to use maximum toner coverage. You can not use 
GCR if you select original CMYK Workflow.

Or:

! Select Low (300%), Medium (260%), or High (220%) to set the 
amount of CMY toners to be replaced by the black toner.

" For information about the four Rendering Indent styles, refer to Rendering Intent 
on page 79.

No GCR Low GCR Medium GCR High GCR

Notes: 
1. Use High to provide low ink coverage while saving on toner (this prevents the 
occasional peeling of ink and the curling effect that may occur when 
printing transparencies).
2. The percentage figure to the right of each GCR level indicates the percentage 
of ink coverage, which is calculated by adding the percentages for C,M,Y and K. 
The theoretical maximum is 400%, but this is not achievable in practice.
3. Ink Saving (any combination of GCR) has no dependencies.
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CMYK Workflow

CMYK Workflow is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations 
of paper and ink, as well as popular proofing systems. It is also used to 
emulate other printing devices such as offset presses, or other digital 
printers.

! Select None (default) to keep CMYK files as is.

Or:

! Select SWOP or Fogra from the drop-down list. 

CMYK Emulation

CMYK Emulation utility lets you create new CMYK emulations based 
on ICC profiles of various output devices and adding them to the 
CSX2000 Color Server pre-installed CMYK emulations. In addition, 
you can rename or delete existing emulations. 

The CSX2000 Color Server supports LAB color profiles. The ICC (International 
Color Consortium) profiles imported to the system for CMYK Workflow should be 
based on CIE LAB values.
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To add a CMYK emulation:

1. Access the CMYK Emulation dialog box via Admin > Resource 
Manager > CMYK Emulation. 

The CMYK Emulation dialog box appears.

.

2. Click the Add Color Emulation button (the first button on the 
left). The Add CMYK Emulation window appears.
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3. Click the Browse button to locate the ICC profile of the device you 
want to emulate.

4. Once a profile is selected, confirm or modify the emulation name 
and click the Create Emulation button. A new CMYK emulation 
transformation is created (based on the selected ICC profile) and 
listed in the CMYK emulation list in the Job Parameters window.

To rename an existing CMYK emulation:

1. In the CMYK Emulation window, select a CMYK emulation from 
the list and click the Rename Emulation button.

2. Type a new name for the emulation and click OK. The emulation 
with the new name appears is listed in the CMYK emulation list.

To delete an existing CMYK emulation:

! In the CMYK Emulation window, select a CMYK emulation from 
the list and click the Delete Color Emulation button. The 
emulation disappears from the CMYK emulation list.
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Screening Method

The CSX2000 Color Server supports Dot and Stochastic screening. 
Screening is achieved by printing dots or lines in an evenly-spaced 
pattern. The distance between screen dots is fixed and the dot size 
varies according to the required strength of color. 

Using screens, printers can work with even amounts of toner and still 
produce a wide range of colors. The darker the color, the larger the dot. 
In this manner screens are used to give the appearance of different 
toner quantities printed in a certain area.

The CSX2000 Color Server supports six types of screening: 

Automatic applies two types of screens: 
For CT, the system uses Dot type screen of 200 lpi. 
For text / line-art elements, the system uses Dot type screen of 200 lpi 
for all colors below a system-preset threshold. It uses Line type screen 
of 600 lpi for colors that are equal to or higher than the system-preset 
threshold. 
Automatic screening results in the printing of text and graphic shapes 
at Continuous Tone. Automatic screening is the recommended 
screening mode.

Dot 150 applies Dot type screen of 150 lpi. The screen of each 
separation is printed at a different angle.

Dot 200 applies Dot type screen of 200 lpi. The screen of each 
separation is printed at a different angle.

Line 200 applies Dot type screen of 200 lpi. The screen of each 
separation is printed at a different angle.

Line 300 applies Dot type screen of 300 lpi. All separations is printed 
at 90 degrees screen angle.

Line 600 applies Dot type screen of 600 lpi. All separations is printed 
at 90 degrees screen angle.
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Gradation Tool

It is sometimes necessary to perform tone corrections when printing a 
job. These changes in gradation can include brightness, contrast and 
color balance adjustments throughout the tone range of an entire 
image, or in specific tone ranges. 

The gradation tables you create on the CSX2000 Color Server are 
added to the Gradations job parameter in the Color Tab and may be 
applied to print jobs. The CSX2000 Color Server also lets you visually 
check the effect of your gradation tables on RTP jobs prior to printing.

With CSX2000 Color Server Gradation, you can apply the default 
gradation table or another pre-configured gradation table to a job. You 
can also edit an existing table and save your changes. Gradation is an 
interactive function and changes are automatically applied to the 
displayed image.

! Select None so that Gradations is not applied.

Or:

! Select a gradation table from the Gradations options drop-down 
list.

The Gradation Window

The Gradation window is used to create and edit gradation tables and 
to check the effect of your gradation tables on specific RTP jobs. These 
tables can then be applied during job processing to apply tailored 
gradations to your jobs.

You can edit an existing gradation table, but you can not overwrite the default 
gradation table, DefaultGradTable.
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To open the Gradation window:

! From the Tools menu, select Gradation. . .

The Gradation window appears.

Preview Button

The Preview Button appears the Gradation Preview window. This 
window lets you view the effect of your Gradation table changes on a 
page from a specific RTP job.

Notes:
1. Gradation is an interactive function. Gradation table changes are 
automatically applied to the displayed image.
2. The gradation table created is not automatically applied to the previewed job. 
You must use job parameters to assign a gradation table to a job.
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To view the effects of gradation table changes on a page from an RTP job:

1. Click Preview to open the Gradation window: 

2. Click Browse to select a job to display in the preview window. 
The RTP Jobs window appears.

Jobs displayed are the RTP jobs listed in the Storage Folder.
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3. Click on the RTP job to which you wish to modify. 
Click OK. 
The job appears in the Gradations window.

4. In the Gradation window, adjust your gradation table settings as 
required. 

5. Click the Show Original button (located at the bottom of the 
Gradation window) to toggle back and forth between edited and 
unedited gradation table views. 

Notes:
1. The job name is listed at the top of the Preview viewer.
2. Click Browse at any time to select a different RTP job on which to view the 
effects of gradation table changes
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6. To view the effects of your gradation table changes on a different 
page of the RTP job, select the page and booklet you wish to view 
from the drop-down lists at the top of the Preview window:

The selected page appears.

Gradation Table Box

Upon opening the Gradation window, the default gradation table 
DefaultGradTable is selected:

This table consists of a 45°-gradation curve, with Brightness and 
Contrast set to 0, Contrast Center set to 50 and all color separations 
selected. 
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If you have previously created or edited gradation tables: 

! Select the required gradation table from the drop-down list.
For viewing and editing purposes, the preconfigured settings of the 
selected gradation table are immediately applied to the RTP job on 
which you are working.

Separation Box

The Separation box is used to select the separations to be edited for a 
particular gradation table. You can select one, all, or any combination 
of separations. Selecting a specific separation and a specific gradation 
control lets you change the color balance for a specific tonal range.

The Gradations window appears with all separations selected: 

This tools allows simultaneous editing of all separations.

To edit only one, or several separations:

1. Click  to clear all separations.

2. Click the individual separations you wish to edit (for example, 
select the cyan separation only):

3. Change the separation parameters using the Gradation controls.

Your changes to gradation tables are immediately presented as 
changes to the gradation graph.

" For further details, refer to Preview Button on page 183.

" For further details, refer to Gradation Controls on page 188.
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Gradation Controls

The gradation controls are used to adjust brightness in specific tone 
ranges. 

The gradation controls are:

• Start
Moves the point of origin of the gradation graph at the highlight 
end along the horizontal or vertical axis. This affects the image file 
from 0% dot to 100% dot, where the greatest change is at 0% dot.

Start Point Low Start Point High
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• Highlight
Changes brightness mainly in the highlights. This affects the image 
file from 0% dot to 50% dot, where the greatest change is at 25% 
dot.

• Mid
Changes brightness mainly in the midtones. This affects the image 
file from 15% dot to 85% dot, where the greatest change is at 50% 
dot.

Highlight Low Highlight High

Mid Low Mid High
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• Shadow
Changes brightness mainly in the shadows. This affects the image 
file from 50% dot to 100% dot, where the greatest change is at 
75% dot.

• End
Moves the endpoint of the gradation graph at the shadow end along 
the horizontal or vertical axis. This affects the image file from 0% 
dot to 100% dot, where the greatest change is at 100% dot.

Shadow Low Shadow High

End Point Low End Point High
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Click the arrow buttons to increase or decrease the graph value of the 
active separation(s) for a specified section of the graph. 

If only one separation is active, the gradation values are listed, ranging 
from -50 to 50. If more than one separation is active, no gradation 
values are listed.

Changes to gradation tables are immediately presented as changes to 
the gradation graph.

Gradation Graph

CSX2000 Color Server gradation tables are represented visually in the 
Gradation window in the form of a graph: 

The horizontal axis represents the tone values of the image before 
gradation changes (input). The vertical axis represents the tone values 
of the image after gradation changes (output). All four separations 
(CMYK) are shown, but if they have identical curves, the graphs 
appear as if there is only one curve.

DefaultGradTable (input equals output) Modified gradation graph
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Brightness and Contrast Slider Controls

The Brightness and Contrast slider controls are active only when all of 
the separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. 
Increasing Brightness brightens the image and results in a concave 
curve. Decreasing Brightness darkens the image and results in a 
convex curve. 

! Move the Brightness slider to the right to increase brightness or to 
the left to decrease brightness.

Or:

! Click the arrow button to select a value from the drop-down list.

Contrast

Contrast increases the image contrast by making the highlights lighter 
and the shadows darker. It can also be used to decreases the contrast.

! Move the Contrast slider to the right to increase contrast (S shaped 
curve), or to the left to decrease contrast (inverted S shaped curve).

Or:

! Click the arrow button to select a value from the drop-down list.

Contrast Center

Contrast increases the image contrast mainly in the midtones. Using 
Contrast Center, you can adjust where the contrast is increased. To 
enhance contrast in highlights, the Contrast Center is shifted toward 
the highlights. To enhance contrast in shadows, the Contrast Center is 
shifted toward the shadows.
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! Set the image contrast, by adjusting the Contrast slider.

Or:

Set the Contrast Center slider to the right to enhance contrast in 
highlights, or to the left to enhance contrast in shadows.

Or:

Click the arrow button to increase or decrease the Contrast Center 
value. The Contrast Center value appears to right of the Contrast 
Center slider. Your change affects the gradation graph by moving 
the point where the curve changes from convex to concave.

Organizing Gradation Tables

The Gradation window provides a number of options for organizing 
gradation tables, including Reset, Save, Delete and Save As.

Contrast Center only affects the image if Contrast has also been adjusted.
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If you work only with the default gradation table, the Reset and Save 
As options are activated. This option lets you use the default gradation 
table as a base on which to build and save new gradation tables. When 
you work on gradation tables other than the default table, Save and 
Delete also become active.

A gradation table other than DefaultGradTable.
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The gradation organization options are:

! Click Reset to reset all Gradation window settings. The gradation 
curve is reset to a 45° line. 

! Click Delete to delete the selected gradation table. 

! Click Save to save the specified gradation settings.

! Click Save As to create new gradation tables by saving existing 
gradation tables with new names.

To create a new gradation table:

1. In the Gradations window, modify your gradation table as 
required.

2. Click Save As. The Save As window appears:

3. In the File name: box, type the required name for the new 
gradation table. 

4. Click OK. The gradation table is saved with the entered name. Or 
click Cancel to return to the Gradations window without saving 
the gradation table.
The saved gradation table is added to the Gradation window Table 
name drop-down list and to the Job Parameters Gradations drop-
down list.

Exiting the Gradations Window

To exit the Gradations window:

! Close the Gradation window and return to the CSX2000 Color 
Server workspace.

You can not delete the DefaultGrad table.

You can only save the default gradation table under a new name.

" For further information, refer to Gradations on page 85.
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Calibration

The purpose of color calibration is to achieve a consistent level of color 
quality on a daily basis and to ensure that the quality achieved is 
maintained for each Xerox DocuColor 2060 / 2045 printer in use. The 
calibration process involves printing a CMYK chart, measuring the 
density of the CMYK strips, and calibrating them to a required target.

Your Xerox DocuColor 2060 / 2045 printer is color calibrated during 
installation. Simultaneously, it is calibrated with the CSX2000 Color 
Server. Subsequently, you can calibrate whenever you are not satisfied 
with the print quality.

The calibration process corrects printer colors by measuring a chart 
using one of the following Densitometers, which measure color 
density:

• The X-Rite DTP32 Densitometer (refer to Connecting the X-Rite 
DTP32 Densitometer to the CSX2000 Color Server on page 197 
and Using the Printer Calibration Wizard with the X-Rite DTP32 
on page 203). 

• The X-Rite DTP34 QuickCal Densitometer (refer to Connecting, 
Configuring and Calibrating the X-Rite DTP34 QuickCal 
Densitometer on page 199 and Using the Printer Calibration 
Wizard with the X-Rite DTP34 on page 216). 

Connecting, Configuring and Calibrating the X-Rite DTP32 Densitometer

The X-Rite DTP32 Densitometer measures color density. Before using 
the X-Rite DTP32 Densitometer for the first time, perform the 
following:

Notes:
1. Calibration can be adjusted while printing is in progress.
2. Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).
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Familiarize yourself with the X-Rite DTP32 Operations Manual 
contents:

• Connect the X-Rite DTP32

• Configure the X-Rite DTP32

• Calibrate the X-Rite DTP32

Connecting the X-Rite DTP32 Densitometer to the CSX2000 Color Server

1. Plug the square end of the interface cable into the I / O port on the 
side of the densitometer.

2. Attach the 9-pin connector, at the other end of the interface cable, 
to the COM1 port on the back of the CSX2000 Color Server.
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3. Use the AC adapter (available from X-Rite) to connect to the 
power supply. Plug the small connector on the adapter cable in to 
the side of the X-Rite DTP32 Densitometer and plug the adapter 
into a power outlet.

Configuring the X-Rite DTP32 Densitometer

The X-Rite DTP32 Densitometer should be configured automatically 
after its connection to the CSX2000 Color Server. Configuration is 
performed across five screens, numbered p1 to p5. If you have any 
problems or errors while connecting to the densitometer, exit the 
application and type the following configuration settings on the X-Rite 
DTP32 Densitometer. 

1. On the X-Rite, click the two buttons marked Menu at the same 
time. The words �MAIN MENU� appear in the display.

2. Press the p# key until p3 appears (the p# key is the left-most key).

3. Press the cnfg key.

4. Configure the X-Rite DTP32 (refer to X-RiteColor DTP32 for 
QUICKAL Densitometer: Getting Started).
Once you set the above parameters, the X-Rite DTP32 is 
automatically configured.

5. Press the two left keys of the X-Rite DTP32 at the same time to 
save the settings you configured. The message �Configuration 
Settings Saved� appears.

Calibrating the X-Rite DTP32 Densitometer

1. On the X-Rite DTP32, click the two Menu buttons at the same 
time. The words MAIN MENU appear in the display.

2. Press the p# key until p2 appears.

3. Press the cal key. The word CALIBRATION appears in the 
display.

4. The words INSERT CAL STRIP should appear after a few 
minutes.
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5. Insert the strip into the X-Rite DTP32 slot until the rollers start 
pulling it inside (refer to X-RiteColor DTP32 for QUICKAL 
Densitometer: Getting Started).
The word READING flashes on the display, followed by the 
density values and the message CALIBRATION OK.
If the message UNRECOGNIZABLE STRIP appears, try to clean 
the strip (refer to X-RiteColor DTP32 for QUICKAL Densitometer: 
Getting Started).

6. Repeat step #1.

Connecting, Configuring and Calibrating the X-Rite DTP34 QuickCal 
Densitometer

The X-Rite DTP34 QuickCal Densitometer is a color measurement 
instrument that reports densitometric and dot data.

Before using the X-Rite DTP34 QuickCal Densitometer for the first 
time, perform the following:

• Familiarize yourself with the X-Rite DTP34 QuickCal 
Densitometer Operations Manual

• Connect the X-Rite DTP34 QuickCal Densitometer

• Calibrate the X-Rite DTP34 QuickCal Densitometer

 

You should calibrate the X-Rite DTP32 Densitometer once a day or as indicated 
by the densitometer.
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Connecting the X-Rite DTP34 QuickCal Densitometer to the CSX2000 Color Server

The X-Rite DTP34 QuickCal Densitometer must be interfaced directly 
with one of the computer's serial ports. 

Power is supplied to the X-Rite DTP34 QuickCal Densitometer when 
the Power Supply is plugged into the AC wall receptacle. The X-Rite 
DTP34 QuickCal Densitometer does not have an ON / OFF switch.

Configuring the X-Rite DTP34 QuickCal Densitometer

The LED indicates a variety of instrument operation conditions, such 
as calibration mode and operation. For a complete list of all conditions 
reported by the LED, refer to the X-Rite DTP34 QuickCal 
Densitometer Operations Manual.

PC
Db9

MAC
Mini-DIN 8

Power Input

Mini-Din 8 Plug

SE108-94-02
Interface Cable

SE108-DB9PA-01
(Optional)
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Calibrating the X-Rite DTP34 QuickCal Densitometer

Frequency of Calibration

Your X-Rite DTP34 QuickCal Densitometer should have a Quick 
Calibration performed weekly. A full calibration should be performed 
annually, during heavy usage to provide accurate measurements, or if 
the Quick Calibration consistently fails. Typically, the host computer 
prompts for an instrument calibration (amber LED) when required but 
the process can be invoked manually at any time. Refer to the 
following procedure for details on the calibration process.

Positioning the Instrument on the Calibration Reference

Handle the reflection reference by the edges. Make sure that the 
reflection reference is free of dust, dirt and smudgemarks. To obtain 
the most accurate calibration, hold the instrument with consistent and 
nominal pressure during the calibration process.

Position the instrument on the designated location of the reflection 
reference (indicated by a dotted outline of the instrument). Do not 
move the instrument more than 0.25" (6.35mm) before reading the 
strip.
 

STATUS  X

DTP34-100   #:

X-Rite
Reflection Reference

C=  .XX

AXXXXXXXX-XXXXX  D:  XXX

M=  .XX Y=  .XX

R
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Quick Calibration

A quick calibration can be performed at any time. The only required 
action is to scan the reflection reference as you would with any other 
strip. A quick calibration should only be performed after a full 
calibration has been done. The instrument comes from the factory with 
a full calibration already stored.

1. Position the X-Rite DTP34 QuickCal Densitometer on the 
reference   as previously mentioned.

2. Press and click the button and scan the reference to the opposite 
end. Release the button. The LED should indicate green if 
calibration was successful. If calibration fails (fast flashing amber 
LED), verify the strip is clean and re-read.

3. Place the reflection reference in its protective envelope and store 
away from light and heat.

Full Calibration

1. To manually invoke the calibration mode, click and hold the 
Instrument button for a minimum of three seconds. The LED 
slowly flashes amber when calibration is initiated.

2. Press and hold the button (if not previously held) and scan the 
reference to the opposite end. Release the button. The LED should 
indicate green if calibration was successful. If calibration fails, 
(fast flashing amber LED), verify the strip is clean and re-read.

3. Place the reflection reference in its protective envelope and store 
away from light and heat. 

If the host computer initiated calibration (amber LED), skip to step 2.
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Using the Printer Calibration Wizard with the X-Rite DTP32 

The Calibration window lets you create and edit calibration tables, 
either through an automatic process or by editing an existing 
calibration table. The system automatically identifies which device is 
connected and if the device is currently working with the X-Rite 
DTP32.

To open the Calibration window:

1. From Tools menu, select Calibration. . .

The Calibration window appears.

2. Click Calibrate to run the Printer Calibration Wizard. This Wizard 
guides you in the use of the X-Rite DTP32 to create calibration 
tables.

Or:

Select the Calibration LUT. Then select one of the below options: 

• Click Edit to edit a calibration table. Select the calibration table 
to edit from the Calibration Name drop-down list.

• Click Delete to delete a calibration table.

• Click Info for the Density Graph.

• Click Close to end a test job and close the Calibration dialog 
box. 
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To run the Printer Calibration Wizard:

1. In the Calibration window, click Calibrate. 
The Color Calibration Wizard dialog box appears at the Printing 
Start Point Chart screen.
This step, in the Color Calibration Wizard dialog box, prints the 
Start Point Density calibration chart.

2. Select the required input tray from the drop-down list.

The Wizard checks for Letter or A4 LEF paper (for more information, 
refer to Template Orientation on page 401). If a particular paper size / 
quality is required, then select the relevant tray.
Calibration charts can be printed on any paper size, including custom 
sizes. In case of small paper size (less than Letter / A4), each 
calibration chart is printed on two separate sheets. If a large size is 
selected, the calibration charts are printed close to the edge of the 
paper, allowing the operator to measure them without difficulty. When 
Auto is selected, the Wizard selects the first tray containing either letter 
or A4 paper. If the correct paper is not found, the following message 
appears:
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3. Refill the selected tray with the required paper and select the tray 
again from the drop-down list.

4. Select the required screening method from the drop-down list:

 

5. Select the required paper weight from the drop-down list:

6. Select whether to print on Coated or Uncoated paper stock.

" Refer to Screening Method: Printing a Catalog with Dot Type Screen of 200 lpi 
on page 253.
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7. Select % of max density using the slider, which defines color 
saturation. The higher the number, the more saturated the color.

8. Select the required number of copies from the drop-down list:

9. Click Print. The Xerox DocuColor 2060 / 2045 printer prints a 
Start Point Density calibration chart. Collect the chart from the 
printer.

10. Click Next. Step 2 of the Color Calibration Wizard dialog box 
appears:

When you shift the slider from the default position, your spot colors may also be 
effected. In this case, edit specific spot colors using the Spot Color Editor (Tools 
> Spot Color Editor. . .).

The Xerox DocuColor 2060 / 2045 printer achieves its best marking performance 
after printing several initial pages, particularly following cold starts. Print the first 
calibration charts in a multiple copies and to use one of the last charts printed. 
Set and print up to 25 copies of the Start Point charts to reach the best color 
performance. 

After you click Print Chart, the Next button is activated. Wait until your chart is 
printed before clicking Next.
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Measuring Start Points

1. Shift the X-Rite slider to point 15.

2. Shift the Insert Point Density Calibration Chart to the X-Rite.

3. Insert the Start Points density calibration chart into the X-Rite 
autoscan densitometer as shown in the illustration below. Begin 
with the cyan column.
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4. The chart is drawn through the X-Rite DTP32 and scanned. A beep 
sounds when the scan is complete. A check mark appears beside 
the cyan icon and instructions appear for the next insertion of the 
chart.

5. After each insertion of the chart, wait for the check mark to appear 
in the appropriate box and follow the instructions as listed.

6. When all of the separation columns have been successfully 
scanned, the icons are all checked:

7. If an error occurs during the scan, the Error window appears:

8. Click OK and re-scan the chart.

Ensure that the separation columns on the Continuous Tone chart are 
scanned in the order they appear in the icons: Cyan > Magenta > Yellow > Black.

If at any stage the scanning has not been completed properly, click Reset 
and scan again.
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9. If at any time during your scan sequence, you would like to scan 
again, click the Reset button.

10. When all four columns of the chart have been successfully 
scanned, Next becomes active. 

11. Click Next. Step 3 of the Color Calibration Wizard appears:
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Print Calibration Chart

1. Click Print Chart.

2. Collect the chart(s) from the printer.

3. Click Next>>. Step 4 of the Color Calibration Wizard appears:

If automatic screening has been selected in Step 1 of the Wizard, the Xerox 
DocuColor 2060 / 2045 prints two charts, an Image Density calibration chart and 
a Text / Line Art chart. If any other screening method has been selected, only the 
Image Density calibration chart is printed. 
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Measuring Colors

1. Insert the Image Density calibration chart into the X-Rite autoscan 
densitometer as shown in the illustration below. Begin with the 
cyan column.

If Automatic Screening was selected in Step 1 of the Wizard, then insert the Text 
/ Line Art after you are finished scanning the Image Density Calibration chart. 
Follow the same scan sequence. Begin each chart with the cyan column.
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2. The chart is drawn through the X-Rite DTP32 and scanned. A beep 
sounds when the scan is complete. A check mark appears beside 
the cyan icon and instructions appear for the next insertion of the 
chart:

3. After each insertion of the chart, wait for the check mark to appear 
in the appropriate box and follow the instructions as listed.

4. If Automatic Screening was selected in Step 1 of the Wizard, the 
second row of check boxes is selected once the Image Density 
calibration chart has been scanned.

Ensure that the separation columns on the Image Density chart are scanned in 
the order they appear in the icons: Cyan > Magenta > Yellow > Black.
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5. Insert the Text / Line Art chart for the same scan sequence.
After the LW Density black separation is scanned and the beep is heard, it can 
take several seconds until the check mark appears in the box.

If at any stage the scanning has not been completed properly, click Reset 
and scan again. 
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6. If an error occurs during the scan, the Error window appears:

7. Click OK and re-scan the calibration chart.

8. If at any time during your scan sequence, you would like to scan 
again, click Reset. 

9. When all four columns of the chart have been successfully 
scanned, Next becomes active. 

10. Click Next. Step 5 of the Color Calibration Wizard appears:

Save Calibration

After scanning the K column, it can take some time for the checkmark to appear 
next to the K icon.
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1. In the Save as: box, select the required name for the calibration 
table. Type your own or select one from the drop-down list.

Or:

2. Select As default table (Normal). The calibration table is saved as 
Normal.

3. Click Finish. The calibration table is saved. 

When you save your calibration tables, the CSX2000 Color Server 
actually saves your calibration table twice, as Normal and as 
Saturated. 

• Normal 
The table is balanced throughout the entire range.

• Saturated
The table is balanced through 80% of the tone range. From 80% 
onwards, all separations are balanced independently. Each 
separation is calibrated to the maximum density the printer can 
produce.
For example, if a calibration table is saved with the name �New�, it 
is saved both as �New� and as �NewSat�.

To save calibration tables:

1. In the Save as: box, type the required name for the calibration 
table.

2. Or select As default table. The calibration table is saved as Normal 
and Saturated.

3. Click Finish. The calibration table is saved. 

Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).

Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).
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Using the Printer Calibration Wizard with the X-Rite DTP34

The Calibration window lets you create and edit calibration tables, 
either through an automatic process or by editing an existing 
calibration table. This Wizard guides you in the use of the X-Rite 
DTP34 to create calibration tables.

To open the Calibration window:

1. From Tools menu, select Calibration. . .

The Calibration dialog box appears:

2. Click Calibrate to run the Printer Calibration Wizard. This Wizard 
guides you in the use of the X-Rite DTP34 to create calibration 
tables.

Or:

Select the Calibration LUT. Then select one of the below options: 

• Click Edit to edit a calibration table. Select the calibration table 
to edit from the Calibration Name drop-down list.

• Click Delete to delete a calibration table.

• Click Info for the Density Graph.

• Click Close to end a test job and close the Calibration dialog 
box. 
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To run the Printer Calibration Wizard:

1. In the Calibration window, click Calibrate. 

2. The Color Calibration Wizard dialog box appears at the Printing 
Start Point Chart screen. The Color Calibration Wizard appears 
with the following message: �Please calibrate the DTP-34, using 
the �X-Rite Reflection Reference� calibration strip, before clicking 
Print. Click OK to continue.
This step, in the Color Calibration Wizard dialog box, prints the 
Start Point Density calibration chart.

3. Select the required input tray from the drop-down list:

The Wizard checks for Letter or A4 LEF paper. If a particular 
paper size / quality is required, then select the relevant tray. 
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Calibration charts can be printed on any paper size, including 
custom sizes. In case of small paper size (less than Letter / A4), 
each calibration chart is printed on two separate sheets. If a large 
size is selected, the calibration charts are printed close to the edge 
of the paper, allowing the operator to measure them without 
difficulty. 
When Auto is selected, the Wizard selects the first tray containing 
either letter or A4 paper. If the correct paper is not found, the 
following message appears:

4. Refill the selected tray with the required paper and select the tray 
again from the drop-down list.

5. Select the required screening method from the drop-down list:

 

6. Select the required paper weight from the drop-down list:

 

" Refer to Screening Method: Printing a Catalog with Dot Type Screen of 200 lpi 
on page 253.
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7. Select the required number of copies from the drop-down list:

8. Select whether to print on Coated or Uncoated paper stock.

9. Click Print. The Xerox DocuColor 2060 / 2045 printer prints a 
Start Point Density calibration chart. Collect the chart from the 
printer.

10. Click Next. Step 2 of the Color Calibration Wizard appears:

The Xerox DocuColor 2060 / 2045 printer achieves its best marking performance 
after printing several initial pages, particularly following cold starts. Print the first 
calibration charts in a multiple copies and to use one of the last charts printed. 
Set and print up to 25 copies of the Start Point charts to reach the best color 
performance. 

After you click Print Chart, Next is activated. Wait until your chart is printed 
before clicking Next.
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Measuring Start Points

1. While pressing down the button on the X-Rite DTP34, align the X-
Rite DTP34�s head with the cyan arrow�s tip. The arrow is to the 
left of the cyan column on the Image Density Calibration Curve. 
Its tip intersects the semi-dotted line.

2. Press the button on the X-Rite DTP34.

3. Sweep the X-Rite DTP34 over the cyan column.



Color Workflow 221

4. A beep sounds when the scan is complete. A check mark appears 
over the cyan icon and instructions appear for the next sweep, this 
time for the magenta column. 

5. After each sweep, wait for the check mark to appear over the 
appropriate icon and follow the instructions as listed.

6. When all of the separation columns have been successfully 
scanned, the icons are all checked: 

Ensure that the separation columns on the Continuous Tone chart are 
scanned in the order they appear in the icons: Cyan > Magenta > Yellow > Black.
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7. If an error occurs during the scan, the Error window appears:

8. Click OK and re-scan the chart.

9. If at any time during your scan sequence, you would like to scan 
again, click the Reset button.

10. When all four columns of the chart have been successfully 
scanned, Next becomes active. 

11. Click Next. Step 3 of the Color Calibration Wizard appears:

If at any stage the scanning has not been completed properly, click Reset 
and scan again.



Color Workflow 223

Print Calibration Chart

1. Click Print.

2. Collect the chart(s) from the printer.

3. Click Next. Step 4 of the Color Calibration Wizard appears:

If automatic screening has been selected in Step 1 of the Wizard, the Xerox 
DocuColor 2060 / 2045 prints two charts, an Image Density calibration chart and 
a Text / Line Art chart. If any other screening method has been selected, only the 
Image Density calibration chart is printed. 
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Measuring Colors

1. Position the X-Rite DTP34 over the Image Density calibration 
chart and follow the scan sequence as prompted.

If Automatic Screening was selected in Step 1 of the Wizard, then insert the Text 
/ Line Art after you are finished scanning the Image Density Calibration chart. 
Follow the same scan sequence. Begin each chart with the cyan column.
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2. A beep sounds when the scan is complete. A check mark appears 
over the cyan icon and instructions appear for scanning of the next 
column:

3. After each scan, wait for the check mark to appear over the 
appropriate icon and follow the instructions as listed.

4. If Automatic Screening was selected in Step 1 of the Wizard, the 
second row of check boxes is selected once the Image Density 
calibration chart has been scanned. 

Ensure that the separation columns on the Image Density chart are scanned in 
the order they appear in the icons: Cyan > Magenta > Yellow > Black.
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5. Insert the Text / Line Art chart for the same scan sequence.
After the LW Density black separation is scanned and the beep is heard, it can 
take several seconds until the check mark appears in the box.

If at any stage the scanning has not been completed properly, click Reset 
and scan again. 



Color Workflow 227

6. If an error occurs during the scan, the Error window appears:

7. Click OK and re-scan the calibration chart.

8. If at any time during your scan sequence, you would like to scan 
again, click the Reset button.

9. When all four columns of the chart have been successfully 
scanned, Next becomes active. 

10. Click Next. Step 5 of the Color Calibration Wizard appears:

Save Calibration

After scanning the K column, it can take some time for the checkmark to appear 
next to the K icon.
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1. In the Save as: box, choose the required name for the calibration 
table. Type your own or select one from the drop-down list.

Or: 

2. Select As default table (Normal). The calibration table is saved as 
Normal.

3. Click Finish. The calibration table is saved. 

When you save your calibration tables, the CSX2000 Color Server 
actually saves your calibration table twice, as Normal and as 
Saturated. 

• Normal 
The table is balanced throughout the entire range.

• Saturated
The table is balanced through 80% of the tone range. From 80% 
onwards, all separations are balanced independently. Each 
separation is calibrated to the maximum density the printer can 
produce.
For example, if a calibration table is saved with the name �New�, it 
is saved both as �New� and as �NewSat�.

To save calibration tables:

1. In the Save as: box, type the required name for the calibration 
table.

2. Or select As default table. The calibration table is saved as Normal 
and Saturated.

3. Click Finish. The calibration table is saved. 

Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).

Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).
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Editing Calibration Tables

To edit a calibration table:

1. In the Calibration screen, under Calibration Name, select the table 
to edit. Then click Edit.

The Edit Calibration window appears.
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Screen

In Step 1. Printing Start Point Chart of the Color Calibration Wizard 
screen, select a screening method. Upon choosing the Automatic 
screening method, in Step 2. Measuring Start Points you receive 
information for both CT (on the left) and LW. Any other screening 
method yields only CT information.

Separation

The Separation box is used to select the separations to be edited for a 
particular calibration table. 

1. Select an individual separation to edit from the separation drop-
down list.

2. Change the separation parameters by adjusting file and printer 
values in the value table. Changes to calibration tables are 
immediately presented as changes to the calibration graph.

Value Table

The value table lists the tone values of the image. The File Value 
column lists the tone values in the image file. The Printer Value 
column lists the tone values of the image that are sent to the printer. 

The File Value and Printer Value columns provide the x and y 
coordinates from which the calibration graph is drawn.
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Editing Calibration Value Tables

To add an entry to the value table: 

1. Highlight a row in the value table that you wish to add a value 
after. 

2. Click Add Entry. The Add Entry window appears:

3. Adjust the File and Printer values as required by clicking on the 
arrow buttons.

4. Click OK. The value table is updated and the calibration graph is 
adjusted.

To change an existing value table:

1. Highlight a row in the value table that you wish to add a value 
after. 

Your changes to calibration tables are immediately presented as changes to the 
calibration graph.
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2. Double-click on the row. The Edit Entry window appears:

3. Adjust the File and Printer values as required by clicking on the 
arrow buttons.

4. Click OK. The value table is updated and the calibration graph is 
adjusted.

To delete an entry from the value table:

1. In the value table, highlight the entry to be deleted:

2. Click Delete Entry. The entry is removed. 

Your changes to calibration tables are immediately presented as changes to the 
calibration graph.

Your changes to calibration tables are immediately presented as changes to the 
calibration graph.
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Calibration Graph

CSX2000 Color Server calibration tables are represented visually in 
the Edit Calibration window in the form of a graph: 

The horizontal axis represents the tone values of the image in the 
image file. The vertical axis represents the tone values of the image 
that are sent to the printer. Upon opening the Edit Calibration window, 
all four separations (CMYK) are shown. If the four separations have 
identical curves, the calibration graph appears as if there is only one 
curve.

! To open or hide the calibration graph, click .

Viewing Separations

You can view one, all, or any combination of separations. The Edit 
Calibration window appears with all separations selected: 

It is possible to view one or more separations and adjust the values of 
other separations. The separations that you adjust are do not have to be 
those that you have chosen to view in the Edit Calibration window. 

Calibration graph showing separations
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To view only one or several separations:

1. Click  to deselect all separations. The separations are 
deselected:

2. Click the individual separations you wish to view (for example, 
select the cyan separation only):

Organizing Calibration Tables

You can use the Save and Save As functions to organize your 
calibration tables.

To save an existing calibration table:

1. In the Edit Calibration window, adjust calibration table values and 
parameters as required.

2. Click Save. The edited calibration table is saved with its original 
name.

To save a new calibration table:

1. In the Edit Calibration window, adjust calibration table values and 
parameters as required.

2. Click Save As. The Save As window appears:

3. In the File Name: box, type the new calibration table name.

When Save is clicked, new calibration settings override previous calibration 
table settings.

You can not overwrite the default calibration tables, CSXNormal and 
CSXSaturated.



Color Workflow 235

4. Click OK. The calibration table is saved with the entered name. 

5. Click Close to exit the Edit Calibration window.

Backing Up Calibration Tables

To back up a calibration table:

1. Browse to the ColorCalibrationDB folder, following the path 
C:\CSX2000\General\ColorCalibration\ColorCalibrationDB.

2. Open the ColorCalibrationDB folder.

3. Copy the required calibration table files to your backup location. 

Color Density Information
To view the Density Graph:

1. In the Calibration screen, under Calibration Name, select the table 
for which you want to receive detailed color information.

Access Calibration tables through Tools > Calibration > Edit. . . (for the Edit 
Calibration window) and Tools > Calibration > Info. . . (for the Density Graph 
window).
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2. Click Info. . . 

The Density Graph appears. Upon saving the calibration, its results 
are also saved as graphic data and displayed in the Density Graph.

Calibration graph showing cyan, magenta, yellow and black 
separations.
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The Density Graph contains the following data:

• Calibration name

• Measured D-Max values for each separation

• Target D-Max values for each separation 

• Minimum accepted density values for each separation (Xerox 
values) 

• View options: filtering by color - select which colors are shown / 
hidden

• Calibration curves (target and measured) for each separation

• Target is displayed as bold lines

• Measured is displayed as thin lines

• Index - emphasizes the difference between target lines and 
measured lines

• Properties: paperweight, screening, paper coating, % of max 
density

Spot Color Editor

Individual job pages can contain continuous tone (CT), line work 
(LW), and Spot color elements. The CSX2000 Color Server Spot Color 
Editor allows editing CMYK values of every Spot color in the Spots 
dictionary. You can edit these values without affecting the CT or LW 
page elements. It also lets you create custom spot colors and to define 
fixed CMYK values for those spot colors. The CSX2000 Color 
Server�s DFE supports only Pantone type Spot colors.

When the density of the DocuColor 2045 / 2060 is lower than 80% of the target 
density, the following message appears: 
�Attention: Below standard D-Max value(s) measured for <cyan, magenta, 
yellow, black>. 
Standard (Minimum): <C - 1.5>, <M - 1.4>, <Y - 0.9>, <K - 1.5>
Measured: <C - >, <M - >, <Y - >, <K - >�

Spot (for example Pantone) colors are not effected by CMYK emulation. A spot 
color has the same appearance with any selected CMYK emulation.
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To edit an existing pantone color:

1. From the Tools menu, select Spot Color Editor. . .

The Spot Color Editor window appears with the CSX2000 Color 
Server's entire collection of colors listed:

2. Search for a particular color under Color:

Under Color:, you cannot perform an exact query. This input stream only reads 
one character. For example, you want �Cool Grey 4� and type "Cool". As soon as 
you type �C�, the cursor only moves to �Cool Grey 1� and will not continue to a 
more specific selection. 
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3. Alternatively, in the Spot dictionary: drop-down list, select the 
color dictionary that contains the color you wish to edit.

4. Highlight the required color. The color's CMYK values and a color 
preview appear in the right hand side of the Spot Color Editor 
window.

5. Adjust CMYK values as required.

Use the Pantone CV dictionary if you are working in QuarkXPress.
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6. Click Apply. The new color is added to the Custom color 
dictionary.

7. If the color name was already modified and is in the custom 
dictionary, the following message appears:

8. Click OK to overwrite the color name, or click Cancel.
To create a new spot color:

1. In the Spot Color Editor window, click the New Color button.

The New Spot Color window appears.
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2. Type the new color name as it exists in the PS file. Adjust the 
CMYK values as required.

3. Click OK. The new color is added to the Custom color dictionary.

4. Alternatively, click Cancel to return to the Spot Color Editor 
window.

To delete a spot color (from the custom dictionary only):

1. In the Spot dictionary: drop-down list, select Custom Dictionary. 

2. From the list of custom colors, highlight the color you wish to 
delete.

3. Click Delete.

4. The following message appears:

5. Click Yes to delete the color. Alternatively, click No to return to the 
Spot Color Editor window. 
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Color Sample Jobs

The examples outlined in this section show seven common uses of 
color parameters:

• Applying last-minute brightness and contrast corrections to prints 
of scanned photographs

• Printing a presentation using out-of-gamut colors (in other words 
screen colors, such as RGB Blue)

• Using rendering intent to print a catalog with RGB images and 
adjusting their gamuts to that of the printer

• Using ink saving (GCR) to print posters

• Printing a file designed for offset printing and emulating the offset 
press for most effective user comparisons

• Using dot-type screening to print a catalogue

• Building and using your own gradations curve to modify color 
balance.

Notes: 
1. The print quality parameters closely influence color parameters. Print quality 
parameter settings have also been listed for these examples.
2. The B&W Printing job parameter is located on the Print Settings tab.
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Brightness and Contrast: Printing Scanned Photographs

In cases where you are printing scanned photographs, you might have 
to compensate for varying brightness and contrast levels. In this 
example, you can increase brightness and contrast for a job containing 
scanned photographs.  

Photograph A features decreased brightness and contrast, while 
photograph B Features Increased Brightness and Contrast. Photograph 
C is the original image.

A B C
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The color parameter settings for this job are as follows:

To print scanned photographs:

1. Download or spool the photo job from your client workstation to 
the CSX2000 Color Server. Or import the job from the CSX2000 
Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, move the slider to the left to Light, 10%.

Color Parameter Setting

Brightness Light, 10%

Contrast More

Rendering Intent Perceptual

Ink Saving (GCR) No

B&W Printing No

CMYK Workflow Original

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality Normal

Image Quality High

Trapping No

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 and 
Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, move the slider to the right to More.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select No.

8. In B&W Printing, select No.

9. In CMYK Workflow, select None.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send your photo job to print. The job is processed 
on the CSX2000 Color Server and sent to the Xerox DocuColor 
2060 / 2045 for printing.

Rendering Intent: Printing a Presentation Using Out of Gamut Colors)

A presentation, or any document that contains out-of-gamut monitor 
colors, (for example RGB blue) should be printed using the Perceptual 
option in the Rendering Intent job parameter.

Presentation with out-of-gamut colors.

Printer
Gamut
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The color parameter settings for this job are as follows:

To print a presentation using out of gamut colors:

1. Download or spool the presentation job from your client 
workstation to the CSX2000 Color Server. Or import the job from 
the CSX2000 Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Perceptual

Ink Saving (GCR) No

B&W Printing No

CMYK Workflow None

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 and 
Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, select Normal.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select No.

8. In B&W Printing, select No.

9. In CMYK Workflow, select None.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the presentation job to print. The job is 
processed on the CSX2000 Color Server and sent to the Xerox 
DocuColor 2060 / 2045 for printing.

Rendering Intent: Printing a Catalog with RGB Images

To print a job with scanned RGB images, use the Perceptual option in 
the Rendering Intent job parameter. 
This parameter ensures press-like quality for the job.

RGB
Gamut
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The color parameter settings for this job are as follows:

To print a catalog with RGB images:

1. Download or spool the presentation job from your client 
workstation to the CSX2000 Color Server. Or import the job from 
the CSX2000 Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Perceptual

Ink Saving (GCR) Medium

B&W Printing No

CMYK Workflow None

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, select Normal.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select Medium.

8. In B&W Printing, select No.

9. In CMYK Workflow, select None.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the catalog job to print. The job is processed 
on the CSX2000 Color Server and sent to the Xerox DocuColor 
2060 / 2045 for printing.

Ink Saving (GCR): Printing Posters

In cases where many intense colors are to be printed (for example 
colorful posters) use Ink Saving (GCR) to save toner, which avoids 
curling of paper or peeling of ink.

While the gray component of each color is replaced by black, there is no change in 
the color quality of the printed image.

No GCR Low GCR Medium GCR High GCR
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The color parameter settings for this job are as follows:

To print posters with Ink Saving GCR:

1. Download or spool the presentation job from your client 
workstation to the CSX2000 Color Server. Or import the job from 
the CSX2000 Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Perceptual

Ink Saving (GCR) High

B&W Printing No

CMYK Workflow None

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, select Normal.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select High.

8. In B&W Printing, select No.

9. In CMYK Workflow, select None.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the poster job to print. The job is processed 
on the CSX2000 Color Server and sent to the Xerox DocuColor 
2060 / 2045 for printing.

CMYK Workflow: Emulating an Offset Press

Various standards used in lithographic printing can be emulated on the 
Xerox DocuColor 2060 / 2045. This is done with the CMYK Workflow 
parameter. 

An example of a CMYK Workflow job would be printing a test sample 
for a survey before moving to an offset press to print millions of survey 
forms. In such a case, it is best to emulate the offset before the job 
actually goes to offset printing.

RGB colors are not affected by CMYK Workflow.
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The color parameter settings for this job are as follows:

To emulate an offset press:

1. Download or spool the survey form job from your client 
workstation to the CSX2000 Color Server. Or import the job from 
the CSX2000 Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Relative Colormetric

Ink Saving (GCR) No

B&W Printing No

CMYK Workflow Offset

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, select Normal.

6. In Rendering Intent, select Relative Colormetric.

7. In Ink Saving (GCR), select No.

8. In B&W Printing, select No.

9. In CMYK Workflow, select Offset.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the survey form job to print. The job is 
processed on the CSX2000 Color Server and sent to the Xerox 
DocuColor 2060 / 2045 for printing.

Screening Method: Printing a Catalog with Dot Type Screen of 200 lpi 

The rosette screen features round screen dots and is most suitable when 
simulating offset or gravure printing conditions on the Xerox 
DocuColor 2060 / 2045. To print a page of a catalog, which contains 
many images, use Rosette screening.
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The color parameter settings for this job are as follows: 

To print a catalog:

1. Download or spool the catalog job from your client workstation to 
the CSX2000 Color Server. Or import the job from the CSX2000 
Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Perceptual

Ink Saving (GCR) No

B&W Printing No

CMYK Workflow Offset

Screening Method Dot 200

Gradations None

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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5. In Contrast, select Normal.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select No.

8. In B&W Printing, select No.

9. In CMYK Workflow, select Offset.

10. In Screening Method, select Dot 200.

11. In Gradations, select None.

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the catalog job to print. The job is processed 
on the CSX2000 Color Server and sent to the Xerox DocuColor 
2060 / 2045 for printing.

Gradation: Using Your Own Curve to Modify the Color Balance

It is sometimes necessary to perform tone corrections before printing a 
job. For example, it may be necessary to modify the color balance of a 
document because the images have too much magenta in the midtones.
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The color parameter settings for this job are as follows:

To creating or modifying a gradation curve (for example, reducing 
magenta in the midtones)

When applying the Gradations parameter, use a pre-defined gradation 
curve, or define your own curve as follows: 

1. From Tools menu, select Gradation.
The Gradation window appears. 

2. Click Preview.

3. Click Browse.

4. Click on the RTP job to which you wish to modify. Click OK. 
Your job appears in the Preview window.

5. In Separation, ensure that only the Magenta icon is selected.

Color Parameter Setting

Brightness Normal

Contrast Normal

Rendering Intent Perceptual

Ink Saving (GCR) No

B&W Printing No

CMYK Workflow None

Screening Method Dot 200

Gradations Select curve from list

Print Quality Parameter Setting

Text Quality High

Image Quality High

Trapping Yes

Black Overprint Yes

PS Overprint No



Color Workflow 257

6. In the Mid box, reduce the Magenta value by depressing the arrow 
buttons. Your changes are displayed as a gradation curve and on 
the job image in the Preview window.

7. Use Before and After to view your changes� effects on the job.

8. Adjust any other gradation parameters in the Gradation window.

9. Select Save As and save your gradation curve under a new name.

10. Click OK.

11. Close the Gradation window.
To print the job:

1. Download or spool the job from your client workstation to the 
CSX2000 Color Server. Or import the job from the CSX2000 
Color Server workspace.

2. Double-click on the job in the Storage Folder in the CSX2000 
Color Server workspace.

3. Select the Color tab in the Job Parameters window.

4. In Brightness, select Normal.

5. In Contrast, select Normal.

6. In Rendering Intent, select Perceptual.

7. In Ink Saving (GCR), select No.

8. In B&W Printing, select No.

9. In CMYK Workflow, select None.

10. In Screening Method, select Dot 200.

11. In Gradations, select the curve that you created (refer to the 
previous page).

12. Adjust parameters in other job parameter tabs as required.

13. Click Submit to send the job to print. The job is processed on the 
CSX2000 Color Server and sent to the Xerox DocuColor 2060 / 
2045 for printing.

" For further details, refer to Printing from Client Workstations on page 28 
and Printing from the CSX2000 Color Server on page 44.

" For further details, refer to Job Parameters Window on page 51.
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PDF Workflow
You can significantly decrease processing time by selecting PDF 
Optimization. This function is useful for PDF jobs with repeated 
elements, which are marked as repeated in the PDF file.

For example, you have an element (a graphic or PowerPoint 
background) that appears more than once in a document. PDF 
Optimization backlogs the element once. But it can be retrieved and 
used as many times as needed. 

PDF Optimization in Preferences

1. Select whether to use PDF Optimization or ignore it in the job, 
from Admin > Preferences > PDF Optimization. Double-click on 
this setting.

2. Select one of the following options: 

• Enable PDF Optimization (default)

• Disable PDF Optimization
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Pre-RIP Preview

Pre-RIP Preview offers the ability to decide whether to keep the PDF 
that was created for the preview or to keep the original PS. The default 
is to keep the original PS. 

! Enter the Pre-RIP Preview dialog box. From the Tools menu select 
Administration > Preferences > Pre-RIP Preview. Double-click on 
this setting.

You can control all of the following:

• The conversion of PS to PDF

• How many booklets are displayed when previewing pre ripped VI 
files

• Pre-RIP preview for PS (to keep or not to keep the PDF file)

• Whether to keep the PDF files after preview or leave the original 
PS file in the Storage Folder without converting it to PDF 
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Editing & Saving PDF Files

In the Pre-RIP Preview dialog box, the following options appear:

1. Select whether to save the file as PDF or to return to the original 
PS file (default).

• With Save file as PDF, the edited PDF replaces the original PS 
file when saving the PDF from Acrobat.

• With Return to the original PS file, the edited PDF also 
replaces the original PS file in the Storage Folder.

2. Select the number of booklets (a personalized set of any number of 
pages) for pre-RIP preview (default is 4).
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PDF Workflows 

PDFToGo is a port through which you can export RTP files and 
convert it to PDF during export.

The system is capable of exporting jobs (both before and after 
processing), which are standard PDF files. For an exported RTP job, 
the PDF file includes the rasterized data of the job.

The operation converts the RTP information to raster files that can be 
encapsulated in a PDF format. This process ensures that the file can be 
processed and printed on any PDF printer. 

While Exporting as PDFToGo, a running bullet starts to move from left 
to right in the top-right server-printer animation of the workspace.

Export as PDFToGo

1. Select a file in the Storage Folder, right-click, and select 
PDFToGo. . . from the Shortcut Menu. 
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The PDFToGo window appears.

2. You can export every type of file, except for RTP jobs that were 
originally VI jobs.

3. You can view the exporting process by clicking on the Progress 
Indicator (the export arrowhead on the top-right server-printer 
animation). 

4. Each file is saved as a separate PDF under the job's name.
When exporting PDL files as PDF, the file is converted to PDF using Acrobat 
distiller. 
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Printing PrePress Files - Graphic Art Port (GAP)
Feature Overview

The GAP is a port through which you can import various file formats 
used in the Graphic Arts industry. GAP files are already rasterized. The 
CSX2000 Color Server needs only to prepare the files for printing, 
which means adjusting the file resolution and rotation. 

Importing GAP Files

During import of the assigned job file / s, the file is converted to a PDF 
that is displayed in the CSX2000 Color Server queues. The PDF can be 
programmed and printed as any other PDF file.

Supporting Graphic Arts Port (GAP) Files

The CSX2000 Color Server can import and consume the following file 
types:

• Brisque jobs

• TIFF

• TIFF IT

• CT / LW

The system converts these file types to �pre-rasterized� PDF files. 
GAP PDF files behave the same as any other PDF file and have the 
same Job Ticket operations.

The CSX2000 Color Server supports GAP files that are in composite 
format only.

To print a specific page, import the assigned file of the specific page. 
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Gap File Structure

TIFF IT

A TIFF IT file has 3 components:

• CT.TIF

• LW.TIF

• FP (final page) file, which combines CT.TIF and LW.TIF

! To import TIFF IT file to CSX2000 Color Server, first import the 
FP file. 

During import, the file is converted to a PDF, which is displayed in the 
CSX2000 Color Server queues. The PDF can be programmed and 
printed as any other PDF file.

CT, LW, TIFF

The components of a Brisque Job and TIFF IT, which are: CT, LW and 
TIFF, can be imported and printed separately to the CSX2000 Color 
Server.

Rasterized Brisque Jobs

All rasterized Brisque jobs have a typical structure. Each job contains 
an assigned file with one or more pages (in case of a multiple job). 
Also, every page contains its own assigned file, which combines LW 
and CT.

! To import a Brisque job to the DFE, import the assigned file of the 
job.

! To print a specific page, import the assigned file of the specific 
page.

The CSX2000 Color Server does not support Spot colors (for example Pantone) 
as part of the incoming job. In other words, the system does not consume 
Brisque jobs, which contain colors other than C, M, Y, and K. 
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Default Paper Size
When a PDL file does not contain any paper size information (usually 
set by the PPD), the RIP uses a pre-defined default size. You can set 
this default size, which is used by the system whenever a file enters the 
system without paper size comment in the code. By setting a default 
paper size, you have more control over the default RIP size.

Default paper size is mainly useful for transactional printing, where 
applications sometimes do not comply with all of the PostScript 
standards.

1. Access the Default Paper Size dialog box via Admin > Preferences 
> Default Paper Size.

The Default Paper Size dialog box appears.

2. Select a default size from the drop-down list.
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Managing Jobs
After entering the CSX2000 Color Server, jobs reside in the Queue 
Manager (which includes both the Process and Print queues) or in the 
Storage Folder. 

The Process queue lists all the jobs that are waiting to be processed and 
the job currently being processed. The Print queue lists all the jobs that 
were processed successfully and are waiting to be printed and the job 
currently printing. Each queue holds jobs in the order they entered it. 
The top job in the queue is the Running job, while all others are 
Waiting jobs. At any time, you can view information regarding the 
number and status of the jobs in the queues, reorder the jobs or suspend 
/ resume the queue.

The Storage Folder contains files that completed printing, were held or 
aborted during processing or printing, failed to complete processing or 
printing, or were imported or downloaded directly from the client to 
the Storage Folder (using the Spool & Store option). At any time, you 
can view information regarding the number and status of the jobs in the 
Storage Folder, sort and filter the list of jobs, or switch view modes.

While jobs are being handled by the CSX2000 Color Server, various 
messages are emitted. You can view the messages of each job (in Job 
History), of the entire session (in Message Viewer) or just the error 
messages (in Alerts).

Accounting provides information related to all the jobs that printed 
successfully and unsuccessfully via the CSX2000 Color Server. If 
required, you can filter, sort or print the list or export the report into a 
spreadsheet application (for example, Microsoft Excel), where you can 
manipulate the data as required.

The Print queue may also list frozen jobs, for which the appropriate paper stock 
is not available (for example, the correct paper type, paper size or paper weight). 

Grayscale images created in RGB applications (such as PowerPoint) should be 
specified as Monochrome or submitted to the system with B&W Printing 
selected in the PPD. This selection ensures that grayscale images are counted 
as B&W instead of Color in both the CSX2000 Color Server and in the 
DocuColor 2045 / 2060 billing meters.
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Queue Manager

After startup, the Queue Manager window appears.

! To close the window, deselect Queue Manager on the Tools menu

Or:

! Click  on the Pathways Panel.

Or:

! Click Close on the window's title.

! To open the window, select Queue Manager from the Tools menu

Or:

! Click  on the Pathways Panel.

The Queue Manager consists of the Process queue and the Print 
queue.
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Each queue holds jobs in the order they entered it. The top job in 
the queue is the Running job, while all others are Waiting jobs. 

If required, you can change the order of Waiting jobs in the queues 
or view / edit the parameters of a job.

In the Print Queue - in cases of very short jobs, several jobs may be Running. 
The jobs in the Running state are listed first and print in the order listed.

" References: 
1. The Status Panel indicates various data regarding the Queue Manager. For 
further details, refer to Status Panel Information on page 274.
2. You can suspend an entire queue or resume its work. For further details, refer 
to Suspending and Resuming Queues on page 277.
3. For further details on operations on the jobs residing in the Queue Manager, 
refer to Handling Jobs in Queues on page 279.



Managing Jobs 271

Process Queue

After submitting PDL files (or re-submitting PDL jobs), the lower area 
of the window (the Process queue) lists the files to be processed. 

Status

 indicates a Running job

 indicates a Waiting job 

Type

Indicates the file format of the PDL job (for example, PS, PDF, 
Variable Print Specification)

Title 

Indicates the name of the file to be printed.

Sender 

Indicates the user name of the system from which this file originated. 

Submitting a file whose name already exists in the CSX2000 Color Server 
automatically adds a sequential number to the file name (for example, submitting 
a file called LOBSTER while such a file already exists renames it to 
LOBSTER1).
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Submitted

Indicates the date and time this job was first submitted into the 
CSX2000 Color Server.

Pages

Indicates the number of pages to be processed in a PDF job.

Sets

Indicates the number of copies to be printed.

Print Queue

Once a file has been processed successfully, it moves to the Print queue 
and waits to be printed or sent to the Storage Folder (depending on the 
current Job Flow or Virtual Printer).

If the DTP application supported it, the number of pages is indicated for other 
PDL jobs.

Importing from a CD, archive and retrieve operations, and printing the 
Accounting log should not be performed when the system is processing or 
printing data. Suspend the Process Queue when performing these functions. 

" For further details on operations on the jobs residing in the Queue Manager, 
refer to Handling Jobs in Queues on page 279.
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Status 

 indicates a Running job

 indicates a Waiting job 

 indicates a Frozen job 

Type

Indicates RTP (Ready To Print). 

Title 

Indicates the name of the PDL file (without the extension).

Sender 

Indicates the user name of the system from which this file originated. 

Submitted

Indicates the date and time this job was first submitted into the 
CSX2000 Color Server.

Pages

Indicates the number of pages to be printed.

Sets

Indicates the number of copies to be printed.

A Frozen job is a job for which the appropriate paper stock is not available, for 
example, the correct paper type, paper size or paper weight.

" For further details on operations on the jobs residing in the Queue Manager, 
refer to Handling Jobs in Queues on page 279.
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Status Panel Information

The Process and Print panes indicate the following:

• The current number of jobs in the respective queue 
(for example, 1).

• The name of the job currently being processed / printed (for 
example, frog1) and a process indicator or No jobs running.

• The number of pages already processed / printed (for example, 2) 
and the total number of pages in the job (for example, 11).

On the Process pane - the total number of pages is indicated for PDF jobs. 
If the DTP application supported it, the number of pages is indicated for 
other PDL jobs. 
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• Click  and select Time to indicate the amount of time 
(in minutes) passed since the job started running. 

Reordering Jobs in Queues

Rearranging a queue lets you set a new processing or printing order.

You can perform any of the following: 

• Promote a job

• Promote a job to top of the queue

• Demote a job

• Demote a job to the bottom of the queue
Proceed as follows:

! Select the job in the Storage Folder. From the Job menu, select 
Reorder Jobs and select an available option.

All actions are valid for a single job only.
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Select one of the following options:

• To move the selected job one step up in the queue, select Promote. 

• To move the selected job to the top of the queue, select Promote to 
top. 

• To move the selected job one step down in the queue, select 
Demote.

• To move the selected job to the bottom of the queue, select 
Demote to bottom.

Or:

Drag the job to the required place.

The job is placed below the Running job.

LOBSTER before Promote to top LOBSTER after Promote to top



Managing Jobs 277

Suspending and Resuming Queues

If required, you can stop a queue (rendering it temporarily ineffective) 
and then later continue its operation. 

To suspend a queue:

! Select the red part of the Suspend / Resume button 

The button switches to . 
Processing / printing stops after the current job has finished 
running. 

To resume a queue, proceed as follows:

! Select the green part of the Suspend / Resume button 

The button switches to . 
The top job in the queue starts processing / printing.

Job Batching

The Job Batching method streams several jobs into a single batch to 
prevent the printer from cycling down between jobs. Every job that 
enters the Print Queue is checked whether it can be streamed to the 
previous job. 

• If a job can be streamed to the previous job, the job�s icon is 
changed to a running state and it prints without a cycle down. 

• A job that cannot be streamed to the previous job prints after the 
print engine cycles down. Jobs that follow this type job can be 
streamed to it. 
The operation of job batching can be turned on / off from the 
system preferences (the default setting is On). This feature saves 
printing time, especially for a large number of short / small jobs.

This is identical to selecting Suspend Process queue or Suspend Print queue 
from the Control menu.

This is identical to selecting Resume Process queue or Resume Print queue 
from the Control menu.



278 Chapter 5  Managing Jobs

Job Batching Workflow

1. The files arrive to the print queue.

2. The job is checked if it is fit for the current batch. If it is found fit 
for the current batch, the job is added to the batched list and runs as 
a batched job (without cycle down). If it is not fit for the current 
batch, it remains on the waiting list and is not run as a batched job 
(its icon remains the waiting icon).

3. Merged files are automatically batched with the upper jobs on the 
queue.

4. If the waiting list order changed and the previous job was not 
merged, then the job at the top of the waiting list is checked.

5. Enter the Job Batching dialog box from the Tools menu, 
Administration > Preferences > Job Batching. 

6. Select one of the following options:

• Enable Job Batching (default value)

• Select Disable Job Batching
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Handling Jobs in Queues
Overview

You can perform the following from the Process and Print queues:

• Abort a Running job

• Move Waiting jobs to the Storage Folder

• View the Thumbnail of a job

• Delete jobs

• View and modify the parameters of a job

• View the history of a job   
Proceed as follows:

! To select all the jobs in the active window, select Select All from 
the Selection menu (or press CTRL+A).

! To re-select any item and clear any selected item, select Invert 
selection from the Selection menu.

! Select the required action from the Shortcut Menu or from the Job 
Menu.

Some of the actions are supported for a single job only, while others are 
supported for several jobs at once.

Some actions may be performed by dragging the job(s) from a queue to the 
Storage Folder or vice versa.
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Aborting a Running Job

To stop processing / printing a Running job, you can use Abort.

1. Select the Running job in the Process or Print queue.

2. From the Job menu, select Abort.

The job is removed from the queue and is added to the Storage 
Folder. The Aborted status  is assigned to the job and the next 
job in the queue starts running.
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Moving Waiting Jobs to Storage

To postpone processing / printing of one or several Waiting jobs, you 
can move files to storage.

1. Select one or several jobs in the Process or Print queue.

To return a job to the proper queue, select the job(s) in the Storage Folder and 
Submit. For more information, refer to Printing from Client Workstations on 
page 28 and Printing from the CSX2000 Color Server on page 44.
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2. From the Job menu, select Move to Storage. 

Or:

Drag the job(s) from the queue into the Storage Folder.

The job(s) are removed from the Process or Print queue and are 
added to the Storage Folder. The Held status  is assigned to the 
job(s). 

To return jobs to their original queue(s), select the jobs and Submit (or drag the 
jobs to the relevant queue). For more information, refer to Printing from Client 
Workstations on page 28 and Printing from the CSX2000 Color Server on 
page 44.
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Viewing the Thumbnail of a Job 

You can view a small image representation of a page in an RTP job to 
help you identify it before printing.   

After startup, the Job Thumbnail window appears.

To close the Job Thumbnail window:

! Deselect Job Thumbnail in the Job Menu.

Or:

Click  on the Pathways Panel.

Or:

Click Close on the window's title.
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To open the Thumbnail window:

! Select Job Thumbnail from the Job menu

Or:

Click  on the Pathways Panel.
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To view the thumbnail, proceed as follows: 

! Select an RTP job while the Job Thumbnail window is open.
The window indicates the name of the job, the sequential number of 
the current displayed page, the total number of pages in the job, and 
the paper size and orientation. The view area shows the thumbnail 
of the current page.

! To view another page, click the up / down arrows or type the 
required page number. 

The view area updates accordingly.
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If you selected a non-RTP job, the Job Thumbnail window indicates its 
name (and the view area indicates NO THUMBNAIL).
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Deleting Jobs

1. Select one or several jobs in the Process or Print queue. 

2. Press Delete.
If you selected one job, the system indicates its name.

Or:

From the Job menu, select Delete.

Or:

Select Delete from the Storage Folder shortcut.
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The Delete Jobs dialog box appears.

If you selected several jobs, the system indicates their number.

The selected job(s) are removed from the Print or Process queue.

Notes: 
1. Once a job is deleted, it needs to be re-submitted for processing and printing.
2. To temporarily remove jobs from a queue, use Move to Storage (refer to 
Moving Waiting Jobs to Storage).
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Managing the Storage Folder
Storage Folder

After startup, the Storage Folder window appears.

To close the Storage Folder window:

! Deselect Storage Folder on the Tools menu.

Or:

Click  on the Pathways Panel.

Or:

Click Close on the window's title.

To open the Storage Folder window:

! Select Storage Folder from the Tools menu.

Or:

Click  on the Pathways Panel.

The Storage Folder window appears. Initially, it contains no jobs.
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The Storage Folder can contain jobs that:

• Completed printing 

• Were Moved to Storage (or Aborted) during processing (or 
printing)

• Failed to complete processing or printing

• Were imported or downloaded directly from the client to the 
Storage Folder (using the Spool & Store only option).

The Status Panel indicates various information regarding the Storage Folder.

" For further details on operations on the jobs residing in the Storage Folder, refer 
to Handling Jobs in the Storage Folder on page 304.



Managing the Storage Folder 291

You can filter the list by various statuses and switch list views.

Status Panel Information

The In Storage pane indicates the number of jobs of each status 
currently residing in the Storage Folder.
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Filtering the List

Each job in the Storage Folder is assigned one of the following 
statuses:

By default, the Storage Folder lists jobs of all statuses (all the Status 
buttons are selected). 

You can filter the list in order to list only jobs of one or several 
statuses, while not listing jobs of other statuses. 

To filter the list, proceed as follows:

1. Press any Status button (for example, Completed) in order not to 
list such jobs.

Status Indicates that

Completed

The job completed printing.

Held

The job was manually moved 
from the Queue Manager to the 
Storage Folder by the operator or 
automatically by the current Job 
Flow or Virtual Printer.

Failed

The job failed to complete 
processing or printing.

Aborted

The job was aborted by the 
operator when it was Running in 
the Queue Manager.

The black check mark emphasizes that jobs of this status appear in the list.
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The list updates accordingly.

2. Press any Status button in order to list such jobs (for example, the 
following lists Held jobs only).

If all the buttons are depressed, no jobs are listed.
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Switching List View Modes

By default, the jobs are listed in the Storage Folder along with various 
details, but you can select to list the jobs as Large Icons, Small Icons, 
a name List, or a list with Details.

Details View

This view is the default list view mode.

Sorting and resizing of columns is relevant for this mode only.
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To switch to another List View mode:

1. Click the List View drop-down icon 

2. Select the required List View mode from the drop-down list.
The list updates to list the jobs according to the selected List View 
mode.

Large Icons View

Compared to the default Details view, the icons are listed from the bottom right 
corner to top left corner.
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Small Icons View

Compared to the default Details view, the icons are listed from the bottom right 
corner to top left corner.
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List View

Compared to the default Details view, the icons are listed from the bottom left 
corner to top right corner.
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Sorting the List

When the jobs are listed using the Details List View mode, you can 
sort the list by its column headers. 

By default, the list is sorted by the order the jobs entered the Storage 
Folder.

1. To sort by one of the column headers (for example, Type), click the 
header once for ascending order.

2. Click again for descending order.
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After sorting, new jobs arrive at the top.
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Resizing Columns

In Details List View mode, by default - the Status, Type, Title, Sender, 
Submitted, Pages, and Size columns appear in the Storage Folder.

To resize columns (or even minimize columns so they are not viewed at 
all):

1. Click the cursor on the right border of the required column (for 
example, Sender). The cursor switches shape.
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2. Drag the cursor to the right to enlarge the size of the column, or to 
the left to decrease (in the following case, the column was 
minimized so it will not be viewed at all. To retrieve the column, 
drag the cursor to the right). 

Disk Management

The procedure to maintain image drives may be required periodically 
in the following situations: 

• To delete VI, RTP, and associated files form the image drives

• If the drives become fragmented

To format the image drives:

1. Delete all jobs in the CSX2000 Color Server Storage Folder.

2. Exit the CSX2000 Color Server Application. 

3. Click Start and browse to CSX2000 / CSX2000 Tools / Format 
Image Drives. 

4. Follow the on-screen prompts.
After three days of running and deleting VI jobs, it is recommended to update the 
Storage Folder by running the three minute Format Image Disks software 
routine. This process removes any remaining file fragments and deletes all 
resident jobs in the Storage Folder.

" For more information on formatting image disks, refer to the CSX2000 Color 
Server Installation Guide.
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Managing Disk Space

The Printer Disk (or Image Disk) holds the processed RTP files of a 
job.

The User Disk (or Spool Disk) holds the submitted PDL files, high-
resolution images, and pre-cached VI elements.

You cannot directly access these disks from within the CSX2000 Color 
Server, but you can manage them by deleting one or several jobs.

The bottom Status Bar indicates the Used and Free space on both the 
Printer and User disks.

In order to free disk space, proceed as follows:

1. Archive the jobs (refer to Archiving and Retrieving Jobs).

2. Delete the jobs (refer to Deleting Jobs).

3. Continue to delete additional jobs until you free enough disk space.

The procedure to maintain image drives may be required 
periodically to delete VI, RTP, and associated files form the image 
drives or if the drives become fragmented. 

Notes: 
1. Do not store files on the desktop. This causes the system disk to fill up and 
stops the RIPping process.
2. It is recommended not to quit the CSX2000 Color Server and store files on its 
disks. These files can not be accessed or deleted via the CSX2000 Color Server 
and may cause disk space problems that cannot be solved from within the 
CSX2000 Color Server.

When a job is deleted, its related PDL files are also deleted.
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Handling Jobs in the Storage Folder
Overview

You can perform the following:

• Submit jobs

• Preview a job

• Edit a job

• Archive a job

• Duplicate a job

• Delete jobs 

• View the thumbnail of a job

• View and modify the parameters of a job

• View job history



Handling Jobs in the Storage Folder 305

Proceed as follows:

1. Select the relevant job(s):

• To select all the jobs in the active window, select Select All 
from the Selection menu (or press Ctrl + A).

• To re-select any item and clear any selected item, select Invert 
selection from the Selection menu.

2. Select the required action from the Shortcut Menu or from the Job 
Menu.

Some of the actions are supported for a single job only, while others are 
supported for several jobs at once.

If you select several jobs, you can only Submit or Delete.
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Submitting Jobs 

! To move the selected job(s) from the Storage Folder to the bottom 
of the appropriate queue, select Submit. 

RTP Jobs are submitted to the Print queue. All other jobs are 
submitted to the Process queue.

Previewing RTP Jobs

You can preview an RTP job to closely inspect it before printing. You 
can navigate to the various pages of the job, switch the display mode of 
the page and view the pages as thumbnails.

Opening the Job Editor

! Select an RTP job in the Storage Folder and right click. Select Job 
Preview&Editor.

Or:

" References:
1. For further details on viewing Job History, refer to Job History on page 349.
For further details on viewing Job Thumbnails, refer to Viewing the Thumbnail of 
a Job on page 283.
2. For further details on viewing and modifying the parameters of a job, refer 
to Setting Job Parameters on page 49.

Or you can drag the job(s) from the Storage Folder and drop them into the 
appropriate queue.
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From the Job menu, select Preview&Editor.

The Job Editor window appears, displaying the first page of the 
selected job.
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The left pane lists the booklet(s) included in this job and the 
names/numbers of the pages within each booklet. 

A non-VI job always has one booklet only.
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The following shows the left pane of a job that includes several 
booklets (for example personal copies / sets as in VI information).

The tabs  allow you to switch between Booklets 
view (the default) and Thumbnails view.

The Navigation buttons  allow you to display 
other pages of the current job.

The Preview buttons  allow you to switch the display 
mode of the page.
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Viewing Pages in the Job Editor

To display a page in Booklets view:

! Double-click the name of a page (for example, Page 2) to display it.

The required page appears (and its number in the Booklet list 
becomes highlighted).

" For further information, refer to Preview Buttons on page 314. 
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To display a page in Thumbnails view:

1. Select the Thumbnails tab.
A small and approximate version of all the pages appears.

The following graphic shows a VI job that includes several 
booklets. The pages in each booklet are listed under the number of 
the booklet.
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2. To view additional thumbnails, use the vertical scroll bar. 

3. If required, resize the thumbnail area to view thumbnails side by 
side (you can then use the horizontal scroll bar to view additional 
thumbnails).
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4. Then double-click the thumbnail of the page you wish to display 
(for example, 3). 

5. The required page appears (and the number below its thumbnail 
becomes highlighted).

" For further details, refer to Preview Buttons on page 314.
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Navigation Buttons

By default, when you open the Job Editor, the first page of the job 
appears.

The Navigation buttons allow you to navigate between the pages of a 
job.

Select one of the following:

!  to display the first page of the job.

!  to display the previous page. Select  to display the next 
page.

!  to display the last page of the job.

Preview Buttons

By default, when you open the Job Editor, the entire first page of the 
job appears (it fits entirely into window mode). 

The Preview buttons allow you to switch the display modes of the 
displayed page.

If the first page of a booklet is accessed, navigation continues to the previous 
booklet. If the last page of a booklet is accessed, navigation continues to the 
next booklet.

" For further details, refer to Preview Buttons on page 314.
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To zoom into an area: 

1. Select  and click on the page.

The cursor changes to . 
The display updates in the zoom mode, displaying the window in 
Max Detail.

The cursor changes to 

2. Click again on the page to zoom out (to Fit in window or max 
detail mode - whichever prevailed before zooming in).

Displaying (or navigating to) another page resets the zoom.
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To display the actual size of the page:

! Select the  Fit to Window button.

The display updates to display the actual size of the page.

Notes: 
1. If the page is larger than the display, use the horizontal and vertical scroll bars.
2. Displaying (or navigating to) another page retains display mode (it displays 
the actual size of the required page).
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To fit the entire page into the window:

! Click the  Preview button.

The display updates to display the entire page.

Editing RTP Jobs
You can perform the following:

• Move pages within the job 

• Delete pages from the job 

• Insert pages from another job

• Merge entire jobs 
Proceed as follows:

1. Preview an RTP job (see Previewing RTP Jobs above).

2. Switch to Thumbnails view.

3. Modify the job as required (see Moving Pages within a Job, 
Deleting Pages from the Job, and Merging Jobs).

4. Save the modified job by a new name.

Notes: 
1. This is the default mode when you open the Job Editor.
2. Displaying (or navigating to) another page retains display mode (it displays 
the entire required page).

Notes: 
1. Jobs that contain VI files cannot be edited. 
2. The modified RTP has no PDL and can therefore be printed, but not re-
processed or duplicated. 

For details on job parameters that require re-RIPping that can not be changed in 
modified RTP files, refer to Setting Job Parameters on page 49.
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Moving Pages within a Job

If required, you can move a page to another location within the job to 
be edited (for example, switching between page #2 and page #3).

1. Click on the page to be moved (for example, page #3).
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2. Drag the page in-between any two pages to the required target 
location (for example, above page #2).

The red marker indicates where the page is inserted.
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The moved page is inserted in the required location and the page 
numbers update accordingly.

original order new order
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Deleting Pages from the Job

If required, you can delete a page from the job to be edited.

Proceed as follows:

1. Click on the page to be deleted.

2. Click the Delete pushbutton or press DELETE. The page is deleted 
and the page numbers update accordingly.

3. If required, delete additional pages.

Merging Jobs

You can copy a page from a job into the job to be edited or you can 
copy all the pages from a job and append them to the job to be edited.

Proceed as follows:

1. Click the Select Job. . . button. 
The RTP Jobs window appears.

2. Select the job from which you want to copy one or several pages.

Only RTP jobs of which the page size and orientation are identical to that 
of the job to be edited are displayed. 
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3. Click OK. 

The Thumbnails display area splits in two and the thumbnails of 
the other job are displayed below those of the job to be edited.

Notes: 
1. If the Job Editor is set to display booklets, when you select a second job for 
editing, the Job Editor automatically switches to thumbnail.
2. If you wish to view the job to be edited only, click the Close Job button.

job to be edi

other job
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Copying a Page from the Other Job

Once the thumbnails of the other job are displayed, you can copy a 
page from this job and insert it into the job to be edited.

1. Select the page that you wish to copy (for example, page #2).

2. Drag the page to the required location in the job to be edited.

The red marker indicates where the page is inserted.
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The copied page is inserted in the required location and the page 
numbers update accordingly.
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Copying all the Pages of the Other Job

If required, you can merge two entire jobs (copy the pages of the other 
job and insert them after the pages of the job to be edited).

1. Once the thumbnails of the other job are displayed, click the 
Merge Jobs button (with a blue arrow on the right).
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All the pages of the other job are inserted at the end of the job to be 
edited.
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2. Click the Close Job button to view the job to be edited only.
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Saving the Edited Job

After editing an RTP job, you save the modified job.

1. Click Save As. . . 
The following dialog box appears:

2. Type a new name for the job.

Or: 

Leave the indicated name to overwrite the job. 

3. Click OK.
The file is saved in the Storage Folder and the Job Editor window 
closes.

Notes: 
1. The modified RTP has no PDL and can therefore be printed, but not re-
processed or duplicated.
2. For details on job parameters that require re-RIPping that can not be changed 
in modified RTP files, refer to Setting Job Parameters on page 49.
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Previewing and Editing PDL Jobs

You can preview a PDL job to closely inspect it before processing. 

Proceed as follows:

1. Select a PDL job in the Storage Folder.

2. From the Job menu, select Preview&Editor. 

Or:

Select a PDL job in the Storage Folder. Right-click and select 
Preview&Editor.

The file appears as a PDF in Adobe Acrobat. 
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3. Modify the file as required.

4. Save the file and exit Adobe Acrobat.

The modified PDL is converted into a PDF that requires re-processing. 
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Duplicating Jobs
To copy a selected job in the Storage Folder: 

1. Select a job in the Storage Folder. From the Job menu, select 
Duplicate.

Or:

Select a job in the Storage Folder. Right-click and select Duplicate 
from the shortcut.

The following message appears:
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2. Click Yes to continue. The selected file is duplicated and is given 
the name of the original job followed by  "_dup".

Or:

Click No to halt duplicating until other print jobs have finished 
processing. Then duplicate the selected job.
You cannot duplicate an RTP job that was modified (using the Job 
Editor). When trying, the following message appears:

Archiving and Retrieving Jobs

When the Storage Folder fills with many jobs, you can backup jobs 
(with their related files) onto an external server. You can then delete the 
jobs from the CSX2000 Color Server. When required, you can return 
the archived jobs into the Storage Folder.

Duplicating an RTP job creates a new PDF version of the job. 

Archive and retrieve operations should not be performed when the system is 
printing or processing data. Suspend the Process queue when performing any 
archive or retrieve operation. 

Archiving jobs that are larger than 256MB require at least 768MB free space in 
D:/ Drive.
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To archive a job to an external server:

1. Select a job in the Storage Folder. From the Job menu, select 
Archive.

Or:

Select a job in the Storage Folder. Right-click and from the 
Shortcut Menu select Archive. 
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The Archive job window appears.

2. Access the required location and click Save. A cabinet file (in 
compressed ZIP form) is created at the selected location. It 
contains all the files related to the archived job. 

To retrieve an archived job back into the Storage Folder:

1. Select a job in the Storage Folder. From the Job menu, select 
Retrieve from Archive.

Notes:
1. The archived job retains its current status (Completed, Failed, Held, or 
Aborted) and is archived with its Job Parameters and Job History. When 
retrieved, an archived job retains the original job name, not the name assigned 
when archived.
2. To actually remove the job from the CSX2000 Color Server, select it in the 
Storage Folder and activate Delete.
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The Retrieve window appears.

2. Access the location in which you archived the job, select the 
related cabinet file, and click Open. 

The selected job appears at the top of the list in the Storage Folder. 
It is assigned the status (Completed, Failed, Held, or Aborted) it 
had when it was stored. 

Archiving & Retrieving VI Jobs

VI jobs that were processed can include VI cached elements. When 
jobs are archived / retrieved then the VI elements must also be archived 
/ retrieved. The archival / retrieval must be done in a certain order as 
specified in the following procedures.

Find the job using the archived job name. The original name appears when 
retrieved.

Notes:
1. The files related to the job (for example, PDL) are also retrieved.
2. The Job Parameters and Job History related to the job prevail.
3. The cabinet file is not deleted from its location. 

" For more information about VI Element procedures, refer to Organizing VI 
Elements on page 141.
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Default Archiving Path

The Default Archiving Path utility lets you select a default path
for archiving jobs. Once the path is set and Archive is selected from
the Job menu, the Archive window browser is directed to the 
predefined path.

To set the default archiving path:

1. Access the Archiving Path dialog box via Admin > Preferences > 
Default Archiving Path. Double-click on this option.

The Archiving Path dialog box appears.

2. Browse to the required location for your job archive.

3. Click OK.
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Deleting Jobs 

You can delete one or several jobs from the CSX2000 Color Server.

Proceed as follows:

1. Select one or several jobs. 

Press Delete.

Or:

From Job menu, select Delete. 

Or:

Right-click and select Delete from the Shortcut Menu.

Unlike archiving, the jobs may not be restored.
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If you selected one job, the system indicates its name:

If you selected several jobs, the system indicates their number:

The selected job(s) are removed from the Storage Folder.

Notes: 
1. When a job is deleted, its related PDL files are deleted as well.
2. To temporarily remove jobs from a queue, use Archive (refer to Archiving and 
Retrieving Jobs).
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Job Ticket Report
The Job Ticket Report contains all information from the Job 
Parameters window (including Job Parameters window title bar data).

The Job Ticket Report offers three main functions: 

• Presents the complete Job Ticket Report on a single sheet 

• Saves this report as a file 

• Prints a hard copy of the report
This feature is useful in the following situations:

• Updating the Hot-Line service on Job Ticket Report data when a 
question arises

• Keeping job parameters when the same job is planned to be re-
printed in the future

• Providing the client / customer a follow-up tool regarding printed 
Job Parameter information.

Enter the Job Ticket Report either one of two ways:

! Select a job on the Storage Folder, click the right button on the 
mouse, and select Job Ticket Report from the Shortcut Menu.

Or:
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Select the job in the Storage Folder. From the Job menu, select Job 
Ticket Report.
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The JTReportForm dialog box appears.

From this report, you can perform the following:

• Export the Job Ticket Report

• Print the Job Ticket Report

Notes: 
1. Updating Job Ticket data is done only through the Job Parameters window.
2. Although the system keeps job parameters data, there is no backup function. 
Thus you can not save Job Ticket Report data as a file.

" For specific Job Parameter details, refer to Job Parameters Window on page 51.
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Overview
While jobs are being handled by the CSX2000 Color Server, various 
messages are emitted. You can view the messages of each job (in Job 
History), of the entire session (in Message Viewer) or just the error 
messages (in Alerts).
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Alerts Window
Any time the system emits a message of type error, the Alerts window 
appears, listing all the error messages that were generated during the 
workflow (the total number of messages is also indicated). 

1. To view error messages at any stage of work, select Alerts from 
the Tools menu

Or:

Click the Alerts button on the Pathways Panel.
The Alerts window appears, listing all the error messages that were 
generated during the workflow. 

By default, the list is sorted to show new messages at the top of the list. 
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For each message, the origin of the message is indicated and a task that 
will solve the problem is suggested.

2. After one or several messages are no longer relevant, select the 
message(s) and click Clear to remove the message(s).

Or:

Click Clear All to remove all the messages.

3. Click Close to close the window.

Alert Messages

The Alert Messages utility let you select whether the Alerts window 
appears automatically or not when an error occurs. 

To set the alert window settings: 

1. Access the Alert Messages dialog box via Admin > Preferences > 
Alert Messages. Double-click on this option.

Cleared messages are not removed from the Message Viewer or related Job 
History lists.
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The Alert Messages dialog box appears.

2. For the Alerts window to appear whenever an error occurs, select 
Launch Alerts window automatically on new error.

3. To open the Alerts window upon selection only, select Launch 
Alerts window on user selection only.

System Disks

When the Printer or User Disks reach a pre-defined threshold (usually
of 256 MB), RIP is suspended and the system provides a warning
message. The RIP resumes automatically only after disk space is
available.

To define the system disks threshold:

1. Access the System Disks dialog box, via Admin > Preferences > 
System Disks. Double-click on this option.

The System Disks dialog box appears.
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2. Set the minimum free disk space required for RIP.

3. Click OK.
The default free disk space value is 250MB.
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Job History
! Access the Job History window one of three ways:

Select a job in the Queue Manager and double-click.

Or:

Select a job in the Storage Folder. From the Job menu, select Job 
History.

Or:

Select a job in the Storage Folder. Right-click and select Job 
History. . . from the Shortcut Menu.

The Job History window appears, listing all the messages that were 
generated during the workflow of the selected job. 
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This window indicates the job title and the sender name (the user 
name of the system from which this job originated).

Message Information

For each message, the following information is indicated by default:

• An icon denoting the type of message (Error, Warning, or 
Information)

• The date and time on which the message was emitted (time stamp 
data)

• The stage in the workflow (for example, Print or Process)

• The message text

You can filter the messages by type and / or sort the list by one of 
the column headers. 
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Message Viewer
1. At any stage of work, access the Message Viewer window from the 

Job menu, Message Viewer. . .

The Message Viewer window appears, listing all the messages that 
were generated during the workflow. 

To view messages related to a specific job, refer to Listing Job History Messages 
above.
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By default, all the jobs that were handled during the last 3 months are 
listed. 

2. You can filter the messages by type and / or sort the list by one of 
the column headers. 

3. Also, you can print the list of messages (refer to Managing 
Messages).

 

The default can be changed in Preferences under Administration (refer to the 
CSX2000 Color Server Installation Guide).
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Managing Messages

If required, you can reorder and resize columns, filter the list or sort the 
list by one of its column headers.

Reordering Columns 

If required, you can change the current order of the columns.

Notes: 
1. This section is relevant for the Message Viewer and Job History windows (but 
not for the Alerts window).
2. These settings are retained after closing a window.
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! Click the cursor on a column (for example, Stage) and, without 
releasing the mouse button, drag the column to the left or to the 
right to the required location (for example, to place the Stage 
column after the Date / Time column).
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Resizing Columns 

If required, you can resize columns (or even minimize columns so they 
are not viewed at all).

1. Click the cursor on the right border of the required column (for 
example, Sender). The cursor switches shape.

2. Drag the cursor to the right to enlarge the size of the column, or to 
the left to decrease (or to minimize the column so it will not be 
viewed at all). To bring the column back into view, drag the cursor 
to the right.
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Filtering the Messages by Type

Each message in the Message Viewer and Job History windows is 
assigned one of the following types:

By default, the messages of all types are listed in the Message Viewer 
(all the Type buttons are selected). 

You can filter the list in order to view only messages of certain types, 
while not listing messages of other types. 

Depress any Type button (for example, Error) in order not to list such 
messages.

Error messages are listed.

Warning messages are listed.

Information messages are listed.

The  emphasizes that messages of this type appear in the list.

If all the buttons are depressed, no messages are listed.
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The list updates accordingly (in the example below, Error messages are 
not listed).
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In the example below, both the Error and Warning buttons were 
depressed, so the window lists only Information messages.
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Sorting the Message List 

By default, the list is sorted by the date at which the messages were 
created (in descending order).

If required, you can sort the list by one of its column headers. 

To sort by one of the column headers (for example Job Title)

1. Click the header once.

2. Click again to switch the order.
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Printing the Message List

You can print the information as it is presented in the Message Viewer 
(as it is currently filtered and sorted).

1. Filter and sort the list as required.

2. Click the Print List. . . button to display the Print window.

3. Set the printing options as required and click OK.

The data is printed according to the current filtering and sorting.
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Pop-up Messages 
Pop-up messages appear during normal operations with the CSX2000 
Color Server. These messages may request confirmation of an action 
(for example, changing an imposition method), warn of a lack of 
printer resources (for example, if a specific paper stock is missing), or 
warn of a possible problem with a procedure.

Example pop-up messages include the following:

When a pop-up message appears:

1. Read the pop-up message. 

2. Take action as requested by the pop-up message (for example, 
confirm a procedure or replace printer resources).

3. Continue with normal CSX2000 Color Server operations.
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Handling Job Accounting
The Accounting feature offers information related to all the jobs that 
printed successfully and unsuccessfully via the CSX2000 Color Server 
as a tab delimited file. If required, you can filter, sort or print the list or 
export the report into a spreadsheet application (for example, Microsoft 
Excel), where you can manipulate the data as required.

Viewing the Accounting Information

! Access the Accounting Viewer window from the Job menu and 
select Accounting. . .

The Account Viewer window appears, listing information related to 
all the jobs that printed successfully and unsuccessfully via the 
CSX2000 Color Server. 

Grayscale images created in RGB applications (such as Power Point) should be 
specified as Monochrome or submitted to the system with B&W Printing 
(recommended) selected in the PPD. This selection ensures that grayscale 
images are counted as B&W instead of Color in both the CSX2000 Color Server 
and in the DocuColor 2045 / 2060 billing meters. 
However, if you have a book with mixed pages (some are color and some are 
B&W) and you want the B&W pages to be counted as B&W, from the Job 
Parameters window > Print Settings tab > B&W Printing select the Print grays 
using only black toner check box. 
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Each row in the Accounting report indicates information related to a 
specific job (including non-successfully completed jobs).

Notes: 
1. To see additional columns, use the horizontal scroll bar.
2. By default, all the jobs that were handled during the past 3 months are listed. 
In the Administration: Preferences window (described in the CSX2000 Color 
Server Installation Guide) you can specify how long information remains before 
being overwritten. In addition, you can remove all the information from the 
window whenever required.
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The columns indicate the following information.

Job Title The original name of the file related to this 
job (without the extension).

Sender The user name of the system from which this 
job originated.

Submitted The date and time the job was first submitted 
into the CSX2000 Color Server.

Started Printing The date and time on which the job first 
started printing.

Processing Time The total time during which the job was 
processed.

Printing Time The total time during which the job was 
printed.

Job Size he size of the PDL file from which the job 
originated.

Paper Size The size of media set for the job (for 
example, A2, A3, A4).

Sets The actual number of copies printed.

Job B / W Pages he number of black-and-white pages in the 
original PDL file. 

Job Color Pages The number of color pages in the original 
PDL file. 

Total Pages Printed The actual number of pages printed.

Account [optional] A string of text, if such was 
entered in Job Parameters.

Recipient [optional] A string of text, if such was 
entered in Job Parameters.

Job Comments [optional] A string of text, if such was 
entered in Job Parameters.
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Managing the Accounting Information
Reordering Columns 

You can change the current order of the columns. The following figure 
shows the default order (Sender followed by Submitted).

! Click the cursor on a column (for example, Sender) and, without 
releasing the mouse button, drag the column to the required 
location (for example, to place the Sender column after the 
Submitted column).
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Resizing Columns 
To resize columns (or minimize columns to hide them):

1. Click the cursor on the right border of the required column (for 
example, Submitted). The cursor switches shape.

2. Drag the cursor to the right to enlarge the size of the column, or to 
the left to decrease (or to minimize the column to hide it altogether. 
To retrieve the column, drag the cursor to the right).

The following picture shows the list after hiding the Submitted 
column. 

! To re-display a hidden column, place the cursor on the location of 
its original left border and drag to the right until the full column is 
re-displayed. 
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Filtering the Information by Date

By default, the information that was gathered in the past three months 
appears. You can filter the list to show all the information gathered or 
only information that was gathered within specific dates.

To filter the list:

1. Click the arrow to the right of the From or To date box.

2. Select the required date from the calendar that appears.

The list updates accordingly.
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Sorting the Information

By default, the list is sorted by the date on which the jobs (successful 
and unsuccessful) were submitted (the latest dates appear first).

You can reverse the order or sort the information in the report by 
another information column.
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1. Click another column header (for example, Sender) to sort the list 
by that column (in ascending order). 

2. Click the column header again to sort by descending order.

Accounting / Message Viewer Log Setup

By default, all the jobs that were handled during the past 90 days are 
listed in the CSX2000 Color Server Accounting window. Also, all jobs 
that were handled during the past 56 days are listed in the CSX2000 
Color Server Message Viewer. This utility lets you enter different 
values to specify how long information remains before being 
overwritten.

Depending on the type of information, the sorting is alphabetical or numerical.
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To change the Accounting / Message Viewer Log Setup:

1. Access the Accounting / Message Viewer Log Setup dialog box via 
Admin > Preferences > Accounting / Message Viewer Log Setup. 
Double-click on this option.

The Accounting / Message Viewer Log Setup dialog box appears.

2. In the Accounting Log Setup and Message Viewer Log Setup 
areas, type the required values to specify how long information 
remains before being overwritten.

3. To remove all the existing information from the windows, 
whenever desired, click the Clear Log Now button.

4. Click OK to confirm the changes you made.
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Exporting the Accounting Report 

You can save the Accounting information (for both successful and 
unsuccessful jobs) to an ASCII Tab delimited file.

1. Filter the information as required.

2. Click the Export. . . button to display the Export Accounting 
window.

3. Browse for the location in which to save the report.

4. Click Save.
The report is saved as a Tab delimited text file in the specified 
location. 

If required, open the *.txt file in a text editor or in a spreadsheet 
application (for example, Microsoft Excel) and manipulate the 
data.

Notes: 
1. The report includes all the columns (even those that were hidden), listed in the 
original order and sorting.
2. To print specific rows, select them before clicking Export. The printed report 
includes only these rows.
3. The exported data is not deleted from the Accounting report on the CSX2000 
Color Server (it still appears in the Job Accounting window).
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Printing the Accounting Report 
You can print the Accounting information as it is currently filtered and 
sorted to any connected printer.

1. Filter and sort the report as required. If required, select the rows to 
be printed.

2. Click the Print List. . . button to display the Print window.

3. Access the required printer. 
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4. Set the printing options as required and click OK.
Successful and unsuccessful job data is printed according to the 
current filtering and sorting.

Notes:
1. Do not print the Accounting log when the system is printing or processing 
data. Suspend the Process queue when printing the Accounting log. 
2. To fit as many columns as possible onto the page, activate Landscape (if your 
printer supports it).
3. The report includes all the columns (even those that were hidden), listed in the 
original order.
4. To print specific rows, select them before clicking Export. The printed report 
includes only these rows.



This Page Is Intentionally Blank.



377

Appendix A

Color Theory

Color Theory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378



378   Color Theory

Color Theory
Color is a visual sensation involving light, an object, the human eye 
and the brain. Each person perceives color differently due to their eyes 
ability to see colors correctly and their own societal and emotional 
backgrounds. Thus colors are seen differently due to physiological and 
psychological differences.

To learn about the process of color reproduction, it is necessary to 
understand basic color theory and concepts of light.

Light

Light is a form of energy that includes radio waves, x-rays, ultraviolet 
and infrared light. The human eye is sensitive to a range of this energy 
between the ultra violet and the infrared called the Visible Spectrum. 

The colors in the Visible Spectrum can be described by their 
wavelength. The spectrum is measured in nanometers (nm): a 
nanometer is a billionth of a meter. Technically, visible light ranges 
from approximately 380nm to 760nm. However the human eye is 
relatively insensitive to light below 400 nm and longer than 700 nm.
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Visible Spectrum

The visible light spectrum can be broken into three predominant bands 
of color. These bands are red, green and blue and are called the primary 
colors of light.

Light Behavior

The way that light waves travel depends on the objects they come in 
contact with. Light waves can be reflected, absorbed, or they can be 
transmitted through an object.

How light waves react is determined by the object they hit. Which 
colors are reflected, absorbed or transmitted determine the color of the 
object.
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The Perception, Physiology and Psychology of Color

Color as a Sensation

Seeing color is a sensation, like hearing or taste. There is no absolute 
color that is inherently seen the same way by every person. Nor is 
every person's vision the same.

Everyone agrees that ripe tomatoes are red (in season). However, a 
group of people probably won't agree on which tomato is the reddest, 
or how a group of tomatoes should be ranked in terms of their redness. 
Beyond the physiological factors that impact our vision, there are 
psychological factors as well. 

How the Eye Sees Color

The retina, which is considered to be part of the brain, is a complex 
nerve structure containing light-sensitive receptors that are responsible 
for translating incoming light into nerve impulses. Because of their 
physical appearance, these receptors are known as rods and cones.

From the retina, the information from the rods and cones travels along 
the optic nerve to the brain. What the brain sees is the experience of the 
viewer and the condition of the rods and cones on his retina. There are 
three types of cones, generally referred to as red, green and blue 
sensitive cones. If some of these cones are defective, or missing, the 
viewer�s interpretation of some colors is affected and color blindness 
may result. 

Rods help us see at nighttime or at low levels of light. The rods cannot 
detect color, only varying levels of black, gray, and white.
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Other Factors Affecting How The Eye Sees Color

There are a number of other circumstantial and environmental factors, 
which impact how the eye perceives light and color. They include:

• Color Temperature (Light Intensity) 

• Metamerism 

• Surrounding Color 

Color Temperature

The intensity of the surrounding light changes the perceived color of 
any object.

Color temperature is a way of measuring the intensity of light radiating 
from a light source and a measure of the relative intensity of all 
wavelengths in the visible spectrum. It is measured by comparison to a 
specific metal contained in a black box and heated to a specific 
temperature. The unit used to measure color temperature is Kelvins. 
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The standard color temperature for viewing color reproductions is 
5,000 Kelvins. Viewing booths suitable for evaluating color must be 
set to this standard to ensure correct lighting conditions.

Metamerism

Metamerism occurs when two colors match under one light source, but 
appear different under another light source. Those two colors are called 
a metameric match. A metameric match might cause problems when 
trying to match proofs to press-sheets under different lighting 
conditions.

Surrounding Color

The color surrounding an object can affect how the actual color of the 
object is perceived. If a green circle is surrounded by light green, it 
appears lighter than if it is surrounded by dark blue.

Circle surrounded by Blue Circle surrounded by Green Original Circle
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Additive Color

White Light

White light is the sum of Red, Green, and Blue light. This is known as 
additive color. When equal parts of each of the primary colors are 
added together, white light is created. 

The absence of all three colors produces Black.
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When two primary colors of light are added together, a secondary 
color, brighter than either of its components, is created. Note the 
following combinations:

Red + Green = Yellow 

Red + Blue = Magenta 
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Blue + Green = Cyan

Combining Red, Green, and Blue in unequal proportions makes new 
colors. The proportions themselves determine the color. From these 
three colors, the entire visual spectrum can be created.

Additive color involves the manipulation of a light source or multiple 
light sources to control color. A television monitor, for example, uses 
additive color. 

Red, Green and Blue inks can not be used for full color reproduction, 
however, since the objective of such color reproduction is to control 
Red, Green and Blue light. Printing Red, Green and Blue is therefore 
controlled by printing with Cyan, Magenta, Yellow and Black.
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Subtractive Color

Printed color begins with white paper illuminated by white light. All 
the color and all the light we can see in the image must first exist in the 
illuminated paper. Take away the light, or print on black paper (with 
transparent inks) and you will see nothing. 

To build a color image, all we can do is selectively subtract some of the 
light.

When we print with a Red ink, we see it as Red because it absorbs Blue 
and Green light and reflects only Red. In other words, red ink absorbs 
or subtracts two thirds of the visible spectrum and reflects one third. 
The same can be said for Blue and Green. They each absorb two thirds 
of the visible spectrum and reflect one third.

The effect of overprinting any equal combination of two of these colors 
is to absorb all three components of light and produce Black. 
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In the printing process we use colored inks that each reflect not one 
third, but two thirds of the visible spectrum. These special inks 
correspond to the secondary colors of light, namely Cyan, Magenta, 
and Yellow.

Since each color absorbs one third of the visible spectrum, it takes all 
three inks to make Black. Overprinting any two of these colors 
produces Red, Green, or Blue.
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By overprinting selected amounts of Cyan, Magenta, and Yellow, the 
widest range of colors within the limitations of paper and ink can be 
achieved.

Pigments

Most of the colors we see in the world can be reproduced using dyes or 
pigments. When applied to color reproduction, subtractive color also 
deals with pigments and filtering.

Pigments must be incorporated into a binder to be attached to the 
substrate, as in a paint film attached to the wall of a house. As in paints, 
xerographic pigments are substances that possess different sensitivities 
to light. These sensitivities have the ability to absorb only portions of 
white light while reflecting back others.

The combination of the lights action on the pigment in an object, 
combined with how the eye reacts to the reflected light, determines 
how the color of the object is perceived.

Color Reproduction

In color reproduction, pigmented transparent inks (Cyan, Magenta, and 
Yellow) are used for printing. These inks are called process colors. A 
transparent printing ink is made to absorb one component of white 
light and transmit the other two. Hence, the term transparent. The 
paper, or substrate, then reflects the transmitted colors back to the eye.
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Cyan ink absorbs only Red light, so it appears Blue-Green. Magenta 
ink absorbs only Green light and appears Bluish-Red. Yellow ink 
absorbs Blue light.
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Inks as Filters

It is important to note that inks act like color filters. A filter transmits 
its own color and absorbs the rest. Since the inks are transparent, it is 
the paper that reflects back the colored light minus the components that 
the inks filter out.

Color Absorption and Reflection

In theory, when each of the process colors - Cyan, Magenta, and 
Yellow - are overprinted, absorbing all the visible light reflected from 
the paper, the result is Black. 

In reality, solid layers of all three printing inks do not absorb all the 
available light and a Brown color is produced. This is because of 
impurities in process inks. Cyan ink not only absorbs Red as it should, 
but also absorbs some Green and Blue light.

The Magenta ink should absorb only Green light. It also absorbs some 
Blue and Red. Yellow ink is nearly ideal.
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To overcome this problem, Black ink is also used. When Black ink is 
added to the reproduction, it adds detail and enhance contrast, making 
the dark areas appear darker and the light areas appear lighter.

Color Separation

The process of translating a color photograph or transparency into its 
Cyan, Magenta, Yellow and Black components is called color 
separation.

The principle of color separation is similar in both photographic and 
electronic scanning processes. Each process utilizes the concepts of 
additive and subtractive color for filtering the individual components 
of white light.
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The photographic process consists of illuminating the original copy 
with white light and then separating it into three images by placing 
Red, Green, Blue filters in between the copy and the film.

• A Red filter is used to generate the Cyan separation. 

• A Green filter is used to generate the Magenta separation. 

• A Blue filter is used to generate the Yellow separation. 

The Black separation is made from a combination of the other three 
colors.

Photographic Separation

When light passes through the Red filter, it exposes all areas of the 
negative film (converting them to Black) where the Red component of 
the White light appears in the copy.

The negative film is then converted into a positive film. Since positive 
is the reversal of a negative, the black portions of the positive film now 
correspond to the areas in the image where Red is absent. The positive 
film, therefore, becomes the Cyan separation since Cyan is the absence 
of Red.

This same procedure is used to produce the Magenta and Yellow 
separation films.



Color Theory 393

CMYK

The printing industry generally refers to the four process color 
separations as CMYK where:

• C is for Cyan. 

• M is for Magenta. 

• Y is for Yellow. 

• K is used for Black, to distinguish it from Blue. 

However, Creo sometimes uses CMYB where black is designated by 
the letter B. In the image assembly process, one of the four separation 
films is used as a master or key to which the other three separations are 
placed in register. Traditionally, the key color is black. This is why the 
letter K is used for black.
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Imposition on the CSX2000 Color Server
The CSX2000 Color Server drives a Xerox DocuColor 2060 / 2045 
digital printer. The CSX2000 Color Server processes image files in 
PDL formats, converting them into a suitable RTP format for direct, 
high-quality printing. 

In combination with the Xerox DocuColor 2060 / 2045 Printer, the 
CSX2000 Color Server outputs flyers, brochures, pamphlets, dummy 
catalogs, short-run trials and print-on-demand publications.

When installed as a fast, networked printer with the CSX2000 Color 
Server, the Xerox DocuColor 2060 / 2045 Printer prints up to 60 full-
color A4 (210mm x 297mm) or Letter (8.5� x 11�).

The CSX2000 Color Server lets you adjust various imposition 
parameters. This is done through the Imposition tab of the Job 
Parameters window.
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Imposition Job Parameters

Imposition allows printing multiple job pages on sheets. Imposition 
also controls the positioning of images or pages on a press sheet so that 
after binding, the pages are correctly located in a publication. A 
publication can be any finished unit of printed and bound matter, such 
as books, booklets, flyers, brochures, business cards, posters, and so 
no. Use of imposition increases printing efficiency and saves time and 
printing resources. 

The following Imposition parameters can be adjusted on the CSX2000 
Color Server:

Method

Method refers to the Binding Method. The CSX2000 Color Server 
performs four Binding Methods: 

Step & Repeat

The Step & Repeat binding style is used for signatures that will not be 
folded. Step & Repeat can require cutting but not folding. 
Step & Repeat is generally used for one or two-sided publications such 
as brochures and business cards. Step & Repeat jobs generally result in 
smaller file sizes, faster spool and RIP times and better productivity.
On the CSX2000 Color Server, Step & Repeat jobs only require 
template selection and adjustment of crop marks.

Cut & Stack

Within the Step & Repeat method, is the sub-option Cut & Stack. A 
job�s pages or booklets are sorted in a Z-shape. In other words, each 
stack of pages is sorted in consecutive order. Thus, when stacks are 
piled one on top of another, the entire job is already sorted up or down. 
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Saddle Stitch

Saddle Stitch bounds pamphlets, brochures, folders, leaflets and 
magazines with staples through the centerfold. The name comes from 
the saddle-like device over which the assembled sections hang while 
being stapled. The cover and the body are bound at the same time, even 
it the item's cover is heavier than the body.
Signatures are opened up and placed onto the rail, one signature on top 
of another. Stapling then binds the signatures together and three sides 
are trimmed away.
On the CSX2000 Color Server, Saddle Stitch jobs require template 
selection and adjustment of crop and fold marks.

Perfect Bound

Perfect Bound, also known as Adhesive Binding holds the pages 
together with a hot melt adhesive.The cover is mounted on the body of 
the book while the adhesive is still molten. Paperback books are the 
most common adhesive-bound products.
In Perfect Binding, the signatures are gathered side to side. The set of 
signatures is placed bind edge down in a clamp. The bind edge of the 
book is ground-off or sawed-off. Hot melt adhesive is applied to the 
exposed ground edge. The cover is applied while the adhesive is still 
hot. Top, bottom and front edge are trimmed-off in a three knife 
trimmer.
On the CSX2000 Color Server, Perfect Bound jobs require template 
selection, adjustment of crop and fold marks. Margin adjustment 
depends on the sheet size.

Size

Sheet size is the size of the actual physical paper, on which the job will 
be printed. You can define the paper stock size that the job will be 
printed on. It overrides the Paper Size job parameter in the Paper 
Stock tab.

When selecting the size parameter, define the following:

• Sheet size

• Trim size

• Bleed size



Imposition on the CSX2000 Color Server 399

Sheet Size

Sheet size is the actual physical paper size. Define the paper stock size 
that the job will be printed on. It overrides the Paper Size job 
parameter in the Paper Stock tab. Select from one of the following:

• The default sheet size taken from the PS file.

• The drop-down list of available sheet sizes.

• Custom sheet size to define the height and width, based on the 
document size you defined in the DTP application.

You can also select whether you want LEF (Long Edge Feed) or SEF 
(Short Edge Feed).

Trim Size 

Trim Size defines the area of the job page that is printed on the sheet. 
The job is finished according to the Trim Size settings.
On the CSX2000 Color Server, the Trim Size Parameter also allows 
you to set Bleed. Bleed extends part of the printed page image beyond 
the trimming boundary. This avoids white edges after cutting and 
folding pages with elements adjacent to the edge of the page.

Trim size is the actual page size (which contains the whole image) on 
which you work in your authoring tool. Select from one of the 
following: 

• The drop-down list of available trim sizes. 

• Custom to define a custom trim size. 

" For more information, refer to Template Orientation on page 401.
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Bleed Size

Bleed extends part of the printed page image beyond the trimming 
boundary. This avoids white edges after cutting and folding pages with 
elements adjacent to the edge of the page. Select one of the following:

• To Fold in order to extend bleed to the sheet fold lines.

• Custom and specify the Bleed Size. Manually type a value in 
millimeters.

Template

A template is the set of parameters that defines how job pages are 
placed on the sheet. This includes page orientation, the number of 
pages printed on the sheet and page sequence. Templates also defines 
whether a job is printed on one or both sides of the sheet.
Templates contains page sequence numbers, which determine which 
job page(s) are placed on the sheet. For example, in a standard Step and 
Repeat Template, there is only one sequence number, so the same job 
page is printed several times on a sheet. The sequence number that 
appears in a template determines which job page to print from the 
sequence of job pages in the job file. When the file has more than one 
page, each page is printed several times on each sheet.
The CSX2000 Color Server offers various templates for each available 
Method.

Notes:
1. You cannot extend the bleed size beyond the sheet fold lines. Bleed does not 
affect the position of crop marks.
2. If a file incorporates bleed previously applied in a DTP application, applying 
bleed in the Imposition tab results in the bleed effect. If bleed has not been 
incorporated in the file, application of bleed on the CSX2000 Color Server does 
not create bleed.
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Template Orientation

When considering template orientation, SEF (Short Edge Feed) 
delivers pages lengthwise, while LEF (Long Edge Feed) delivers page 
sideways (the orientation of the data remains the same in both cases, as 
you have defined it in your application).
In general, when sheet orientation is LEF, it is not necessary to use a 
rotated template. When sheet orientation is SEF, it may be helpful to 
use a rotated template. Selection of template orientation is dependant 
on sheet size and trim size.
At the lower right hand corner of the CSX2000 Color Server 
Imposition tab, a dynamic thumbnail view shows the effect of your 
parameter choices on the printed sheet. The thumbnail viewer appears 
when you select the Template job parameter.

When setting the Template parameter, the thumbnail view continuously 
updates your selections for trim size, margins and sheet size.
In the thumbnail view, the page orientation is indicated by the direction 
of the arrows (which points to the head of the page) and not by the 
orientation of the numbers. In the thumbnail view, conflicting 
parameter settings are indicated by red corners on the pages on the 
template.
In addition, the CSX2000 Color Server does not print a job that 
contains conflicting or inappropriate template parameters.

Marks

Marks are additional images printed on the sheet that help in the 
finishing process by noting where trimming and folding should occur. 
They also help with color control. On the CSX2000 Color Server, you 
can add Crop marks and Fold marks.

The template option and the thumbnail view are not active if you select None as 
your imposition method.



402   Imposition Theory

Margins

The Margins Imposition parameter allows you to adjust the space 
between trim sizes (and pairs of trim sizes) so they fit your finishing 
requirements. You can adjust:

• Spine Trim Size 

• Minimum Gutter Size

• Minimum Margin Size

Spine trim size is the space between adjacent trim sizes on a printed 
sheet, which, when folded into a booklet, allows for grinding and 
perfect binding. 
This option is only available for Perfect Bound.

The gutter is the inside space between pairs of trim sizes on a sheet. 
When folded into a booklet, the gutter allows space for trimming.

Margin size is the distance between the outside edges of the sheet and 
the edges of the trim sizes printed on the sheet. On the CSX2000 Color 
Server, you can set the minimum margin size, but not the exact size, 
which is calculated automatically in accordance with other imposition 
parameters. 
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Creep

When inserting signatures inside one another when binding saddle-
stitched jobs, the signatures inserted last (towards the center of the job) 
are the furthest away from the center of the publication. When the 
publication is trimmed down to its final size, the inward page sections 
drift outward (or are even clipped).
Creep compensates for this problem by moving the pages on inside 
signatures progressively closer to the fold (the position of the final 
PostScript trimmed pages remains at a constant distance from the 
outside edge of the book, when in fact the margins closest to the spine 
are continually changing).
Two parameters are used to compensate for Creep:

• Total Creep In

• Initial Creep Out

Total Creep In specifies the amount of movement towards the spine 
applied to the center two pages and their backs (the pages that require 
the most amount of compensation). An ever-decreasing amount of 
movement is automatically applied from the center quartet of pages 
back towards the outside four pages of the job (every quartet of pages 
is moved by an amount less than the previous quartet). 
You can find that images get too close to the spine. This can be 
resolved by specifying a value for Initial Creep Out that moves all the 
pages of the job further out toward the outside margin (away from the 
spine) by the specified amount. 

" For detailed information on CSX2000 Color Server Imposition parameters, refer 
to Imposition Tab on page 90 and The Imposition Workflow on page 151.
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Printing a Job Using Imposition on the CSX2000 Color Server

When a job using imposition is sent to print on the CSX2000 Color 
Server, the job is printed according the defined imposition parameters. 

Paper Sheet Size, Trim Size, and Margin, Gutter and Spine size are 
variables and can be adjusted at any stage when preparing a job for 
printing. The Template parameters cannot be adjusted, but you can 
select which Template to apply to a job. 

The combination of the Paper Sheet size, the Trim Size and the 
Template results in a virtual holes on the paper sheet. Job pages are 
centered behind these holes. The Trim Size defines the size of the hole. 
In effect, the holes block the outer edges of the job pages.

Adjustments to Gutter and Spine size affect the distance between the 
holes, while adjustments to Margin settings affect the distance of the 
�holes� from the edge of the sheet. When using the Bleed parameter, 
the hole is increased by twice the size of the Bleed setting, in both the 
horizontal and vertical directions. This does not affect the actual 
positioning of the Trim Size of the job pages, which remain centered 
behind the holes.

It is important to remember that changes to one imposition job 
parameter will likely affect other imposition parameters. It is therefore 
recommended that you frequently refer to the thumbnail viewer, found 
at the lower right corner of the Template parameter screen. The 
thumbnail shows the effect of imposition parameter choices on the 
printed sheet. Parameter setting conflicts are highlighted in red, or with 
a dotted line.

The Job Editor window lets you move pages within a job, delete pages 
of a job, insert pages of another job, or merge two entire jobs. You can 
use the Job Editor with imposition jobs just as you would with any 
other job.
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Variable Information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These materials 
can include bills, targeted advertising and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific individual or address. You send VI 
jobs to the CSX2000 Color Server in Creo Variable Print Specification 
or Variable data Intelligent Postscript Printware (VIPP) formats to be 
RIPped and printed.

All VI jobs are constructed as a collection of individually RIPped 
elements. Element include text, graphics, pictures and page 
backgrounds. Elements can be static or unchanging from page to page 
or booklet to booklet, such as a company logo. Elements can also be 
variable or changeable from page to page or booklet to booklet. 
Variable elements can be used repeatedly, for example a product 
photograph. Variable elements can also be in-line, or unique, for 
example, an individual name, or text used only once.

On the CSX2000 Color Server, all elements, whether they are used 
only once, or repeatedly, are RIPped only once. Static elements and 
repeating variable elements are cached for re-use in the job and 
between jobs. Each set of elements associated with a particular job is 
assigned a unique name. This name allows re-using the cached 
elements between jobs. In-line variable elements that are used only 
once, usually text, are not cached. 

Pages are assembled from the RIPped elements just before printing. 
Each element - text, graphic, picture, or page background - is RIPped 
only once, regardless if the element is used once, several times, or even 
in every page of the VI job. If it is used more than once, then it is 
cached for further re-use.

You send VI jobs to the CSX2000 Color Server in Creo Variable Print 
Specification or Xerox Variable data Intelligent Postscript Printware 
(VIPP) formats to be RIPped and printed. The CSX2000 Color Server 
can also process conventional PostScript (PS) files as VI jobs, although 
they are not truly VI documents. In other words, all PS jobs (VI and 
non-VI jobs) can use Gallop mode. 
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The CSX2000 Color Server allows concurrent RIPping and printing of 
VI jobs. This simultaneous function is called Gallop mode. Large jobs 
do not have to be RIPped entirely to disk before printing. You pre-
define the number of pages to be processed before the engine starts to 
print. As soon as these pages are processed, printing starts while the 
rest of the job is streamlined through the CSX2000 Color Server. The 
Xerox DC2000 Series continues printing at its rated speed without 
interruption or slowing down until the job is finished.

Simultaneously RIPping and printing on the CSX2000 Color Server is 
called Gallop Mode. 

The VI Workflow

VI jobs are created using VI authoring programs that support Variable 
Print Specification and Xerox VIPP formats. Most VI authoring 
programs can convert VI files to conventional PS files, which can also 
be processed by the CSX2000 Color Server, although less efficiently 
than Variable Print Specification and VIPP files. Each authoring 
program creates VI code that instructs the RIP where to place the VI 
elements and each authoring program does so in a slightly differing 
manner.

Pre-RIPped reusable elements are combined on the fly with inline 
elements during the RIP. Pages are assembled from the various 
elements at high speed on the CSX2000 Color Server as they are fed 
into the print engine.

The reusable elements are stored in a cache folder. The CSX2000 
Color Server only RIPs inline elements in subsequent jobs using the 
same reusable elements. The cached reusable elements are integrated 
on the fly. 
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In your VI authoring program (for example, Creo Darwin), you can 
define several sub-jobs related to the same VI job, (for example, 
different weekly runs or late additions or updates to a database). This is 
known as batch processing. The CSX2000 Color Server processes the 
first batch that arrives at the system, as described above. When 
processing following batches of the same job, the CSX2000 Color 
Server uses the already cached reusable elements and adds new 
reusable elements to the cache sub-folder. This saves the initial ramp-
up time for processing and allow immediate processing at the rated 
printer speed.

VI Document Authoring Programs 

The desktop environment requires an authoring program to design, 
organize and generate VI documents. This program can be stand alone 
covering all aspects of document design, data management, text 
capture, and so on. Or it can be an extension of an existing program 
that allows the creation of VI documents and VI jobs. 

Variable data Intelligent Postscript Printware (VIPP)

The Variable data Intelligent Postscript Printware format was 
developed in 1993 by Xerox Corporation. The VIPP is PostScript 
based format that composes the VI pages during the processing stage. 
The VIPP is being used for various types of applications, but mostly 
for financial applications, which typically use the dynamic graph 
charting capability of VIPP and for billing statements of banks, 
telephones, electricity, and so on.

In order to be able to utilize VIPP files on your CSX2000 Color Server, 
the VIPP software should be first installed on your system. This 
installation should be done by a service engineer. Contact your service 
provider for further information.

PostScript Files

The CSX2000 Color Server can also process conventional Postscript 
files (for example with Darwin) as VI jobs, although they are not truly 
VI documents. All page elements are re-RIPped for each page. This 
workflow can be suitable for simple, very short run jobs. These jobs 
may not use a VI authoring tool at all, but rather a mailmerge function 
in a MS Word® document or a MS Excel® spreadsheet.
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Creo Variable Print Specification Job Organization

Creo Variable Print Specification is the Creo language designed for 
effective production of VI documents. 

Creo Variable Print Specification is comprehensive and can specify a 
complete range of VI documents. It also provides the means for fast, 
efficient data processing and storage prior to printing. 
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The following are components of Variable Print Specification jobs:

• Booklet
A personalized copy of a document within a single print run where 
pages and / or elements within a page can vary from booklet to 
booklet. 

• Sub-job
All copies of a particular document (for example books, brochures, 
or flyers), within a single print run. On the CSX2000 Color Server, 
sub-jobs can be deleted, archived, or reprinted at any time. 
However, you can still maintain reusable elements for future runs. 
Reusable elements are cached elsewhere, so only the unique data, 
which is embedded in the job, is deleted.

• Reusable Elements
Self-contained graphical entities that can be line art, text, raster 
images or a combination of these types. Reusable elements are 
represented in PostScript and can be stored as EPS files when 
appropriate. Reusable elements include clipping and scaling 
instructions as well as the image data. 

Reusable elements can be used repeatedly in different pages, 
booklets and jobs. On the CSX2000 Color Server, all reusable 
elements are processed once and cached as RTP elements for 
further re-use. They can then be re-used either within the sub-job 
itself, or in additional runs of sub-jobs.

• Inline Elements 
Unique information is drawn from a database and is embedded in 
the sub-job. This data prints only once for individual booklets.

Grayscale TIFF and EPS images created in CMYK applications (such as 
PhotoShop) are counted correctly as B&W instead as Color in both the 
CSX2000 Color Server and the DocuColor 2045 / 2060 billing meters.
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Xerox VIPP Job Organization

VIPP jobs are composed of the following four files:

VIPP software creates xgf and xgfc folders on your system. Within the 
xgfc folder, a number of sub-folders are created. Store the VIPP job 
files in these sub-folders as follows.

To print the VIPP job, import it (the *.DBF file) to the CSX2000 Color 
Server. The VIPP job is processed and printed.

File Name File Description

File.PS The PostScript Master Form, which holds all of 
the fixed elements from the original document.

File.JDT The Job Descriptor Ticket, which holds header 
and setup information for the job.

File.DBM The Database Master, which holds the VIPP 
coding.

File.DBF The Database File, which holds all the ASCII 
data to be merged. It should contain database 
information taken from the range of database 
records that were specified in the DataMerge 
dialog.

File Name Store in VIPP Sub-folder

File.PS formlib

File.JDT jdtlib

File.DBM formlib

File.DBF mislib

Variable Image Files imglib
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Archiving & Retrieving VI Jobs

VI jobs that were processed can include VI cached elements. When 
jobs are archived / retrieved then the VI elements must also be archived 
/ retrieved. The archival / retrieval must be done in a certain order as 
specified in the following procedures.

To Archive a VI Job

1. Archive the VI elements from Admin > Resource Manager > VI 
Elements. Double-click this option. 

2. Select the RTP job to archive.

3. Click the Archive button. Wait until the �Archive is complete� 
message appears in the Alerts window.

4. Now you can delete both the RIP file and the VI elements.
To Retrieve a VI Job

1. Retrieve the VI elements to Admin > Resource manager > VI 
Elements. Double-click this option.

2. Select the RTP job the retrieve. 

3. Click the Retrieve button. Wait until the �Retrieving is complete� 
message appears in the Alerts window.

" For more information, refer to Organizing VI Elements on page 141, Previewing 
RTP Jobs on page 306, and Editing RTP Jobs on page 317.
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Appendix D

Glossary
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24 bit/3 byte image - An image can be either RGB or CMY and each 
of the three colors uses 1 byte or 8 bits of data. Since 3 bytes equals 24 
bits, these images are also known as 24 bit images. This system is used 
for high quality video imaging and scanning. For process color 
printing, a fourth color (black) is added for optimum effect. See also 
digital data.

32 bit/4 byte image - An image that uses 8 bits each for CMYK pixels, 
or 8 bits for each RGB pixel and 8 pixels for a mask layer or other 
future use. Since 4 byte equal 32 bits, these images are also known as 
32 bit images. An 8 bit CMYK image is the minimum required for high 
quality print reproduction. See also digital data.

4 color printing - Color reproduction method used to create full color 
output by overlaying cyan, magenta, yellow and black inks.

8 bit/1 byte image - An image limited to 256 tones of one color or 256 
different colors. Since 1 byte contains 8 bits and each bit has two 
choices, 1 byte equals 28 choices or 256 possibilities. See also digital 
data.

Additive color model - Color system in which the picture is composed 
of the combination of Red (R), Green (G) and Blue (B) light 
transmitted by the original subject. Effective for monitors and TV's but 
not for print. Scanners normally first scan in RGB and it is converted 
into CMYK for printing. See also RGB, CMYK, process colors, 
subtractive color model.

Amplitude Modulation - Halftone screening, as opposed to FM 
screening, has dots of variable size with equal spacing between dot 
centers.

Anti-Aliasing - A step effect in which angled lines or curved edges of 
elements in an electronic image look broken or jagged, as a result of 
producing it in a grid format. Increasing resolution can reduce this 
effect or using a technique called anti-aliasing where the edges are 
softened.
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APR - The Creo Automatic Picture Replacement workflow. In this 
workflow, two versions of a file are created - a high-resolution file and 
a low-resolution file called PSImage. The latter is used for positioning 
and manipulation within a DTP application. The low-resolution file is 
replaced automatically by the high-resolution version during the RIP 
process. See also PSImage.

Binding - The process by which pages of a book or other publication 
are attached to one another.

Bit - Abbreviation of binary digits. The smallest unit of information 
used to store information in a computer. Bits are expressed as a binary 
notation, that is, in ones and zeros.

Bitmap graphics - An image composed of individual pixels. The color 
value and position of each pixel are individually described in bits and 
bytes of computer memory. It is called a bitmap because it is 
effectively a map of bits. See also raster file.

Bleed - An extra amount of printed image, which extends beyond the 
trim edge of the sheet or page.

Booklet - VI jobs are composed of booklets, which are personalized 
copies of a document. A booklet can consist of several pages, but the 
entire document is targeted at a specific individual or address. VI jobs 
include elements that may differ from booklet to booklet, including 
text, graphics, pictures and page backgrounds. 

Butt - To join without overlapping or space between.

Byte - A grouping of 8 bits of stored information, giving 256 levels of 
data. Each byte represents a value or character such as a letter or a 
number. In a color system, a byte can describe one out of 256 distinct 
shades. 

CIE - Abbreviation for Commission Internationale d'Eclairage. This 
body was created for the study of illumination problems. CIE color 
coordinates specify proportions of the three additive colors required to 
produce any hue and are used for comparative color measurement.

CMYK - The process colors - Cyan, Magenta, Yellow and Black. See 
also color separations, process color, and subtractive color model.

Color gamut - The range of colors possible with any color system. 
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Color separations - Separate films are prepared for each of the 
process printing inks - cyan, magenta, yellow and black. These films 
are used to prepare the printing plates for printing on press. See also 
CMYK.

Composite mode - In composite mode, the data required to separate a 
page into its CMYK components is all contained within one single 
(composite) file. Brisque or PS/M then separates the file into CMYK 
as part of the conversion process. This processing mode is the fastest 
and most efficient in the majority of cases. Regarding exceptions see 
pre-separated mode.

Creep - The effect of middle pages of a folded signature extending 
slightly beyond outside pages, compensated by shingling. See also 
shingling.

Crop - To eliminate portions of an illustration or photography so the 
remainder is more clear, interesting or able to fit the layout.

CT - Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from dark to 
light (unlike the abrupt changes in linework). 

DCS - Abbreviation for Desktop Color Separation, an EPS format 
containing 5 files. Four of the files contain the color information for 
each of the CMYK colors and the fifth is a low-resolution composite 
file for use in electronic page layout. See also OPI.

Degradé - A gradual blend or transition between colors. Also known 
as vignette or graduated blend (vector drawing).

Digital front end system - In electronic publishing, this is the 
workstation or group of workstations containing the applications 
software for preparing pages of type and graphics. In prepress, this is 
the workstation that gives access to the user for the operation of 
hardware. For example, proofer, platesetter, imagesetter.

Digital proof - A black and white or color image reproduction made 
from digital information without producing intermediate films. It can 
be output as a digital hard proof using a peripheral output device or 
displayed as a digital soft proof on a video monitor.

Dot - The individual element of a halftone.
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Dot area - The percentage of an area covered by halftone dots ranging 
from no dots at 0% to a solid ink density at 100%. The size of a single 
dot is stated in a percentage of the area it occupies.

DTP - Abbreviation for Desktop Publishing. The process of page 
production using personal computers, off-the-shelf software and an 
output device such as a printer or imagesetter. Usually, these 
components form a system that is driven by a device-independent page 
description language such as PostScript.

EPS - Abbreviation for Encapsulated PostScript, a graphic file format 
used to transfer PostScript, graphic files from one program to another. 
It includes both a low-resolution preview and the high resolution 
PostScript image description. On the Macintosh, the preview is in 
PICT format, on the PC it is in TIFF format. Also known as EPSF.

Finishing stage - Stage following the press process, which may 
include procedures such as laminating, perforating and varnishing.

Font - A complete assortment of letters, numbers, punctuation marks, 
characters etc. of a given design and size.

Frame - A color overlap created intentionally at a color border so as to 
minimize the effects of misregistration. Also known as trap or grip. See 
also trapping.

Frequency modulated screens - A method of creating halftones 
where the spots are all the same size, but the frequency or number of 
dot changes in a given area. There are more dots in a dark area and 
fewer in a light area.

Frozen job - A job for which the appropriate paper stock is not 
available, for example, the correct paper type, paper size or paper 
weight.

GCR - Abbreviation for Gray Component Replacement. Method for 
reducing the CMY amounts that produce the gray component in a 
color, without changing the color hue. 

Graduated blend - See Degradé.



418   Glossary

Gravure printing - A printing method in which the image is engraved 
through a screen below the surface of a cylinder. The ink is transferred 
to paper when pressed to the cylinder. Gravure is used for very long 
print runs and on many substrates.

Gray component - The amounts of CMY in a color, which result in 
neutral gray, based on the lowest separation value of the color. See also 
GCR.

Grayscale - A scale of gray tones from white to black. Digitally, 
grayscale images have up to 256 different levels of gray. See also 8 bit 
images.

Halftone - A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. Creates the 
illusion of continuous tone when viewed with the naked eye.

Highlights - The whitest portions of the original or reproduction that 
have no color cast. The highlight dot is ranged in the reproduction from 
the smallest printable dot to approximately 25%. See also Midtones 
and Shadows.

HSL - Abbreviation of Hue, Saturation and Lightness. This is a color 
model, which specifies a color by its wavelength (Hue), chroma or 
purity of the color (Saturation) and value of its brightness (Lightness).

Image area - Portion of a negative or plate corresponding to inking on 
paper. The portion of paper on which ink appears.

Imposition - The arranging of pages in a press form to ensure the 
correct order after the printed sheet is folded, bound and trimmed.

Ink jet proof - A proof of a digital image printed by using jets that 
squirt minuscule drops of ink. Ink jet proofers can print onto a variety 
of surfaces.

Job Flow - Job flow refers to the job parameter settings of selected 
virtual printers that are automatically applied to all jobs printed using 
that virtual printer. These settings determine how a sent or imported 
file is processed. For example, a file sent to a virtual printer with a 
Process & Print job flow will be RIPped, printed and stored in the 
Storage Folder. A file sent to a Process & Store job flow virtual printer 
will be RIPped and stored, without printing.
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LEF - A printer page orientation, where pages are delivered long edge 
first.

Laserwriter driver - A part of the Macintosh system software which 
generates PostScript instructions from an application file when the 
Print command is activated.

Look-up table (LUT) - A two or three-dimensional array of values 
stored for specified input-output relationships. When one input value is 
known, the system can automatically determine the correct output 
value. For example, the system can find the needed dot size for a given 
set of printing conditions based on the stored gray level; color setups 
can be saved in color tables (color transformation tables) which are one 
of the many kinds of LUTs.

Linework - Linework graphics are characterized by sharply defined 
lines and very clear transitions from one color to another. Linework is 
stored in the computer as a series of geometric (vector) drawing 
instructions.

Metamerism - Metamerism occurs when two colors match under one 
light source, but appear different under another light source. Those two 
colors are called a metameric match. A metameric match might cause 
problems when trying to match proofs to press-sheets under different 
lighting conditions.

Midtones - Density values of an image (original or reproduction) 
between the highlights and the shadows. In the reproduction, midtones 
are printed with dot areas between approximately 40% or 60%. See 
also highlights and shadows.

Misregistration - A situation common during printing where one or 
more of the color separations is slightly misaligned with regard to the 
others on press. Misregistration shows up as white gaps or tinted 
overlaps at the borders of color pairs. Colors containing such files are 
trapped to compensate for this possibility. On Continous Tone images, 
misregistration can lead to blurring. See also overprinting and trapping.

Moiré - An interference pattern caused by differences in halftone 
screen angles or rulings. In process color printing, screen angles are 
selected to minimize this pattern. If the angles are not correct, a pattern 
that distracts the eye from the picture may be produced.
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Newton's rings - Small concentric circles that can appear on film 
when two surfaces are closed together but not in perfect contact.

OPI - Abbreviation of Open Prepress Interface. A prepress convention 
established by Aldus Corps. OPI refers to tags or place holders in 
source PostScript that point to TIFF or EPS images that have not been 
embedded in the PostScript. These images reside in other locations and 
are merged with the PostScript file when processed. Normally used for 
performing high resolution or low resolution image substitution 
(alternative to Creo APR).

Output resolution - The number of laser dots per unit of linear 
measurement (millimeter, inch etc.) on film or paper. 

Output tone curve - A graph showing the relationship of original 
input densities and the corresponding dot percentages on film. 

Overprint - A technique, which overlaps colored elements to 
eliminate the appearance of gaps between elements caused by 
misregistration of the various separations during printing. For example, 
black text is normally set to overprint. See also trapping and 
misregistration.

PDL - Printer Description Language files (for example, PostScript, 
PDF, EPS, VPS, VIPP). The CSX Color Server processes image files 
in PDL formats, converting them into a suitable Ready-To-Print format 
for direct, high-quality printing.

PICT - A Macintosh file format for bitmaps and vector graphics.

Pixels - Contraction of Picture Element. The smallest element of a 
digital image.

PostScript® - A programming and page description language that has 
become industry standard for electronic publishing. It is used to 
describe the entire page, including both text graphics and images. 
PostScript is completely independent of the printing device. Developed 
by Adobe Systems, Inc.�

Prepress - Generic term used to describe the processes involved in 
preparing images for printing. Includes the input, edit and output 
stages.
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Printer description files - PPDs (PostScript Printer Definition), and 
PDFs (Printer Definition Files). These files are used by the Macintosh 
applications to prepare page and documents for specific output devices.

Process colors - The four ink colors used to reproduce full color 
images - cyan, magenta, yellow and black.

PSImage - A low-resolution EPS file used in the Creo APR workflow. 
This file is used for positioning in page layout. Changes made to this 
file will be applied to the high-resolution file, which automatically 
replaces it shortly before exposure. See also APR.

Quartertone - The tone area of an image influencing highlight detail 
and with density values between the white point and midtone. 
Typically, printed with a dot area near 25%. See also highlight, 
midtone, shadow.

Raster file - A file of data that was scanned, processed or output 
sequentially, bit by bit and line by line. Also known as a bitmap.

Rasterization - The translation of vector information into bitmap 
information. Bitmaps may also require a new rasterization to comply 
with the screening parameters (dot shape, dot size) of the imagesetter 
that will expose them on film. See also RIP and RIPing.

Register - Fitting of two or more printing images or plates in exact 
alignment with each other.

Register marks - Crosses or other targets applied to original copy 
prior to printing. Used for positioning films in register or for register of 
two or more colors in process printing.

Resolution - The number of pixels, points or dots per unit of linear 
measurement. For example, pixels per millimeter on a video display, 
number of dots per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail is 
recorded and the larger the digital file size.
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RGB - Abbreviation for the additive primaries Red, Green and Blue. 
They are used in video monitors, scanning, and other uses where the 
light is direct and not reflected. The component colors are the three 
predominant colors in the visible light spectrum detected by the human 
eye. Combining these 3 colors together creates white light.

RIP - Abbreviation for Raster Image Processor. This is a software 
program or hardware device that converts vector information into pixel 
information to be imaged on an output file. This output file is imaged 
based on commands from the page description language.

RIPing - The process of rastering or converting bitmaps and vector 
graphics into raster images suitable to the screening parameters of the 
output device. Files are RIPed prior to exposure or plotting.

Saturated color - A color where the high and medium values approach 
100%. In a saturated clean color, the values of the wanted colors are 
near 100% and the value of the unwanted color is near 0%. For 
example, when the color is red, 5% cyan, 90% magenta, 80% yellow is 
more saturated than 30% cyan, 90% magenta, 80% yellow.

Saturation - The strength of a color.

Screen angle - The angle of rows of halftone dots represented in 
degrees. During output of films for reproduction, the dot arrangement 
of each separation film is placed at a distinct and different angle to the 
other separations. See also Moiré.

Screen rulings - The number of rows of printing dots per inch on a 
halftone film. A 150lpi-screen ruling provides much better quality than 
65lpi.

SEF - A printer page orientation, where pages are delivered short end 
first.

Shadows - The darkest part of an image (original and reproduction) 
having densities near to maximum density. In the reproduction, 
shadows are printed with dot areas between 80% and 100% See also 
highlights and midtones.

Shingling - A procedure that moves the image area of a page toward 
the direction specified, usually towards the binding, in order to 
compensate for creep.
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Signature - Sheet of printed pages which when folded becomes part of 
the publication.

Solid - The point in the picture printed with a dot area of 100%. See 
also highlights, midtones and shadows.

Spectrophotometer - Spectrophotometer (X-Rite DTP41), which is a 
24 band color measurement instrument that reports densitometric, 
colorimetric and spectral data.

Spot color - An additional separation (fifth, or more) that is used with 
special inks to achieve difficult color combinations, such as gold, or 
chocolate brown. Spot color is sometimes used by graphic artists to 
define special corporate colors, for example, for company logos. On 
the CSX Color Server, spot colors are tanslated into CMYK values 
using a dictionary, that can be edited to adjust CMYK values.

Step and repeat - The procedure of copying the same image by 
stepping it in position both horizontally and vertically according to a 
predetermined layout.

Stochastic screening - A method of creating frequency-modulated 
halftones that depends on the number of laser dots in a given area 
rather than the size of the laser dots in a given area. The dots are 
randomly placed and very small. Areas with a higher dot percent have 
more spots exposed in that area and those with a low dot percent have 
fewer spots. Stochastic screening is used to eliminate moiré and 
improve picture detail and sharpness in high-end color printing.

Subtractive color model - A color process in which the red, green and 
blue components of the original subject are reproduced as three super-
imposed images in the complementary (subtractive) colors of cyan, 
magenta and yellow respectively. See also CMYK, process colors, 
additive color model.

Three quartertone - Tone area of an image influencing the shadow 
detail and with density values between the Midtone and the Dark Point. 
Typically printed with a dot area near 75%.

TIFF - Abbreviation for Tagged Image File Format, a graphics file 
format. TIFF is a bitmap file format.
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Tone compression - The reduction of the density range of an original 
to the density range achievable in the reproduction.

Tone reproduction curve - A graph showing the density of each point 
of the original and its corresponding density on the reproduction.

Trapping - Creating and overlap (spread) or an underlap (choke) 
between colors that adjoin each other to hide misregistration during 
printing. Trapping is sometimes referred to as spreads and chokes or 
fatties and skinnies.

UCR - Abbreviation of Undercolor Removal. This is a method for 
reducing the CMY content in neutral gray shadow areas of a 
reproduction and replacing them with black. As a result, the 
reproduction appears normal but less process color inks are used. See 
also GCR.

Unsaturated color - A color whose highest value is less than 
approximately 80%. In an unsaturated, dirty color, the difference in the 
values of the wanted colors and the unwanted color is relatively low. 

For example, when the color is red, 30% cyan, 80% magenta, 70% 
yellow is more unsaturated than 0% cyan, 90% magenta, 80% yellow.

Variable Information (VI) - Variable information (VI) jobs are jobs in 
which the printed materials are individualized for specific recipients or 
purposes. These materials can include bills, targeted advertising and 
direct mailings.

Vector drawing - The geometric system used to define lines and 
curves in many computer graphics most often used for line drawings.

Vignette - See Degradé.

Virtual Printer - For Macintosh and PC networks, the CSX Color 
Server provides three default network printers, known as virtual 
printers. Virtual printers contain preset workflows that are 
automatically applied to all print jobs processed with that virtual 
printer. 

White point - The whitest neutral area of an original or reproduction 
that contains detail and is reproduced with the smallest printable dot 
(typically 3% to 5%).
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